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Safety Guidelines Safety Guidelines 
This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

DANGER  
indicates that death or severe personal injury will result if proper precautions are not taken. 

WARNING  
indicates that death or severe personal injury may result if proper precautions are not taken. 

CAUTION  
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken. 

CAUTION  
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken. 

NOTICE  
indicates that an unintended result or situation can occur if the corresponding information is not taken into 
account. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The device/system may only be set up and used in conjunction with this documentation. Commissioning and 
operation of a device/system may only be performed by qualified personnel. Within the context of the safety notes 
in this documentation qualified persons are defined as persons who are authorized to commission, ground and 
label devices, systems and circuits in accordance with established safety practices and standards. 

Prescribed Usage 
Note the following: 

WARNING  
This device may only be used for the applications described in the catalog or the technical description and only 
in connection with devices or components from other manufacturers which have been approved or 
recommended by Siemens. Correct, reliable operation of the product requires proper transport, storage, 
positioning and assembly as well as careful operation and maintenance. 

Trademarks 
All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this 
publication may be trademarks whose use by third parties for their own purposes could violate the rights of the 
owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
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Asset Management using the 
SIMATIC Maintenance Station 1
1.1 Basics of plant asset management 

Introduction 
Various tasks have to be accomplished within the operating phase of a plant. The actual 
plant operation is the task of production personnel. Aspects to be taken into consideration 
when controlling and monitoring the plant's output of products:  
● Appropriate quality 
● Defined batch quantity 
● Specified time or date of delivery 
● Minimum utilization of resources such as personnel, raw materials, power and costs. 
Maintenance personnel are responsible for ensuring high availability of the plant within a 
defined period and reliable long-term operation by taking appropriate optimization measures. 
Maintenance measures must also be carried under the aspect of minimizing the utilization of 
resources, for example, personnel, material, energy and costs. As a result of their different 
tasks, these two groups of persons have different information requirements. 
By contrast to maintenance personnel who require information about the state of production 
equipment, the operating personnel are primarily interested in information concerning the 
process. 
The HMI and SCADA systems of the plant form the information interface for both groups. 
The corresponding users should deploy these systems in order to obtain all important 
information relevant to their task. The user should not be confronted with unnecessary 
information flooding. 

Introduction to plant Asset Management  
The section below describes the basic terminology used in this introduction to Asset 
Management.  

Term: Asset 
Assets are the various plant components. The term "plant assets" denotes components or 
devices of the plant / machinery which are serviced by maintenance personnel.  
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Term: Asset Management 
The term Asset Management generally encompasses activities and measures taken to 
maintain or increase the value of a plant. In addition to plant management, plant automation 
and their optimization, these measures include in particular the maintenance and increase of 
asset values.  

Term: Plant Asset Management 
Plant asset management denotes maintenance tasks which are suitable to preserve or add 
values. An important aspect in this context is an optimal cost ratio of value-adding 
maintenance and plant availability.  
In addition to the collection of data for the analysis of the plant's technical state, plant asset 
management also makes decisions concerning maintenance measures to be taken.  

Term: Plant Asset Management System  
A plant asset management system is an IT system that provides the following functionality: 
● Collection of online information for the assessment of the plant and components state. 
● Support of decisions concerning maintenance measures to be taken. 
● Preparation and execution of maintenance measures. 
● Interface to other systems for asset management such as EAM/CMMS or business 

management. 

Abbreviation: CMMS 
Computerized Maintenance Management System. CMMS is a computerized system which is 
used to plan, manage and analyze maintenance. This includes request management and 
execution, personnel planning and management, spare parts and materials.  

Abbreviation: EAM 
Enterprise Asset Management System. EAM functionality is closely related to CMMS.  
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1.2 Asset management using the SIMATIC Maintenance Station 

Plant Asset Management using SIMATIC Maintenance Station 
SIMATIC Maintenance Station is a system for Plant Asset Management which provides the 
following basic functions: 
● Collection of online information for the assessment of the plant and components state 

and for reporting system errors. 
● Decisions concerning maintenance measures such as plant service, inspection, repairs 

and the elimination of weak point. 
● Maintenance request and status management. 

Additional features of SIMATIC Maintenance Station  
● Scaleable diagnostics functionality for individual components and the plant. 
● Integration of all operating and monitoring systems and plant components. 
● Separation of maintenance-relevant information and process data 
● Clear presentation of the plant status 
● Harmonized visualization of all components 
● Automatic generation of diagnostics screens and of their corresponding hierarchy based 

on project data 
● Integration of process automation components. These are PC stations, network 

components, automation systems and their sublevel components such as fieldbus 
systems, drives, sensors and switchgear. 

● The system supports the integration of components not belonging to the SIMATIC 
environment and of user-specific diagnostics functions. 
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Benefits of SIMATIC Maintenance Station  
SIMATIC Maintenance Station provides diagnostics functions to maintenance departments 
which allow precise analysis of the plant components, namely the assets. An additional 
advantage of Maintenance Station is the concentration of plant automation and maintenance 
in a single system. This single-system structure for plant engineering, operating and 
monitoring clearly facilitates handling.  

 
Implementation of the SIMATIC Maintenance Station enhances effectiveness in terms of the 
planning and execution of maintenance tasks. Benefits derived: 
● Reduction of direct maintenance costs in terms of personnel and material by enhancing 

scheduling and reducing maintenance time. Improved utilization of component down 
times also contributes towards this effect. 

● Reduction of costs incurred as a result of non-scheduled down times, because tasks can 
be completed within defined down times. Reduction of reject products and reworking due 
to the early detection of error rates at specific components. 

Functions  
SIMATIC Maintenance Station integrates various functions: 
● The HMI system for the visualization of diagnostics information. 
● Controls for the initiation of maintenance processes and status management. 
● Functions for asset management. 
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1.3 Implementation and application of SIMATIC Maintenance Station 

Introduction to functions and applications 
SIMATIC Maintenance Station facilitates plant asset management in the field of process 
automation. It provides functions for plant and component diagnostics, for requesting 
maintenance measures, and for managing the status of maintenance tasks.  
This topic provides a brief overview of Maintenance Station functionality. You can find a 
detailed description in "Overview of diagnostics and maintenance using the maintenance 
station (Page 185)".  

 

 Note 
Maintenance Station functionality is dedicated to Plant Asset Management.  
It does not provide technical functions which could be used, for example, to configure drives 
or calibrate sensors / transducers. The hardware is configured in SIMATIC Manager of 
SIMATIC STEP 7. 
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The overview screen and area overviews  
The diagnostics screens of Maintenance Station have a hierarchic structure. The 
Maintenance Station opens with the overview screen. This is the root screen within the 
diagnostics screen hierarchy and provides an overview of the actual plant status to 
maintenance.  

 
 

The so-called overview area on the top edge of the screen outputs the most recent 
diagnostics message.  
The group displays  show a summary of the states of all components and of 
the nested hierarchies.  

The group display or the "Loop-in-Alarm"  function can be used to open the diagnostics 
screen of the component addressed by the current diagnostics message. The program 
opens the diagnostics screen at the higher hierarchy level in order to visualize all diagnostics 
messages which are currently active.  
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The overview screen visualizes the PC stations, network components and AS objects fields, 
and highlights these on different colored backgrounds. The current status of each area is 
displayed by means of icons (e.g. 

 or ).  
The user can open the corresponding area overview by clicking one of the icons in order to 
obtain information about the maintenance-relevant status of this area.  

 

 Note 
The "Loop-in-Alarm" function triggers a change to the diagnostics screen which outputs the 
selected message and the environment causing this message. 
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Diagnostics screens  
The diagnostics screens are arranged within their hierarchy below the AS field overview. The 
hierarchy of diagnostics screens corresponds with the component hierarchy of the 
automated plant. The diagnostics screens output the symbols of the automation systems and 
of their sublevel components. These symbols also visualize the status of these components. 
The user can navigate in the hierarchy of diagnostics screens. 
The "Network components" and "PC stations" areas only provide an overview screen for the 
relevant area. 
The diagram below shows an example of a diagnostics screen which visualizes an 
automation system with integrated hardware, for example, the CPU, the universal rack "UR1, 
the expansion rack "ER1", and the corresponding "DP master system 1" and "DP master 
system 2" bus systems. The status displays of this screen output a summary of the status of 
sublevel components in the bus systems.  

 

Abbreviation: AS  
AS = Automation System 
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Component diagnostics  
The overviews or other diagnostics screens visualize the various components using symbolic 
images. The symbolic images visualize the corresponding status and sublevel hierarchy of 
the component.  
The symbolic image of an AS is shown below.  

 
The symbolic images contain: 
1. The symbolic visualization of the component. 
2. The status display of the actual component. In this example, the status shown is: 

 = "Maintenance alarm". 
3. Status display for diagnostics messages of the component. The status display is inserted 

on the bottom right side of the below the component status display mentioned earlier. In 
the example, this is a small red square. 

4. The display for diagnostics messages in the nested hierarchy. The example shows a 
"Maintenance alarm" diagnostics message concerning a component in the sublevel 
hierarchy of this automation system. 

As a result, the display shows the status  = "Maintenance alarm". 
5. Designation of components or of the subsystem. 
By clicking a status display in the component image, you open either the diagnostics screen 
of the hierarchy sublevel or the diagnostics faceplate of the component.  
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The component's diagnostics faceplate 
The diagnostics faceplate contains diverse displays relating to the component status and 
maintenance requests. The faceplate also contains control elements for maintenance 
request and status management. The faceplate shown in the image below, for example, 
shows the following status:  

 
The icons mean: 
●  = A "Maintenance alarm" diagnostics message for the component is active. 

●  = "Maintenance alarm". This represents the highest priority of maintenance 
requests. 

 
 

The faceplate supports three default views for the visualization of component-specific 
information.  
● The "Identification" view outputs online data of the component or of the hardware 

configuration and of the maintenance status, including the status of any existing 
redundant component. 

● The "Message" view outputs diagnostics messages, operator actions and maintenance 
demands. The messages can be acknowledged and managed. 

● The "Maintenance" view lets the user react to maintenance requests by initiating and 
managing corresponding maintenance tasks.  
In this view the data of the component can be exported for other applications for further 
processing such as the WinCC add-ons "PM-MAINT" or "Alarm Control Center". For 
additional information please refer to the chapter "Exporting component data for other 
applications". 

For additional information, please refer to "Components for the visualization of diagnostics 
data  (Page 107)". 
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Initiating and managing maintenance tasks 
The Maintenance Station supports users in terms of the preparation and execution of 
maintenance tasks such as maintenance, inspection, repairs and the elimination of weak 
points. 
In addition to the output of component-specific data and messages, the diagnostics faceplate 
provides the following functionality. Users can open the "Maintenance" view in order to react 
to component maintenance requests. This may involve the initiation or termination of a 
maintenance task, or the change of the corresponding priority.  
After initiation of a maintenance task, the faceplate returns the progress status of 
maintenance. The status is indicated by the faceplate symbols and is also logged.  

The symbols  and  of the faceplate indicate the following status.  

●  = "Maintenance requirement" requested. 

●  = Maintenance "in progress". 
A work instruction number and a comment can be entered for each maintenance task. The 
work instruction number is used as information for the transfer to EAM/CMMS systems and 
is entered in the log.  
On successful completion of maintenance, the user sets the "Completed" status on the 
diagnostics faceplate. The status displays are refreshed automatically.  
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1.4 Components supported 

Integration requirements 
The next section outlines the components supported for integration.  
● The properties of SIMATIC components are determined by data already integrated in the 

hardware configuration of the S7 project. 
● The properties of other integral components of the S7 project that are capable of 

communication, such as PROFIBUS DP or PROFINET IO components, are defined by 
means of a GSD file. SIEMENS drive components also belong to these standard slaves.  

● Integration by means of Asset Proxy is designed for third-party components and devices 
which do not support standard diagnostics functionality for reporting errors to higher-level 
components.  
The diagnostics functions are handled based on configuration data of the S7 blocks in the 
user program.  
The Asset Proxy also supports integration of the interfaces of logical devices. 

 

  Note 
An archive server may not be used as Maintenance Station Server. 
For further information on supported device types, refer to the STEP 7 documentation 
"Configuring messages > Configuring the reporting of system errors > Components 
supported and functional scope".  
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Overview of supported components 
The list shows the components in the areas in which they are assigned the diagnostics 
functions and screens.  

 
Area Component 

WinCC stations / Operator Stations (OS) 
Industrial PCs 
Standard PCs 
WinAC Slot 

PC stations 

Archive Server 
  
Network components Ethernet components 
  

CPUs of the SIMATIC S7-300 and S7-400 automation systems, including H and 
F systems 
Central and expansion racks of the automation systems, I/O modules  
External I/O such as ET 200M or ET 200S  
PROFIBUS components such as DP interfaces (S7 slaves, DP slaves)  
PROFINET IO components 
Diagnostic Repeater 
PA devices are supported if these are connected directly to PROFIBUS via 
DP/PA coupler. The support corresponds with that of a standard salve.  
PA devices connected via DP/PA Link are not supported. 
Drives, sensors, switchgear 

AS objects 

Non-Siemens components can be integrated by means of asset proxy.  

 

Term: Maintenance Station Server 
A WinCC server which features enhanced diagnostics functionality. 

Term: Asset Proxy 
The Asset Proxy acts as component representative in the diagnostics system. It is 
implemented for components which are not standard slaves and do not belong to the 
SIMATIC family. The function blocks and instance DBs for the asset proxy are programmed 
in the user program of the AS. A defined interface is used to manage "MaintenanceState" 
diagnostics data and transfer messages. The "Extended" or "Standard" type is used, 
depending on the component.  

Term: MaintenanceState 
Representation of the diagnostics status in MaintenanceState "MST" 
The diagnostics maintenance states of a component are managed in status word 
MaintenanceState "MST". 
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1.5 Quantity structures and restraints 

Data volumes 
Data volume of the software listed below: 
● SIMATIC STEP 7 V5.4 SP3 
● SIMATIC WinCC V6.2 SP2 or V7.0 
● SIMATIC NET V6.4 

Limitations  
Restraints of the current version of Maintenance Station: 

Components 
● Smart devices (intelligent field devices) are not supported.  

The term smart devices denotes appliances such as sensors and actuators which support 
loadable, programmable functionality such as a PLC core, for example. 

● PA devices connected via DP/PA Link are not supported. 
● The restrictions defined in "Reporting system errors" also apply.  

For more detailed information, refer to the STEP 7 documentation "Configuring 
messages > Configuring the reporting of system errors > Components supported and 
functional scope". 

Configuration 
● A Central Archive Server CAS may not be operated as Maintenance Station Server. 
● Maintenance Station Server or the Maintenance Station of a single-user WinCC project 

may not be used as "Master OS" for WinCC applications of the type "OS Reference". 
● The use of the "Project Duplicator" of WinCC is not allowed. You may not use "Project 

Duplicator" to copy the "OS" configured for the Maintenance Station and other OS of the 
S7 project. 

● The PC names may not end with the character string "_IM". 
● The name of all automation systems to be visualized in Maintenance Station diagnostics 

must be unambiguous within the S7 project. 
● Connections to the components play an important role when using the Maintenance 

Station. This is an important aspect when using direct connections to the automation 
systems. 
– The system supports up to 64 connections to the PC which is used to visualize 

diagnostics data. 
– The MPI network supports up to 29 active connections per interface. However, the 

number of active connections on the MPI is also limited to 64. 
– Make allowances in terms of the number of connections when using SIMATIC NET, 

for example, on PROFINET. 
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Diagnostics 
● Diagnostics of several CPUs in the same rack is not supported.  

Redundant CPUs support diagnostics functions. 
● The use of WinCC clients without integrated project data may have a negative impact on 

performance of Maintenance Station Server at the start of runtime. It is advisable for this 
reason to implement WinCC clients with integrated project data. Please note the 
conditions defined in the WinCC documentation when using WinCC clients without 
integrated project. 
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1.6 The sample project 

The included sample project 
The SIMATIC Maintenance Station SW package is supplied with a sample project for 
STEP 7. Data configured in this sample program:  
● Hardware configuration. 
● PC Station for SIMATIC Maintenance Station Combined, integrated on a WinCC station. 
The Maintenance Station configuration is based on the hardware configuration. 
The sample project automatically included when you install the Maintenance Station can be 
edited for testing.  
For detailed information on installation and usage, refer to the "SIMATIC Maintenance 
Station - Getting Started" description. The description is available in PDF format in the 
Windows Start menu at "SIMATIC > Documentation > English".  
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Configurations of the SIMATIC Maintenance Station 2
2.1 Introducing SIMATIC Maintenance Station configuration 

Overview  
In addition to configuration data, the Maintenance Station requires diverse process data. You 
can implement different Maintenance Station configurations, depending on the plant's 
topology and on the existing WinCC stations.  
● SIMATIC Maintenance Station Combined:  

Maintenance Station is installed on an existing WinCC station and is integrated into the 
WinCC project. Users can change between the diagnostics and process screens.  

● SIMATIC Maintenance Station stand-alone: 
Maintenance Station is installed on a separate PC which is dedicated to diagnostics 
functions. 

Information about SIMATIC Maintenance Station in client-server architectures 
Maintenance Station functionality can be distributed to different computers within distributed 
systems. Maintenance Station Server handles processing of the diagnostics messages. 
Maintenance Station Client is used to visualize diagnostics data and to handle maintenance 
tasks.  
This kind of configuration is also required if the data volume of a WinCC station or 
Maintenance Station exceeds the capacity of the Maintenance Station.  

Integration of SIMATIC NET SNMP OPC Server 
Maintenance Station also supports SIMATIC NET SNMP OPC server where it is required for 
diagnostics of SNMP-compatible network components or industrial PCs. SNMP must be 
activated and configured on all network components to be monitored. All SNMP components 
integrated in the diagnostics system require a network connection. For further information, 
refer to "Integrating additional components > Integrating SNMP components".  

Configuration criteria 
Essential configuration criteria: 
● Operating mode of Maintenance Station, i.e. "stand-alone" or "combined". 
● Type of the plant architecture. 
Hardware and software requirements also represent decisive configuration criteria. For 
further information, refer to the topic "Installing SIMATIC Maintenance Station > Hardware 
and software requirements".  



Configurations of the SIMATIC Maintenance Station  
2.1 Introducing SIMATIC Maintenance Station configuration 

 SIMATIC Maintenance Station 2007 
24 Operating Manual, 04/2008, A5E00901992-03 

Maintenance Station engineering on the S7 Engineering Station 
It is usual in most systems to implement a PC which is dedicated to S7 project engineering. 
It is advisable for this reason to run Maintenance Station engineering on this PC as well. All 
data of the plant's hardware configuration are available for Maintenance Station engineering 
and for generating the diagnostics screens/data/blocks.  
In order to visualize diagnostics data of the Maintenance Station on a second PC and use 
the "Loop-in-HW-Config" function for diagnostics, SIMATIC STEP 7 must be installed and 
the S7 project must be copied to this second PC.  

Maintenance Station diagnostics on the S7 engineering station 
The handling of Maintenance Station diagnostics on the engineering station "ES" of the S7 
project is an alternative combination. In distributed systems, this corresponds with the 
operation of Maintenance Station Client on the S7 ES.  
The hardware configuration data of the S7 project must be made available to the "Loop-in-
HW-Config" diagnostics function on the diagnostics faceplate. This function also requires 
SIMATIC STEP 7.  
Properties of this combination: 
● All essential diagnostics data of the S7 project are already available and represent the 

actual configuration status. It is not required of the user to transfer the S7 project to a 
separate PC which runs the Maintenance Station application. User-specific adaptation of 
each S7 project update is not necessary. 

● Deactivate the Maintenance Station before you edit configuration data. The PC is used 
either as Maintenance Station or as S7 Engineering Station. Concurrent operating modes 
are not supported. 

Term: Maintenance Station Client 
A WinCC Client for the visualization of process and diagnostics screens with diagnostics 
control functionality. 

Abbreviation: ES  
ES = Engineering Station 

Abbreviation: SNMP 
Simple Network Management Protocol. The protocol supports central management of 
multiple network components. 



 Configurations of the SIMATIC Maintenance Station 
 2.2 Determining the plant types 

SIMATIC Maintenance Station 2007 
Operating Manual, 04/2008, A5E00901992-03 25 

2.2 Determining the plant types 

2.2.1 Overview of the plant types 

Overview  
The overall system structure determines the vital criteria of the Maintenance Station 
configuration and properties. The overall system is subdivided into different plant types: 
● Single-user system:  

The plant represents a "single-user system" type in an S7 project which only contains 
WinCC stations with single-user projects. The S7 project contains neither any WinCC 
multi-user projects, nor any WinCC servers, nor any assignments of WinCC clients.  

● Multiuser system:  
A plant represents a "multiuser system" type if the S7 project only contains WinCC 
multiuser stations and perhaps WinCC clients with integrated project. In this case, the 
Maintenance Station must also be a multiuser project. It may not contain and WinCC 
stations with single-user projects.  
Multiuser projects may have a different configuration.  
– As stand-alone WinCC stations without clients. 
– A client-server architecture with WinCC server and allocated WinCC clients. 

● Mixed system:  
The plant represents a "mixed system" if the S7 project contains WinCC stations with 
single-user and multiuser projects.  
Multiuser projects may have a different architecture similar to the "multiuser system" type.  

Term: WinCC single-user station  
WinCC station running a project of the type "WinCC multiuser project". 

Term: WinCC multiuser station  
WinCC station running a project of the type "WinCC multiuser project". 
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2.2.2 Principle of determining the plant types 

Introduction  
A suitable Maintenance Station configuration is selected based on several criteria. 
● Operating location of the Maintenance Station  

"Stand-alone": on a separate PC. "Combined": integrated into a WinCC station.  
● Type of the plant architecure.  

The type of project, i.e. either "single-user" or "multiuser", forms a criterion for configuring 
S7 projects running on the WinCC stations. 

● Communication paths for data traffic to the Maintenance Station.  
The Maintenance Station and other WinCC stations within a multiuser project architecture 
exchange information by means of so-called server packages. WinCC stations running 
single-user projects can not intercommunicate and are interconnected with the 
automation systems via direct process channel. The Maintenance Station also requires a 
direct process channel for diagnostics of these automation systems. 

Basic procedure 
Essential configuration criteria to consider in the next steps:  
1. Maintenance Station operation on a separate PC,or integration in a WinCC station. 
2. Determination of the possible configuration of the overall automation system based on 

the definition of the plant type.  
The plant type defines important properties and requirements in terms of the configuration 
of the Maintenance Station to be implemented. 

The diagrams below illustrate the determination of the plant type, depending on the 
operating location selected. Based on this criterion, the diagrams provide a brief overview of 
the essential properties of the Maintenance Station to be implemented.  
You can find a detailed description in the section titled "Effect of the plant types on the 
configuration (Page 30)".  
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Definition for the SIMATIC Maintenance Station Stand-alone 
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Definition for SIMATIC Maintenance Station Combined 
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The configuration cannot be determined 
The system architecture may not meet requirements, or a suitable configuration could not be 
found for the Maintenance Station, for example. In this case, the solution may be to modify 
the system architecture.  
Modification of a system architecture which consists of stand-alone WinCC stations may 
provide a solution if, for example, the Maintenance Station to be implemented as stand-alone 
station is unable to communicate with the automation systems.  
● The WinCC single-user stations connected to the required AS are converted into WinCC 

multiuser projects. This solution requires installation of the WinCC "Server" software 
component and of the corresponding license key. This setup enables communication by 
means of server packages with the Maintenance Station which is, in this scenario, also 
configured as WinCC multiuser project.  
If the project type is changed after the diagnostics screens have been generated for the 
first time, please note the information in "Changing the project type in WinCC  
(Page 149)". 

● Implementation of a shared system bus for AS communication. This scenario would allow 
direct connections via the system bus to a Maintenance Station operated as WinCC 
single-user project.  
This solution, however, increases the number of connections required for communication 
between the WinCC station or Maintenance Station and the AS. Allowances must be 
made for the SIMATIC WinCC and SIMATIC NET data volumes in terms of the number of 
connections.  

Term: WinCC single-user project 
WinCC single-user projects are interconnected directly with the corresponding automation 
systems. Generation of packages is not supported. Communication with other WinCC 
stations and server-server communication are ruled out for this reason. 

Term: WinCC multiuser project 
A WinCC multiuser project can generate its own packages and upload the packages from 
other WinCC multiuser projects. The packages can be uploaded from WinCC clients and 
WinCC multiuser projects. Communication with other WinCC multiuser stations is handled by 
server-server communication functions. The PC running the multiuser project features a 
process bus interface for communication with the corresponding automation systems. The 
multiuser project supports several WinCC clients. 
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2.3 Effect of the plant types on the configuration 

2.3.1 Configuration of the "single-user system" type 

Configuration of the "single-user system" type 
A "single-user system" within an S7 project only contains WinCC stations with single-user 
projects.  

Communication 
The WinCC single-user stations feature a direct process bus interface for communication 
with the corresponding automation systems. The WinCC stations do not communicate 
directly.  
The Maintenance Station to be integrated must be provided a direct process connection to 
each AS which participates in diagnostics processes and was previously assigned only to 
one WinCC single-user station. 
Make allowances for data volumes when you define the number of connections. For 
additional information, please refer to "Quantity structures and restraints (Page 20)". The 
system supports up to 64 direct connections between the Maintenance Station and the 
automation systems. 

Software requirements  
● The same WinCC version must be installed on all WinCC stations of the project, as 

specified in "Hardware and software requirements". 
● The "Maintenance Station Engineering" component must be installed on the PC which is 

used for Maintenance Station engineering. 
● When integrating the Maintenance Station in an existing WinCC project, install the 

"Maintenance Station Server" component on the WinCC station which is intended to be 
used as Maintenance Station "OS" to visualize diagnostics data.  
This WinCC project can remain for operation as WinCC single-user project or can be 
converted into a WinCC multi-user project.  
The WinCC "Server" options must be installed on the PC to convert the WinCC station 
into a multiuser project. However, it is not required to install a "WinCC Server" license key 
as long as the project is not accessed by any WinCC clients. 
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Licensing 
● A separate PC added to the plant in order to run the Maintenance Station requires a 

"WinCC RT (x)" license key. For additional information on the required license keys, 
please refer to "Licensing (Page 47)". 

● Corresponding Maintenance Station license keys required: 
– The "SIMATIC Maintenance Station 2007 Engineering" license key on the PC which 

runs Engineering. 
– The "SIMATIC Maintenance Station 2007 Engineering" license key on the PC which is 

used to visualize diagnostics data.  

Abbreviation: OS 
OS = Operator Station 
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2.3.2 Configuration of the "multiuser system" type 

Configuration of the "multiuser system" type 
With a "multiuser system" type, the S7 project only contains WinCC multiuser stations and, 
in some cases, WinCC Clients with an integrated project. In this case, the Maintenance 
Station must also be a multi-user project.  

Communication 
Communication between the WinCC multiuser stations is handled by means of server 
packages.  
The Maintenance Station to be implemented is also defined as multiuser project and 
receives its data in the server packages. For this reason, the Maintenance Station does not 
require a direct process connection to the automation systems.  
However, the data can also be allocated directly to the Maintenance Station if a direct 
process connection is available.  

Software requirements 
● The following requirements apply to all WinCC stations which download their server 

packages to the Maintenance Station: 
– The version of WinCC specified in the hardware and software requirements must be 

installed. 
– The extension software ("Process Server Extension") for Maintenance Station must be 

installed. This extension software can be installed via Setup in the Maintenance 
Station. 

– One session with "WinCC OS Project Editor" must be completed in the WinCC project. 
● The system only supports up to 12 multiuser stations due to the data volume of WinCC. 
● The "Maintenance Station Engineering" component must be installed on the PC which is 

used for Maintenance Station engineering. 
● When the Maintenance Station is integrated into an existing WinCC multiuser project, the 

corresponding component - "Maintenance Station Server" or "Maintenance Station Client" 
- is installed on the WinCC Server or WinCC Client. 

● When the system is expanded to include new PCs for diagnostics functions, the 
corresponding component of the Maintenance Station is installed on the Maintenance 
Station Server or Client that will be implemented.  
The software specified in "Hardware and software requirements" must be installed 
beforehand. 

● The relevant version of STEP 7 must be installed on the client in order to provide access 
to the "Loop-in-HW-Config" function on the Maintenance Station Client to be 
implemented. The user has to install this software. 
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Term: WinCC client 
General term used of a PC which is used to visualize and operate the process screens or 
diagnostics screens. 

Term: WinCC Server 
A WinCC Server receives and processes the process data for operating and monitoring the 
system. The process data can be transferred via direct process connection or by other 
WinCC Servers. Operation and monitoring takes place on one or more WinCC clients.  
If several WinCC Servers are used, the data can be distributed across them. This means 
that, in a large system, different components can be processed on separate servers, for 
example. Systems that are distributed in this way offer the following advantages: 
● Good scalability 
● Separate system components 
● Greater availability as a result of good scalability and separate system components. 
● A WinCC Server can access several other WinCC Servers at the same time (server-

server communication). 
If configured as a SIMATIC Maintenance Station Server, a WinCC Server can also execute 
diagnostics and maintenance functions. 

Licensing 
The "SIMATIC Maintenance Station 2007 Engineering" license key must be installed on the 
PC which is used for Maintenance Station engineering.  
License keys which must be installed on the Maintenance Station Server:  
● The "SIMATIC Maintenance Station 2007 Runtime" license key to provide a suitable 

number of variables.  
● The "WinCC Server" license key must be installed on this PC if one or more WinCC 

clients or Maintenance Station clients access a WinCC multiuser project. 
● The "WinCC RC (x)" or "WinCC RT (x)" license key is required to expand the system with 

PC for Maintenance Station Server.  
For additional information on the license keys required, please refer to "Licensing 
(Page 47)". 

License keys which must be installed on the Maintenance Station Client: 
● A STEP 7 license key must be installed on the client in order to provide access to the 

"Loop-in-HW-Config" function on the Maintenance Station Client to be implemented. 
● It is not necessary to install the Maintenance Station license key on the client. 
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2.3.3 Configuration of the "mixed system" type 

Configuration of the "mixed system" type 
The plant represents a "mixed system" if the S7 project contains WinCC stations with single-
user and multiuser projects.  

Communication 
Communication between the WinCC multiuser stations is handled by means of server 
packages. The Maintenance Station does not require a direct connection to automation 
systems which are already interconnected with a WinCC Server. 
The WinCC single-user stations feature a direct process bus interface for communication 
with the corresponding automation systems. There is no communication between WinCC 
single-user stations. The maintenance station must be provided for this reason a direct 
process interface to each AS which participates in diagnostics processes and which was 
previously assigned only to one WinCC single-user station.  

Software requirements and license agreements 
Conditions are similar to those of the "multiuser system" type. 
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2.4 SIMATIC Maintenance Station Combined 

Definition 
SIMATIC Maintenance Station Combined: The SIMATIC Maintenance Station is integrated 
into an existing WinCC station.  

Integration of Maintenance Station into an existing WinCC station 
With this type of configuration, the Maintenance Station is also installed on an existing 
WinCC station and integrated into the WinCC project.  

 
The diagram shows an application with this type of configuration. Components previously 
implemented in the plant, for example: 
● Automation systems 
● S7 Engineering Station for configuration 
● Several WinCC stations 1 and 2 for "operating and monitoring". 
The Maintenance Station is now expanded for asset management. The existing hardware 
remains in use. 

Communication 
An interconnection with the system bus is required.  

Software and license requirements 
Software which must be installed on the Maintenance Station: 
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● SIMATIC Maintenance Station. 
Installation of one of one of the "Engineering", "Server" or "Client" options on the PC, 
depending on your configuration. For more detailed information, refer to "Installing 
SIMATIC Maintenance Station (Page 53)". 

● Maintenance Station license keys.  
The "Runtime" license key is required to visualize diagnostics data on the PC. The 
"Engineering" license key is required if the PC is used for Maintenance Station 
engineering. 

● SIMATIC WinCC version as specified in the "Hardware and software requirements" 
section. 

● License key for SNMP OPC Server if SNMP-compatible network components or industrial 
PCs are to be integrated in the diagnostics system. 

If both conditions defined below apply to the PC which is used to visualize diagnostics data, 
the following conditions will apply to the software. 
● The Maintenance Station is engineered on the S7 Engineering-Station and diagnostics 

data are visualized on a separate PC. 
● The "Loop-in-HW-Config" function is used for diagnostics.  
If this applies, the software and data shown below must be installed on the PC: 
● SIMATIC STEP 7.  
● A copy of the S7 project. 
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2.5 SIMATIC Maintenance Station Stand-alone 

Definition 
SIMATIC Maintenance Station Stand-alone: SIMATIC Maintenance Station is implemented 
on a new or separate PC which is dedicated to operation of the SIMATIC Maintenance 
Station.  

"Stand-alone" configuration 
With this type of configuration, a PC is dedicated to handling Maintenance Station 
diagnostics. The same PC can be used for Maintenance Station engineering. It is usually 
more practical to use the S7 ES for Maintenance Station engineering. 
An example of this type of configuration is the expansion of a plant which was previously 
operated only with automation systems and without WinCC stations for operating and 
monitoring, for example. The Maintenance Station is now expanded for asset management.  

 
The diagram shows the configuration for using the S7 ES for Maintenance Station 
Engineering. Diagnostics data are visualized on a separate PC.  

Communication 
Integration into the system bus. 
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Software and data requirements 
 

Maintenance Station engineering and diagnostics on the same PC 
The following software and data must be installed or available when the same PC is being 
used for Maintenance Station engineering and diagnostics: 
● SIMATIC Maintenance Station "Engineering" 
● License keys for Maintenance Station "Engineering" and "Runtime". 
● SIMATIC WinCC version as specified in the "Hardware and software requirements" 

section.  
● SIMATIC WinCC license keys. 
● License key for SNMP OPC Server if SNMP-compatible network components or industrial 

PCs are to be integrated in the diagnostics system. 
● SIMATIC STEP 7, including the license key  
● A copy of the S7 project from the S7 Engineering Station if the S7 ES is not used for 

Maintenance Station engineering or if the "Loop-in-HW-Config" is to be used for 
diagnostics. 

Maintenance Station engineering and diagnostics on different PCs 
Software and data which must be installed or available when using the S7 ES for 
Maintenance Station engineering and a separate PC to visualize diagnostics data:  
On the S7 Engineering Station and on the new Maintenance Engineering Station: 
● SIMATIC Maintenance Station "Engineering" 
● The Maintenance Station "Engineering" license key. 
● SIMATIC WinCC version as specified in the "Hardware and software requirements" 

section. 
● SIMATIC WinCC license keys. 
On the PC used to visualize diagnostics data: 
● SIMATIC Maintenance Station "Server" 
● SIMATIC WinCC version as specified in the "Hardware and software requirements" 

section. 
● SIMATIC WinCC license keys. 
● The Maintenance Station "Runtime" license key. 
● License key for SNMP OPC Server if SNMP-compatible network components or industrial 

PCs are to be integrated in the diagnostics system. 
Additional software packages and data required on the PC used to visualize diagnostics data 
when using the "Loop-in-HW-Config" function for diagnostics:  
● SIMATIC STEP 7, including the license key 
● Copy of the S7 project. 
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2.6 Information on client-server architectures 

Introduction 
SIMATIC Maintenance Station can be installed as client or server station, independent of 
their operation as stand-alone or combined station.  

Maintenance Station in a client-server architecture 
The functionality of a Maintenance Station operated in a client-server architecture is 
distributed to several PCs. Maintenance Station Server processes the signals and 
diagnostics messages relevant to maintenance. Maintenance Station Client is used to 
visualize diagnostics data and to manage the status of maintenance tasks.  
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A Maintenance Station operated in a client-server architecture represents a WinCC multiuser 
project for applications with the system's plant types described below.  
● Multiuser system: Other WinCC stations in the client-server architecture are always 

implemented as multiuser projects. 
● Mixed system: The system contains multiuser and single-user WinCC stations. 
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Communication 
● The Maintenance Station Server must be interconnected with the terminal bus.  

An interconnection with the system bus is optional. A direct process interface, for 
example. via system bus, is only required for communication with automation systems 
which are only assigned to WinCC single-user stations. 

● The Maintenance Station Client must be interconnected with the terminal bus. An MS 
client which is also used as S7 Engineering Station must be interconnected with the 
system bus.  
Integration of the "Loop-in-HW-Config" function for diagnostics requires a direct process 
interface to the automation systems which are only assigned to WinCC single-user 
stations.  

Software and data requirements of Maintenance Station Client 
Software or data which must be installed or be available:  
● SIMATIC Maintenance Station "Client" 
● SIMATIC WinCC, including the "WinCC RT" license key 
● Server packages of all configured WinCC servers and of Maintenance Station Server. 
Additional software required if Maintenance Station Client is not used concurrently as S7 
Engineering Station and when using the "Loop-in-HW-Config" function for diagnostics:  
● SIMATIC STEP 7, including the license key  
● Configuration data of the S7 project. 

Software and data requirements of Maintenance Station Server 
Software requirements when installing Maintenance Station Server on a WinCC server: 
● SIMATIC Maintenance Station "Server" 
● The Maintenance Station "Runtime" license key. 
● License key for SNMP OPC Server if SNMP-compatible network components or industrial 

PCs are to be integrated in the diagnostics system.  
The following software is also required for adding a new Maintenance Station Server PC:  
● SIMATIC WinCC, including the "Server" option. 
● The "WinCC RC" and "WinCC Server" license keys. 
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Properties of Maintenance Station Server  
Maintenance Station Server, "MS-Server" in the following, can be implemented with or 
without interconnection with the system bus. The user can decide whether to configure MS 
Server for operation on a WinCC station with system bus connection or on a separate PC. 
This is an optional configuration which does not depend on factors such as system 
utilization.  
A direct process interface is required for the diagnostics of automation systems which are 
only assigned to WinCC single-user stations.  
The direct process interface can be formed by a network or physical direct connections 
connections. The diagram above shows this scenarios for the "AS10". The project type of 
this WinCC single-user station may also be converted into a multiuser project in order to 
allow communication using server packages. However, this configuration changes software 
requirements, for example, in terms of availability of the "WinCC Server" component and 
corresponding license.  

 

 Note 
If the project type is changed after the diagnostics screens have been created for the first 
time, please note the information in "Changing the project type in WinCC (Page 149)". 

 
The MS Server can be operated in stand-alone or redundant mode.  
Data relevant to diagnostics which are archived on MS Server:  
● The diagnostics screens including the hierarchic structure. 
● Variables of SNMP OPC server 
● Internal variables for the diagnostics status. 
● Variable for the diagnostics status of S7 automation systems with direct connection to MS 

Server. 
● Status variables for PC stations and network components. 
If the SNMP OPC Server is being used on the MS Server, a system bus connection is 
required for diagnostics purposes: for example, Optical Switch Module "OSM" and Electrical 
Switch Module "ESM".  
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Properties of Maintenance Station Client  
The Maintenance Station Client, "MS Client" in the following, is a WinCC client with 
integrated project. In order to access data of the MS Server and of other WinCC servers the 
MS Client requires the corresponding server data, namely the packages. The data of other 
WinCC servers must be available because the diagnostics faceplates are interconnected 
with the variables of the various WinCC servers. 
Each client supports visualization of the data of up to twelve servers or redundant server 
pairs. 
The MS Client can also be implemented directly on the S7 ES. In this case, actual S7 project 
data are already available to the MS Client. MS Client must be deactivated when you edit the 
project data.  
The S7 project data must be available on the MS Client when "Loop-in-HW-Config" is used 
for diagnostics. A direct process connection is also required for communication with 
automation systems which are only assigned to WinCC single-user stations. 

 

 Note 
The server names must be unambiguous within the distributed system and the plant in order 
to be able to visualize the data of different servers. 
All external server configuration data must be available on the clients for their proper 
visualization in the client project. The term external data refers to functions such as ActiveX 
Controls which do not originate from WinCC and to external graphic objects, for example, 
which are not integrated as OLE objects.  

 
For more detailed information on the configuration of client-server systems, refer to the 
WinCC documentation, "Configurations > Distributed systems". 
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Installation of SIMATIC Maintenance Station 3
3.1 Hardware and software requirements 

Notes on installation 
Please observe the installation information provided in the "readme" file on your SIMATIC 
Maintenance Station product DVD.  

Hardware requirements 
 

System Clock rate Main memory Free hard disk 
space 

Engineering station 2.8 GHz 1 GB 15 GB 
Maintenance Station Stand-alone /  
WinCC-Station "Single-user 
Workstation"  

2.8 GHz 1 GB 15 GB 

Maintenance Station Server /  
WinCC Server  

2.8 GHz 1 GB 15 GB 

Maintenance Station Client / 
WinCC Client  

2.8 GHz 512 MB 3 GB 
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Software requirements 

Supported operating systems  
 

System Operating system 
Engineering station "ES" Windows XP Professional SP2  

Windows Server 2003 SP2  
Maintenance Station Stand-alone /  
WinCC-Station "Single-user Workstation"  

Windows XP Professional SP2  
Windows Server 2003 SP2 

ES with  
Maintenance Station Stand-alone  

Windows XP Professional SP2  
Windows Server 2003 SP2 

Maintenance Station Server /  
WinCC Server  

Windows Server 2003 SP2  

Maintenance Station Client /  
WinCC Client  

Windows XP Professional SP2  
Windows Server 2003 SP2 

 
 

 Note 
The Windows Firewall must be deactivated when running the Windows XP SP2 operating 
system. The active Windows Firewall may prevent communication and data exchange 
between the PCs.  

 
 

SIMATIC software 
The software below is not supplied and installed with the SIMATIC Maintenance Station.  
Depending on the intended use of a PC, the software must be installed prior to the 
Maintenance Station.  
● SIMATIC STEP 7 V5.4 SP3 
● SIMATIC WinCC V6.2 SP2 or V7.0 
● SIMATIC NET V6.4 

See also 
Configurations of the SIMATIC Maintenance Station (Page 23) 
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3.2 Licensing 

Introduction 
The SIMATIC Maintenance Station software is protected by copyright, as is the case with 
other SIMATIC software such as WinCC and STEP 7; it requires a valid license agreement 
for unrestricted use. The SW is licensed with a Certificate of License "CoL" and the license 
keys supplied alongside with the SIMATIC software package on a separate license key 
volume. License keys are the technical representatives of the license.  
The installation procedure transfers the license key to a local drive and clears it on the 
license key volume. Users may acquire more than one license key per licensed component 
on SIMATIC Maintenance Station. This feature is not supported for any other SIMATIC 
software.  
License keys can be installed using Automation License Manager. Automation License 
Manager for managing the license keys is included in the Maintenance Station software 
package.  
SIMATIC software such as WinCC only runs in demo mode if the corresponding license key 
is not installed. The software also changes to demo mode if the maximum number of 
licensed process variables or archive variables is exceeded in a project.  
The SW runs in demo mode for a limited period. Any further use upon expiration of the trial 
period constitutes a breach of SIMATIC software license agreements. For additional 
information, refer to the corresponding SIMATIC software "Licensing" documentation.  

Basic license key types 
● Single license:  

The software can be used on any PC for an unlimited amount of time. The type of use is 
determined from the Certificate of License (CoL).  

● Floating License  
This license grants you the use the software for an unlimited period of time. Users can 
obtain this type of license from a connected PC to allow the use of protected SW 
products for which a local license key is not available.  

For further information on license types, refer to the Automation License Manager 
documentation.  
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Licensing of SIMATIC Maintenance Station 
 
License key Description Family 
SIMATIC Maintenance Station 2007 
Engineering 

SIMATIC Maintenance Station only for 
Engineering  

SIMATIC MS 

SIMATIC Maintenance Station 2007 
Runtime 

SIMATIC Maintenance Station  
Different license keys for Runtime:  
100 tags / assets 
500 tags / assets 
1000 tags / assets 
The number of assets is indicated at the 
"Validity" parameter. 

SIMATIC MS 

Installed Runtime license keys may be accumulated.  
The user may install two Runtime license keys for 100 and 500 assets to cover the use of 
520 diagnostics components, for example. Such a setup covers the licensing of 600 assets.  
 

 

 Note 
SIMATIC Manager returns the total number of configured assets which require licensing for 
diagnostics. Select "Diagnostics screens > Configured objects" from the shortcut menu of 
your project. 
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Overview of license keys required 
● License keys to install on the PC for Maintenance Station Engineering. 

 
License key Description Family 
SIMATIC Maintenance Station 2007 
Engineering 

SIMATIC Maintenance Station Engineering  SIMATIC MS 

STEP 7 SIMATIC STEP 7 V5.4  SIMATIC STEP 7 
WinCC RC (x) WinCC for WinCC Engineering and Runtime 

(corresponding to the version of WinCC in use)  
SIMATIC HMI 

Industrial Ethernet SOFTNET S7 Lean SIMATIC NET PC-Software V6.4  SIMATIC NET 

 
● License keys to install on the PC for visualization of diagnostics data 

 
License key Description Family 
SIMATIC Maintenance Station 2007 
Runtime 

SIMATIC Maintenance Station Runtime  
Different license keys, depending on the number of 
assets.  

SIMATIC MS 

STEP 7 If SIMATIC STEP 7 V5.4 is installed, optional for 
the "Loop-in-HW-Config" diagnostics function  

SIMATIC STEP 7 

WinCC RC (x) 
or  
WinCC RT (x) 

WinCC for WinCC Engineering and 
Runtime/Diagnostics  
or for WinCC Runtime/Diagnostics 
(corresponding to the version of WinCC in use) 

SIMATIC HMI 

Industrial Ethernet SOFTNET S7 Lean SIMATIC NET PC-Software V6.4  SIMATIC NET 
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Maintenance Station in a client-server architecture 
● License keys on Maintenance Station Server. 

 
License key Description Family 
SIMATIC Maintenance Station 2007 
Runtime 

SIMATIC Maintenance Station Runtime  
Different license keys, depending on the number of 
assets.  

SIMATIC MS 

WinCC RC (x) WinCC for WinCC Engineering and Runtime 
(corresponding to the version of WinCC in use) 

SIMATIC HMI 

WinCC Server Optional: WinCC with "Server" option for 
Maintenance Station Server 
(corresponding to the version of WinCC in use) 

SIMATIC HMI 

Industrial Ethernet SOFTNET S7 Lean SIMATIC NET PC-Software V6.4  SIMATIC NET 

 
● License keys for Maintenance Station Client.  

This PC is only used to visualize diagnostics data.  
Terms defined at "License Keys on the PC used for Maintenance Station Engineering" 
shall apply if Maintenance Station Client is also used for engineering. 

 
License key Description Family 
STEP 7 If SIMATIC STEP 7 V5.4 is installed, optional for 

the "Loop-in-HW-Config" diagnostics function  
SIMATIC STEP 7 

WinCC RT (x) For WinCC Runtime  
(corresponding to the version of WinCC in use) 

SIMATIC HMI 

 

Licensing of SNMP OPC Server 
SIMATIC NET SNMP OPC Server is a component of SIMATIC NET and requires a 
separately purchased license agreement with license key.  
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3.3 Installing license keys 

Introduction 
You license SIMATIC Maintenance Station by installing the license keys supplied on the 
license key volume.  
This section described license key installation using Automation License Manager which is 
included in the Maintenance Station software package.  

Requirements 
Installation requirements 
● The license key volume is not write protected. 
● License keys cannot be installed on a compressed volume. 

Procedure 
The description in the next section shows how to transfer SIMATIC software license keys for 
installation on a relevant PC. 
1. Run Automation License Manager. You select Automation License Manager from the 

Windows Start menu, "SIMATIC > License Management". 
2. Connect plug-in license key volumes to the PC. Place the removable license key volume, 

for example, a floppy disk, into the relevant drive. 
3. Select the drive which contains the license key volume from the navigation window of 

Automation License Manager.  
The view shows all license keys available on this volume. 

4. Select the required license key from the table. You may also select several license keys 
for the transfer. Select "Transfer..." from the shortcut menu of the license key selected. 
This opens the "Transfer License Key" dialog box. 

5. Select the target volume and confirm your entry with "OK". The license key is now 
transferred to the target volume. 

6. Verify the transfer by selecting the target volume from the navigation window of 
Automation License Manager. The view shows the license key you transferred and all 
other existing license keys. 
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Result 
The selected license keys were successfully transferred to the relevant PC. 

 

 Note 
Initialize your license key installation by restarting the corresponding SIMATIC software, for 
example, WinCC and STEP 7. 

 
You uninstall the license keys in reverse order. Open the navigation window of Automation 
License Manager, and then select one or several license keys from the local volume of a PC. 
In the next step, transfer the license keys to a selected license key volume.  
For more detailed information on license key handling, refer to the Automation License 
Manager documentation.  
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3.4 Installing SIMATIC Maintenance Station 

Introduction 
This section describes the installation of SIMATIC Maintenance Station software.  
Software installation packages available: 
● "Maintenance Station Stand-alone" 

For installation of the Maintenance Station in the configuration with the same name, if the 
Maintenance Station is installed on a separate PC that is only used for diagnostics 
purposes. 

● "Maintenance Station Engineering"  
For installation of the entire engineering and diagnostics software on a PC.  
This option also supports installation on a Maintenance Station Client and on a 
Maintenance Station Stand-alone. 

● "Maintenance Station Server"  
For installation of the component with the same name in a client-server architecture.  
This option also supports installation on a Maintenance Station Stand-alone without 
Engineering. 

● "Maintenance Station Client"  
For installation of the component with the same name in a client-server architecture.  

● "Process Server Extension" 
For installation of the extension software on a WinCC Server with the "multiuser system" 
plant type.  

Licensing is prerequisite for using the software. For additional information, please refer to the 
sections "Licensing (Page 47)" and "Installing license keys  (Page 51)".  
Integration of the Maintenance Station in an existing WinCC project may have an impact on 
WinCC licensing, because additional tags may be required for diagnostics functions in this 
project.  

 

 Note 
Maintenance Station requires installation of the WinCC version specified in the hardware and 
software requirements.  
Installation of the Maintenance Station on an existing WinCC station may require an update 
or upgrade of the WinCC software. In particular when upgrading the software, you should 
first read the chapter "Installation Notes > Upgrading WinCC" in the WinCC documentation. 

 

Upgrading the Maintenance Station 
To upgrade the Maintenance Station to a more recent version, proceed as described below.  
During the updating process restarting of the PC may be necessary in order to continue the 
installation successfully.  
When carrying out an upgrade, observe the corresponding configuration steps under the 
topic "Configuration steps in case of changes".  
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Requirements 
● Local administrator rights for installation. 
● The hardware and software requirements must be met for installation of the Maintenance 

Station.  
● Always close SIMATIC WinCC before you install the Maintenance Station software on the 

PC. 

Procedure 
1. Place the product DVD of SIMATIC Maintenance Station into the DVD drive of the PC. 

Setup usually runs automatically. The autorun function of the DVD drive is disabled if 
Setup does not start. In this case, open the DVD directory in Windows Explorer and then 
run Setup by double-clicking "Setup.exe". 

2. Select your Setup language and then click "Next". 
3. Please note the information in the dialog box; for example, relating to open programs. 

Click "Next". 
4. In the "Product information" dialog box, if required you can press the relevant button to 

open the information for reading or printing. Click "Next". 
5. The license agreement dialog box opens. Set the "I accept the terms of this license 

agreement…" check box to continue installation. Click "Next". 
6. Enter the corresponding user information in the dialog box and then click "Next". 
7. The "Program packages" dialog box opens. Select a program package that corresponds 

to the required configuration. The different packages are described in the introduction. 
The help window indicates the installation scope of the option selected. Click "Next". 

8. The "Programs" dialog box shows the programs installed and corresponding update 
requirements. Click "Help" to obtain information on the various status icons. Depending 
on the program package selected, you can also enable or disable options. 

9. Click "Next". SW installation starts. Software Setup is menu-controlled. You can set up 
and configure diverse items in the next setup dialog boxes. Confirm your changes until 
setup is completed. 

Result 
The Maintenance Station software is installed according to the software package you 
selected.  
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Integrating additional components 4
4.1 Integrating standard slaves and Siemens drives 

4.1.1 Overview of the integration of standard slaves and Siemens drives 

Overview  
Siemens drives and non-SIMATIC components can be integrated in the diagnostics system 
as so-called standard slaves, for example DP slaves. The component properties of standard 
slaves are defined by a GSD file.  
The device manufacturer supplies the GSD file. Device data are integrated by importing the 
corresponding GSD file. The standard slave is available in the module catalog after import. 
PROFINET components can also be integrated using a GSD file. The GSD file may be 
multilingual to support different languages.  
The GSD file must be available in the regional languages required. The last letter of the 
"GSD" file name extension is replaced with a language identification letter.  

 
File name extension Language 
GSD Standard file 
GSG German 
GSE English 
GSF French 
GSI Italian 
GSS Spanish 
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4.1.2 GSD file import 

Introduction 
Siemens drives and non-SIMATIC components can be integrated in the diagnostics system 
as sc-called standard slaves; for example DP slaves. The component properties of standard 
slaves are defined by a GSD file. 
The device manufacturer supplies the GSD file. Device data are integrated by importing the 
corresponding GSD file in the "HW Config" editor.  

 

 Note 
The GSD file must be available in the regional languages required.  

 

Procedure 
1. Select the component, for example an AS, from the navigation window of 

SIMATIC Manager. 
2. Select "Open Object" from the shortcut menu. The "HW Config" editor opens the 

hardware configuration of this component. 
3. Select "Options > Install GSD file…". The "Install GSD file" dialog box opens. 
4. From the "Install GSD files:" field, select the source of the GSD files to be installed. Select 

"from the folder" if you have saved the GSD files received from the manufacturer to the 
PC, for example. Select "from STEP 7 project" if you want to copy an already configured 
standard slave from a different project. 

5. Open the selection dialog box by clicking "Find". Select the folder which contains the 
GSD file to be imported or the relevant user project from this dialog box. Close this dialog 
box by clicking "OK". 

6. The table now lists the GSD files of the folder or project you selected. The list also shows 
the languages supported by the GSD file. The revision level and version is only indicated 
for I/O devices. 

7. Select one or several files. You select or deselect all GSD files by clicking "Select all" or 
"Deselect all".  
You can view the log of the previous installation session by clicking "View log file". This 
log file returns information on existing GSD files or on installation errors. 

8. Click "Install" to run the installation session. A message is output to inform you that you 
cannot undo the selected GSD file installation. Confirm this dialog by clicking the "Yes". 

9. The system outputs a message when setup is completed. Confirm this message. Exit the 
"Install GSD files" dialog box by clicking "Close", or select further files for installation and 
repeat the procedure starting at step 4. 

Result 
Import of the GSD file for the standard slave is completed. The component can now be 
integrated into the diagnostics system.  
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4.2 Integrating other components using the asset proxy 

4.2.1 Using the asset proxy 

Overview  
An Asset Proxy is used to integrate the plant components outlined below into the diagnostics 
system of SIMATIC Maintenance Station.  
● Interfaces of logical devices, i.e. hardware interfaces or other function blocks. 

– A welding robot connected via I/O interface. The status is reported via the interface. 
The user can program error evaluation and output the diagnostics status and 
messages at the Asset Proxy. 

– A SW controller block can be integrated in the diagnostics system Asset Proxy in 
order to visualize control loop errors. 

● Components which do not support standard diagnostics because these are not standard 
slaves, for example. 

● Components of "DRIVE ES". 
● Components not configured in the S7 project. 
An asset proxy is visualized similar to other components in icon format on the diagnostics 
screens.  
The diagnostics status and messages of an asset proxy are integrated automatically into the 
diagnostics status of a corresponding AS. 

Asset Proxy types 
The two types available are distinguished by the value of the "S7_asset" attribute in the 
corresponding function block: 
● Standard:  

The "S7_asset" attribute is assigned the "standard" value. 
This type applies to components which are not available in the module catalog of the 
"HW Config" editor, because these are non-SIMATIC components, for example, or cannot 
be integrated as standard slaves. 

● Extended:  
The "S7_asset" attribute is assigned the "Extended" value.  
This type applies to components of "DRIVE ES". DRIVE ES is an Engineering System for 
all Siemens drives.  
"DRIVE ES" provides the corresponding components or drives in the module catalog of 
the "HW Config" editor. Configured function blocks which can be used to program asset 
proxies for these components are also made available in a block library. 
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Configuring an asset proxy 
The user configures various functions for the asset proxy. 
● The interface for the "MaintenanceState" diagnostics status and its data. 

A function block and an instance DB assigned the "S7_asset" attribute are defined for the 
configuration of an asset proxy. The value of the attribute in the FB is determined by the 
type of asset proxy. A function block can be used to generate several instance DBs for an 
asset proxy or to assign these to the proxy.  
These blocks are used to manage the "MaintenanceState" diagnostics status of the 
component represented by the asset proxy. Instead of being generated automatically by 
the Maintenance Station, the diagnostics data are programmed in the function block by 
the user. 

● Diagnostics messages of the component:  
Instead of being generated automatically by the Maintenance Station, the diagnostics 
messages are programmed by the user. 

The configured FBs from a block library can be adapted to suit the components of "DRIVE 
ES".  

Visualization in the diagnostics screens 
The diagnostics screens only visualize an asset proxy in the AS overview screen because it 
is not possible to assign these to a hierarchic structure.  
Asset proxies for PROFIBUS slaves are assigned to a specific bus segment and are not 
represented by an icon on the overview screen.  
The symbols for Asset Proxies are available in the block symbol file 
"@@MaintenanceTypicals.pdl", same as all other symbols for the diagnostics screens.  
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4.2.2 Diagnostics status word as interface to the asset proxy 

Diagnostics status word as interface to the asset proxy 
The "MaintenanceState" diagnostics status word interfaces the status of the asset proxy with 
the Maintenance Station and the diagnostics functions of this station. This status word 
manages maintenance-relevant states of the components and asset proxies.  

 
 

You can find a detailed description on the structure of the diagnostics status word in "Syntax 
of the diagnostics status word MaintenanceState "MST" (Page 102)".  

Parameterization of the interface  
A function block and an instance DB are programmed for each asset proxy. The status word 
interface and the variable relevant to maintenance are defined in this function block.  
The data of the diagnostics status word for the asset proxy are not generated based on 
Maintenance Station functionality. Instead, these are programmed by the user in the 
corresponding function block. 

Visualization in the diagnostics screens 
The component symbols output to the diagnostics screens return the states of the 
diagnostics status word as usual for other components. The status is also integrated into the 
group displays of the hierarchy.  
Diagnostics messages to the asset proxy must be programmed by the user. For additional 
information on this topic, please refer to "Triggering diagnostics messages for the asset 
proxy (Page 67)".  
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4.2.3 PROFIBUS DP slave as asset proxy 

Asset Proxy for a PROFIBUS DP slave  
Asset proxies can be implemented, for example, for drives which have been configured in 
"HW Config" as PROFIBUS slave but do not return standard slave characteristics.  
The same applies to drives with "PROFIdrive" device profile on the basis of PROFIBUS.  
This type of configuration is based on the fact that these PROFIBUS slaves do not use 
standard diagnostics functions to report errors to a corresponding higher-level component 
such as an AS.  
Based on its slave configuration, the drive is detected and handled by the Maintenance 
Station as "normal" PROFIBUS slave. A corresponding "MaintenanceState" status variable 
is generated and managed to his effect. As this status variable is not saved to the 
diagnostics DB as for standard PROFIBUS components, it is saved to the DB which is 
configured to output values to the asset proxy.  
Asset proxies for PROFIBUS slaves are always assigned to a specific bus segment and 
therefore affect the group displays and diagnostics status displays of their bus segment.  
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4.2.4 Creating an "Extended" type asset proxy 

Introduction 
The asset proxy configuration depends on its type. This section describes the configuration 
of an "Extended" type.  
This type applies to components of "DRIVE ES". DRIVE ES is an Engineering System for all 
Siemens drives.  
"DRIVE ES" provides the corresponding components or drives in the module catalog of the 
"HW Config" editor. Configured function blocks which can be used to program asset proxies 
for these components are also made available in a block library. The elements of these FBs, 
such as variables and attributes, are pre-programmed to suit component requirements.  
For more detailed information on supported components or drives, as well as on selecting 
FBs, refer to the "DRIVE ES" documentation.  

Procedure 
1. From the Navigator of SIMATIC Manager, select the icon of the AS you want to assign 

the asset proxy. Open the "HW Config" editor by double-clicking the "Hardware" icon in 
the right-hand window. 

2. Navigate to the corresponding module catalog folder and select the component required. 
Drag-and-drop the component you selected to an AS bus system such as "PROFIBUS(x): 
DP master system(x)". Close the "Properties" dialog box of the interface. 

3. Open the "Properties" dialog box by double-clicking the component you inserted. Open 
the "General" tab and note down the value returned in the "Diagnostics address" field. 
Close the dialog box. 

4. Select "Station > Save" in the "HW Config" editor. Click "Station > Close" to close the 
editor. 

5. Insert the asset proxy FB which matches your component from the block library of 
"DRIVE ES". Note the description in the introduction section. 

6. Select the "Blocks" subfolder from the navigation window of SIMATIC Manager. Select 
"Insert new object > Data block" from the shortcut menu. The "Properties - Data block" 
dialog box opens. 

7. Change to the "General - Part 1" tab. Name the block in the "Name and type" row. You 
should use a similar numbering scheme to make it easier to recognize the function block 
context. Select "Instance DB" from the box on the right side, and then select the FB from 
the box next to it. 

8. Type a name into the "Symbolic name" input box. Close the dialog box by clicking "OK". 
The program automatically sets the "S7_asset" attribute and the "Extended" value on the 
"Attribute" tab. 

9. Open the "DB-Param" dialog box by double-clicking the new DB on the block window. 
Select the value "LADDR" from the "Name" column of the table. Type the value taken in 
step 3 from the "Diagnostics address" field into the same row of the "Actual value" 
column. Save your entries with "Data block > Save" and then close the dialog box. 
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10. Select the new data block from the block window. Select "Special object properties > 
Operating and monitoring..." from the shortcut menu. Activate the "Operating and 
monitoring" check box. Close the dialog by clicking "Save". 

11. From the navigation window, select the icon of the AS in which you created the new asset 
proxy. Select "PLC > Compile and download" to download the blocks you generated to 
the corresponding AS. 

Result 
The blocks for an asset proxy of the "Extended" type have been inserted into the S7 project. 

 

 Note 
Verify that the asset proxy FB is called in the S7 program of the AS. Further information 
relating to the call and programming is available in the "DRIVE ES" documentation.  

 



 Integrating additional components 
 4.2 Integrating other components using the asset proxy 

SIMATIC Maintenance Station 2007 
Operating Manual, 04/2008, A5E00901992-03 63 

4.2.5 Creating an asset proxy of the "Standard" type 

Introduction 
The asset proxy configuration depends on its type. This section describes the configuration 
of an "Standard" type.  
The S7 program requires an FB and a DB for managing the diagnostics status of an asset 
proxy. The section below shows the parameter or variable declarations in the FB.  

 
Name Data type Value of the 

"S7_m_c" attribute 
Representation in the 
diagnostics faceplate 

MS DWord "TRUE" As status symbols for 
"MaintenanceState" 

MESSAGE String[50] "TRUE" "Message" field 
HWTYPE String[50] "TRUE" "Device type" field 
MANUFACTURED_ID String[50] "TRUE" "Manufacturer" field 
ORDER_ID String[50] "TRUE" "Order number" field 
SERIAL_NUMBER String[50] "TRUE" "Serial number" 
INST_DATE String[50] "TRUE" "Installation date" field 
HARDWARE_REVISION String[50] "TRUE" "HW revision" field 
SOFTWARE_REVISION String[50] "TRUE" "SW revision" field 
COMMENT String[50] "TRUE" "Comment" field 
ASSET_ID String[32] "TRUE" No display 

Additional information about the representation of the data in the diagnostics faceplate is 
available under the topic "Source and representation of component data".  
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Procedure 
1. From the Navigator of SIMATIC Manager, select the icon of the AS you want to assign 

the asset proxy. 
2. Navigate to the "Blocks" subfolder in the navigator of SIMATIC Manager. Select "Insert 

new object > Function block" from the shortcut menu. The "Properties - Function block" 
dialog box opens. 

3. Assign a block name on the "General - Part 1" tab. Change to the "Attributes" tab. Select 
the "S7_asset" value from the first free row from the top of the "Attribute" column. Enter 
the text "Standard" in the corresponding "Value" column. Note that these entries are case 
sensitive. Close the dialog box by clicking "OK". 

4. Open the "LAD/STL/FBD" editor by double-clicking the new FB on the block window. 
Select the "IN" icon from the "Interface" area of the programming window. Create a new 
variable according to the list shown earlier. Observe the notation. 

5. Set the values of the "S7_m_c" attribute at the variables according to the table shown 
earlier. Select the relevant variable from the list and then select the "Object properties" 
command from the shortcut menu. Select the "Attributes" tab on the "Properties - 
Variable" dialog box. Select the "S7_m_c" value from the first free row from the top of the 
"Attribute" column. Enter "TRUE" in the corresponding "Value" column. Close the dialog 
box by clicking "OK". Repeat this step for all necessary variables. 

6. Save your entries by clicking "File > Save". 
7. Select the "Blocks" subfolder from the navigation window of SIMATIC Manager. Select 

"Insert new object > Data block" from the shortcut menu. The "Properties - Data block" 
dialog box opens. 

8. Change to the "General - Part 1" tab. Name the block in the "Name and type" row. You 
should use a similar numbering scheme to make it easier to recognize the function block 
context. Select "Instance DB" from the box on the right side, and then select the FB from 
the box next to it. 

9. Type a name into the "Symbolic name" input box. This symbolic name is used for the 
icons of the diagnostics screens. Close the dialog box by clicking "OK". The program 
automatically sets the "S7_asset" attribute and the "Standard" value on the "Attributes" 
tab. 

10. Select the new data block from the block window. Select "Special object properties > 
Operating and monitoring..." from the shortcut menu. Activate the "Operating and 
monitoring" check box. Close the dialog box by clicking "Save". 

11. From the navigation window, select the icon of the AS in which you created the new asset 
proxy blocks. Select "PLC > Compile and download" to download the blocks you 
generated to the corresponding AS. 
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Result 
The blocks for an asset proxy of the "Standard" type have been inserted into the S7 project.  

 

 Note 
Verify that the asset proxy FB is called in the S7 program of the AS.  
The diagnostics status data are programmed in the FB. The Maintenance Station does not 
automatically program these FBs.  

 

See also 
Source and visualization of component data (Page 90) 
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4.2.6 Configuring an asset ID for individual export with a standard asset proxy 

Introduction 
To use the "Individual export" function with a standard type of asset proxy block, what is 
known as an asset ID must be configured in the instance data block for the asset proxy.  
The asset ID is used to identify the asset proxy and must be unique across the entire project. 
The asset ID is a character string of 32 characters that is transferred to the export file when 
an individual export is carried out. 

Requirements 
The instance data block for this asset proxy has been created.  

Procedure 
1. In the block window of the SIMATIC Manager, select the instance data block for the asset 

proxy. 
2. Double-click the data block to open it. 
3. For the "ASSET_ID" element in the "Actual value" column, enter a character string as the 

asset ID for this asset proxy.  
A maximum of 32 characters may be used.  
Special characters such as "/,\,:,.,?,*,<,>,|" are not permitted.  
Please note the syntax of the data type. 

4. Save the changes and exit the editor. 
5. Update the diagnostics screens by selecting "Options > Diagnostics screens > Create...". 
6. In the SIMATIC Manager navigation window, select the icon corresponding to the 

automation system in which the data block has been changed to the asset proxy. Select 
"PLC > Compile and download" from the shortcut menu to download the block you have 
changed to the corresponding AS. 

Result 
The asset ID of a standard asset proxy is configured for individual export of the component 
data.  

See also 
Creating an asset proxy of the "Standard" type (Page 63) 
Introduction to exporting the data of an individual component (Page 153) 
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4.2.7 Triggering diagnostics messages for the asset proxy 

Overview 
To trigger diagnostics messages for an asset proxy, the user must configure "ALARM_S" 
and "ALARM_D" messages.  
This function is programmed in the S7 program using the following default message blocks: 
● SFC17 "ALARM_SQ" 
● SFC18 "ALARM_S" 
● SFC107 "ALARM_DQ" 
● SFC108 "ALARM_D" 
For more detailed information on "ALARM_xx" messages, please refer to the "Configuring 
messages" section in the SIMATIC STEP 7 documentation.  

4.2.8 Assigning diagnostics messages to an asset proxy 

Introduction 
In the case of diagnostics messages for an asset proxy, what are known as "ALARM_S" or 
"ALARM_D" messages are triggered in the AS, as described in the section titled "Triggering 
diagnostics messages for the asset proxy".  
These diagnostics messages are transferred to the Maintenance Station. To use the 
Maintenance Station functionality, the user must configure another assignment of the 
incoming messages to the corresponding asset proxy.  
For this purpose, you will have to enter the name of the diagnostics area in message text 2 
of the instance data block. In addition, the "S7_m_c" attribute must be set to "TRUE" at this 
data block.  
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Procedure 
1. In the block window of the SIMATIC Manager, select the instance data block for an asset 

proxy. 
2. Select "Special object properties --> Message..." from the shortcut menu. The "Message 

configuration" dialog box will open. 
3. Click the "Advanced" button. Change to the "Additional text" tab. 
4. Enter the name of the diagnostics area in additional text 2.  

You can find this name in the "Name of the diagnostics area" field in the "Settings for 
Generating Diagnostic Screens" dialog box. Once you have selected the project in the 
SIMATIC Manager, you can open the dialog box by selecting "Options > Diagnostic 
screens > Settings..." 

5. Close the dialog box by clicking "OK". 
6. In addition, the "S7_m_c" attribute must be set to "TRUE" at this block. 

To do this, select the data block in the block window, followed by "Object properties..." in 
the shortcut menu. Change to the "Attributes" tab on the "Properties - Instance data 
block" dialog box. 

7. In the table, check that the value of the "S7_m_c" attribute is set to "TRUE"; correct it if 
necessary.  
If the "S7_m_c" attribute is not present, select the value "S7_m_c" in the uppermost 
empty line of the "Attribute" column. Enter "TRUE" in the same line of the "Value" column. 

8. Close the dialog box by clicking "OK". 
9. Select the Maintenance Station OS in the navigation window of the SIMATIC Manager.  

Select "Compile" from the shortcut menu. 
10. In the navigation window, select the icon for the AS in which the asset proxy blocks have 

just been changed. In the shortcut menu, select "PLC > Download" to download the 
blocks you have changed to the corresponding AS. 

Result 
The assignment of the diagnostics messages from the AS to the corresponding asset proxy 
is configured and, therefore, the correct functionality for the diagnostics messages 
guaranteed in the Maintenance Station.  

 

 Note 
Please note that the settings are language-dependent. You can find the language set in the 
upper part of the "Message configuration" dialog box. 
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4.3 Integration of SNMP components 

4.3.1 Optional diagnostics of SNMP components 

Optional diagnostics of SNMP components  
SIMATIC NET SNMP OPC Server is deployed as an optional feature for network component 
diagnostics using the Maintenance Station. SNMP OPC Server also supports the diagnostics 
of SNMP components such as the Optical Switch Module "OSM" and the Electrical Switch 
Module "ESM".  
The term OPC (= OLE for Process Control) denotes an interface for data exchange used in 
automation engineering. The Simple Network Management Protocol "SNMP" is used for 
network management. SNMP supports read and write access to the variables of network 
components. The Maintenance Station only performs read operations. 
Components which support diagnostics functions using SNMP.  
● Ethernet components such as SCALANCE X / W, OSM and ESM. 
● WinAC/LC with SIMATIC NET CP 
● SIMATIC S7 300/400 CPs, for example, CP343-1 IT 
● PROFINET devices such as ET200S 
● Industrial PCs such as SIMATIC PC 
● SNMP-compatible non-Siemens devices 

Profile 
Standard SNMP variables are defined in "Management Information Base MIB-2". This 
database defines the variables which should be supported by all network components. 
These default variables are imported to all default profiles.  
Profile "MIB-2" should be used for devices lacking a user-specific or manufacturer profile.  
In addition to these standard variables of "MIB-2", each manufacturer of network devices can 
implement additional, device-specific SNMP variables which do not conform to the standard. 
Siemens also defines additional SNMP variables for SIMATIC components. In order to 
support these specific variables, the components are supplied with the additional, Siemens-
specific profiles such as "Profil_IPC_VXX.txt" for IPC, or "CP443-1_Advanced.txt" for the 
central communication processor CP443-1 Advanced.  
The standard profile MIB-2 "MIB_II_V10.txt", a user-specific profile, or a profile supplied by 
the manufacturer can be implemented for non-SIMATIC network devices. The SNMP profiles 
are saved to the "..\SIEMENS\STEP7\S7DATA\snmp\profile" folder. 
The configuration dialog of OPC Server is used to create profiles.  
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Licensing 
● SIMATIC NET SNMP OPC Server requires a separate license. The Maintenance Station 

license cannot be used to run OPC Server.  
● The server license does not include SNMP components. Allowances must be made at 

each SNMP component for the number of assets to be licensed with the Maintenance 
Station "Runtime" license key. 

 

  Note 
SNMP OPC Server must be installed and configured for SNMP component diagnostics 
before you modify existing or create new diagnostics screens. The SNMP components 
must also be assigned to the SNMP OPC Server to ensure proper creation of the 
diagnostics screens.  

Requirements 
● The SNMP service must be installed, configured and activated on the components to be 

monitored.  
● SNMP must be active at all SNMP components which participate in the diagnostics 

system. 
● All SNMP components integrated in the diagnostics system require a network connection. 
● In order to provide support of special views in the diagnostics faceplate, install 

"SIMATIC PC DiagMonitor" V2.0 or higher on the SIMATIC Industrial PC.  

Configuration overview 
1. SNMP OPC Server license key is installed on the PC running the Maintenance Station 

application. In distributed systems, it is installed on the Maintenance Station Server, and 
with other configurations on the PC running the visualization of diagnostics data. 
SNMP OPC Server is integrated into the SIMATIC NET software and is automatically 
included when the user installs the Maintenance Station. 

2. SNMP OPC Server is implemented in the project as "OPC Server" in SIMATIC Manager. 
3. All SNMP components to be provided diagnostics functions based on SNMP are 

assigned to OPC Server. 
 

  Note 
A redundant computer running Maintenance Station must be configured appropriately 
when operated on a redundant system.  

Visualization in the diagnostics screens 
SNMP components are visualized as SNMP objects in the "Network components" overview. 
These objects are not indicated by a PC icon in order to distinguish these from other PC 
stations.  
The "PC stations" overview also visualizes industrial PCs which are integrated as SNMP 
components.  
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4.3.2 Integrating SIMATIC NET SNMP OPC Server into the project 

Introduction 
The Maintenance Station also supports the diagnostics of SNMP components such as the 
Optical Switch Module "OSM" and the Electrical Switch Module "ESM". These functions are 
handled by SIMATIC NET SNMP OPC Server.  
You implement SNMP OPC Server in SIMATIC Manager as application for the PC station 
running the Maintenance Station.  

Requirements 
SNMP OPC Server license key is installed on the PC running the Maintenance Station 
application. In distributed systems, it is installed on the Maintenance Station Server, and with 
other configurations on the PC running the visualization of diagnostics data. SNMP OPC 
Server is integrated into the SIMATIC NET software and is automatically included when the 
user installs the Maintenance Station.  

Procedure 
1. Open SIMATIC Manager and activate the component view. 
2. From the directory tree of the navigation window, select the "PC Station" object of the 

Maintenance Station or of Maintenance Station Server. 
3. Double-click the "Configuration" object on the detail view. The "HW Config" editor opens. 
4. Select the hardware catalog from the "Profile" field, for example, "Standard". 
5. Select the relevant OPC Server from the "SIMATIC PC Station > User Application > OPC 

Server" folder, and then drag-and-drop it to the hardware configuration of the PC station. 
6. Save the configuration by clicking "Save and compile" and then close the "HW Config" 

editor. 

Result 
SIMATIC NET SNMP OPC Server is integrated into the configuration in SIMATIC Manager.  
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4.3.3 Assigning SNMP components to OPC Server 

Introduction 
The OPC Server which is to handle the diagnostics of an SNMP component must be 
assigned this component.  

Naming SNMP components 
Aspects to be taken into account when naming SNMP components:  
● Do not use space or special characters. 
● The names must be unambiguous and should not coincide with any names assigned to 

the PC stations in SIMATIC Manager. 
● The names and IP addresses of SNMP components must be unambiguous in all Ethernet 

networks of a plant configuration. 
For information on the assignment of an industrial PC, refer to "Assigning industrial PCs to 
OPC Server".  

Requirements 
● The hardware configuration has been completed. 
● OPC Server is integrated for the S7 project in SIMATIC Manager. 
● The PC station with OPC Server for Maintenance Station or Maintenance Station Server 

is compiled. 
● The SNMP component is installed in the S7 project. 

Procedure 
1. Select the PC station running OPC Server from the Navigator of SIMATIC Manager. 

Select "Open Object" from the shortcut menu. The "HW Config" editor opens. 
2. Select the OPC Server in the "HW Config" editor, and then select the "Edit > Object 

properties ..." command. The "Properties - OPC Server" dialog box opens. 
3. Open the "SNMP" tab. Accept the default shown in the "Cycle time" box. 
4. Click "Edit plant configuration...". The "Edit plant configuration..." dialog box opens.  

You have two options of integrating new nodes. 
– Click "Add" to create new nodes separately. The program does not support the 

automatic import of different SNMP components, for example OSM and Industrial 
PCs. Add these separately as as described starting at step 6. 

– You automatically import new nodes by clicking "Import new nodes". Continue at 
step 5. 
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5. You can automatically import new nodes by clicking "Import new nodes". The program 
imports all components which have been created in the hardware configuration of the 
current project and assigned a unique IP address.  
Configuration data such as the name and IP address are applied where possible. New 
entries are highlighted in color. 
Continue at step 9 if you do not want to separately import additional components. 

6. Click "Add..." to add new nodes separately or if the program is unable to automatically 
add the SNMP component. The "Add node" dialog box opens. 

7. Type in the name and IP address. Observe the naming conventions defined in the 
preface.  
Set up a suitable profile for the component. The default MIB-2 profile is available in the 
"MIB-II_V10.txt" file.  
Click "Create profile…" in the "Edit plant configuration..." dialog box to create a new 
profile based on a MIB file or to edit a profile. It is advisable to use the "MIB-II_V10.txt" file 
when creating a new profile. You also receive the MIB file from the manufacturer of the 
SNMP network component.  
For further information on SNMP profiles, refer to the section "Optional diagnostics of 
SNMP components". 

8. Accept the data and close the dialog box by clicking "OK".  
Repeat steps 6 to 8 to add further nodes. 

9. Click "OK" to close the "Edit plant configuration..." dialog box. 
10. Click "Export tags for WinCC" on the "SNMP" tab. Click "OK" to close the "Properties – 

OPC Server" dialog box. 
11. Save the configuration and close HW Config. 

 

  Note 
Measures to be taken in order to integrate the SNMP in diagnostics: 
1. If the diagnostics screens were created: 
a) Update the diagnostics screens. 
b) Compile and download the PC station with OPC Server.  
2. When initially creating the diagnostics screens:  
a) Create the diagnostics screens. 
b) Execute "Export tags for WinCC" as described in Step 10.  
c) Compile and download the PC station with OPC Server.  

Result 
The SNMP components are assigned to the OPC Server. You can now run diagnostics 
functions using SNMP.  

 

 Note 
A redundant computer running Maintenance Station must be configured appropriately when 
operated on a redundant system. Copy the configured OPC Server to the redundant PC 
station using the "HW Config" editor. Finally, save and compile the redundant PC station.  
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4.3.4 Assigning industrial PCs components to OPC Server 

Introduction 
In order to include an industrial PC such as SIMATIC PC in the diagnostics system you 
assign it as SNMP component to OPC Server.  

Naming SNMP components 
Aspects to be taken into account when naming SNMP components:  
● Do not use space or special characters. 
● The component name in OPC Server must correspond with the name of the industrial PC 

in SIMATIC Manager.  
● The names must be unambiguous and should not coincide with any names assigned to 

the PC stations in SIMATIC Manager. 
● The names and IP addresses of SNMP components must be unambiguous in all Ethernet 

networks of a plant configuration. 

Requirements 
● The hardware configuration has been completed. 
● OPC Server is integrated for the S7 project in SIMATIC Manager. 
● The PC station with OPC Server for Maintenance Station or Maintenance Station Server 

is compiled. 
● The industrial PC is installed in the S7 project. 
● In order to provide support of special views in the diagnostics faceplate, install 

"SIMATIC PC DiagMonitor" V2.0 or higher on the SIMATIC Industrial PC. This software is 
used for PC diagnostics / message transfer via Ethernet, email and SMS, and for the 
direct transfer of messages to the SIMATIC software using OPC. 
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Procedure 
1. Select the PC station running OPC Server from the Navigator of SIMATIC Manager. 

Select "Open Object" from the shortcut menu. The "HW Config" editor opens. 
2. Select the OPC Server in the "HW Config" editor, and then select the "Edit > Object 

properties ..." command. The "Properties - OPC Server" dialog box opens. 
3. Open the "SNMP" tab. Accept the default shown in the "Cycle time" box. 
4. Click "Edit plant configuration...". The "Edit plant configuration..." dialog box opens. 
5. Click "Add" to add one new node. The "Add node" dialog box opens. The program does 

not support automatic installation of certain SNMP components such as industrial PCs. 
6. Type in the name and IP address. Observe the naming conventions defined in the 

preface.  
Select the file "Profil_IPC_V13.txt" from the "Device profile" box and assign it to the 
industrial PC. For additional information on the SNMP profiles, please refer to "Optional 
diagnostics of SNMP components (Page 69)". 

7. Select the value "public" from the "Community" field.  
Accept the data and close the dialog box by clicking "OK".  
Repeat steps 5 to 7 to add further industrial PCs as nodes. 

8. Click "OK" to close the "Edit plant configuration..." dialog box. 
9. Click "Export tags for WinCC" on the "SNMP" tab. Click "OK" to close the "Properties – 

OPC Server" dialog box. 
10. Save the configuration and close HW Config. 

 

  Note 
Measures to be taken in order to integrate the SNMP in diagnostics: 
1. If the diagnostics screens were created: 
a) Update the diagnostics screens. 
b) Compile and download the PC station with OPC Server.  
2. When initially creating the diagnostics screens:  
a) Create the diagnostics screens. 
b) Execute "Export tags for WinCC" as described in Step 9.  
c) Compile and download the PC station with OPC Server. 

Result 
The industrial PC is assigned as SNMP component to OPC Server. You can now run 
diagnostics functions using SNMP.  

 

 Note 
A redundant computer running Maintenance Station must be configured appropriately when 
operated on a redundant system. Copy the configured OPC Server to the redundant PC 
station using the "HW Config" editor. Finally, save and compile the redundant PC station.  
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Configuration for SIMATIC Maintenance Station 5
5.1 Overview of Maintenance Station engineering 

Requirements 
● The Maintenance Station hardware and software requirements are met. Additional 

information is available in the sections "Hardware and software requirements" and 
"Quantity structures and restraints". 

● Optional for diagnostics of SNMP-compatible network components and industrial PCs:  
The SNMP OPC Server license key is installed. For additional information, please refer to 
"Optional diagnostics of SNMP components (Page 69)". 

● All licenses for the software used on the Maintenance Station are installed. 

Overview of Maintenance Station engineering 
 
Step Configuration step  Application implemented
H1 Editing the data of existing SIMATIC components. This may be based on the 

existing hardware configuration. 
HW Config 

H1a If the data of existing SIMATIC components are applied: Enable diagnostics 
interrupts. 
• Check and enable for existing modules, if necessary, such as 

I/O modules in the component properties dialog box of HW Config. 
• Activate for new modules.  

HW Config 

H1b When migrating S7 projects that were created before STEP 7 V5.4 SP3:  
• For the individual export function, one asset ID for all configured 

components must be manually created on a one-off basis, using the 
"Allocate asset ID..." function. 

HW Config 

H2a Inserting new SIMATIC components in HW Config. HW Config 
H2b Integrate Siemens drives and non-SIMATIC components as standard slaves.  SIMATIC Manager/HW 

Config 
H2c Integrating the components and interfaces of logical devices using an Asset Proxy. SIMATIC Manager/HW 

Config 
H3 If the PC of the Maintenance Station to implement is not yet registered in the S7 

project or when you implement a new PC, for example, as Maintenance Station 
Server: 
• Create the PC station for the Maintenance Station PC in the S7 project.  
• Execute the command "Compile OS" for each new Maintenance Station 

"OS" you created.  

SIMATIC Manager/HW 
Config 
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Step Configuration step  Application implemented
H4 Optional when using SNMP OPC Server:  

• Integrate OPC Server of the Maintenance Station into the project in 
SIMATIC Manager. 

• Edit the SNMP components in the plant configuration of SNMP OPC 
Server. 

SIMATIC Manager/HW 
Config 

   
W1 For initial creation of the diagnostics screens:  

Requirements: The Maintenance Station "OS" was compiled at least once using the 
"Compile OS" function. This function is executed in step "H3" when integrating a 
new PC.  
• Start the "OS Project Editor" in the WinCC project of the Maintenance 

Station. 
• Start the "OS Project Editor" in the WinCC project of all WinCC servers 

in the S7 project which provide diagnostics variables and messages for 
diagnostics in their packages.  

• Define the "single-user" or "multiuser" project in the WinCC project 
properties, depending on the plant type.  

WinCC / OS Project 
Editor 

   
SM1 Defaults for the creation of diagnostics screens:  

• "Create settings for diagnostics screens" dialog box.  
SIMATIC Manager 

   
SM3 For initial creation of the diagnostics screens:  

• Execute the "Create diagnostics screens" function.  
• When using the SNMP OPC Server: Execute the "Export tags for 

WinCC" function in the "Properties – OPC Server" dialog box.  

SIMATIC Manager  

SM3a Delete CPU data from diagnostics data: 
• Change the AS / CPU assignment in the "Create diagnostics screens" 

dialog box.  

SIMATIC Manager/HW 
Config 

SM3b Refresh the diagnostics screens, for example, after you changed the hardware 
configuration: 
• Execute the "Create diagnostics screens" function. 

SIMATIC Manager  

   
SM4 Compile the diagnostics screens and block and then transfer these to the AS and to 

the "OS" of the Maintenance Station: 
• "Compile and download objects" dialog box for all components. The use 

of this function depends on the plant status.  
• or compile and download individual components in step SM 4a+4b. 

SIMATIC Manager 

SM4a Transfer the diagnostics blocks to the AS using the "Compile and download objects" 
function:  
• Execute this function for all AS after you initially created the diagnostics 

screens. 
•  Execute this function for each AS if configuration data were changed. 

SIMATIC Manager 
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Step Configuration step  Application implemented
SM4b To execute for the compilation and transfer of diagnostics screens for the 

Maintenance Station "OS":  
• "Compile OS" function. 
If Maintenance Station diagnostics are not performed on the S7 Engineering Station: 
• "Download to PLC" function.  

SIMATIC Manager 

SM5 Compile and download additional WinCC stations which access a modified AS. SIMATIC Manager 
SM6 If the Maintenance Station "OS" operated as multiuser system is capable of 

accessing different WinCC servers:  
• Compile and download all WinCC servers which are accessed by the 

Maintenance Station "OS". 

SIMATIC Manager 

   
W2 Basic settings in the WinCC Project:  

• Check the settings of computer and project properties. 
WinCC Explorer 

W3 User administration within the WinCC project:  
• Check the users and access rights.  
When you create a new Maintenance Station:  
• Create the users and assign access rights.  

WinCC Explorer / 
WinCC User Admin 

W4 To integrate the Maintenance Station into an existing WinCC project: 
• Configure the links to the diagnostics screens in the process screens. 
• Configure the links to process screens in the diagnostics screens.  

WinCC Explorer / 
Graphics Designer  

W5  When creating a new maintenance Station in a client-server architecture:  
• Add the Maintenance Station Clients to the computer catalog in the 

WinCC project of the server.  
• Configure the client properties such as the start screen or key locks 

within the project. 
• Configure package management at the server, for example, automatic 

import.  
• Create the server packages and export these to all WinCC servers to 

which the Maintenance Station Client is allowed access.  
• Configure the package import function at the Maintenance Station Client. 

WinCC Explorer 

   
BS Optional if the "Loop-in-HW-Config" function is used for diagnostics:  

• If the S7 ES does not handle Maintenance Station diagnostics, copy the 
S7 project to the PC which runs diagnostics and the "Loop-in-HW-
Config" function.  

Operating system / 
Windows 
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5.2 Steps to take when changing the configuration 

Overview of the steps to take for changing the system configuration:  
The following configuration steps are to be observed in particular in case of changes: 
● Configuration changes 
● Upgrading the Maintenance Station to a new version  

 
Step Configuration step  Application implemented
H1a Editing existing component data in HW Config.  HW Config 
H1b When migrating S7 projects that were created before STEP 7 V5.4 SP3:  

• For the individual export function, one asset ID for all configured 
components must be manually created on a one-off basis, using the 
"Allocate asset ID..." function.  

HW Config 

H2a Inserting new SIMATIC components in HW Config. HW Config 
H2b Integrating SIMATIC drives and non-SIMATIC components as standard slaves. HW Config 
H2c Integrating other components and interfaces of logical devices using an Asset 

Proxy. 
SIMATIC Manager/HW 
Config 

H3 If the PC of the Maintenance Station to implement was not yet registered in the 
S7 project, or if a new PC is implemented, for example as Maintenance Station 
Server:  
• Creation of a PC station for the Maintenance Station PC in the 

S7 project.  
• Execution of "Compile OS" for each new Maintenance Station "OS" 

created. 

SIMATIC Manager/HW 
Config 

H4 Optional when using SNMP OPC Server:  
• Integration of OPC Server of the Maintenance Station in the project in 

SIMATIC Manager. 
• Assignment of all SNMP components for diagnostics functions based on 

SNMP to OPC Server. 

SIMATIC Manager/HW 
Config 

   
W1a At upgrading of the Maintenance Station execution of the OS Project Editor:  

Requirements: The Maintenance Station "OS" was compiled at least once using the 
"Compile OS" function. This function is executed in step "H3" when integrating a 
new PC.  
• Start of the "OS Project Editor" in the WinCC project of the Maintenance 

Station. 
• Start of the "OS Project Editor" in the WinCC projects of all the WinCC 

servers in the S7 project that make tags and messages available for 
diagnostics by means of packages.  

WinCC / OS Project 
Editor 

SM3a Deletion of CPU data from diagnostics data: 
• Change of the AS / CPU assignment in the "Create diagnostics screens" 

dialog box. 

SIMATIC Manager/HW 
Config 
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Step Configuration step  Application implemented
SM3b Updating diagnostic screens.  

• Execute the "Create Diagnostics Screens" function. 
Updating is required after changes have been made in the hardware configuration in 
HW Config: 
• DP interrupt mode of DP slaves changed from "DPV0" to "DPV1" and 

vice versa. 
• Modification of addresses, device names, diagnostics addresses, 

comments 
No updating is required when the channel diagnostics function is switched on or off, 
or when the module specifications - such as the comment, higher-level designation, 
or location designation - are changed.  

SIMATIC Manager  

SM4 Compile the diagnostics screens and blocks, and then transfer these to the AS and 
to the Maintenance Station "OS": 
- "Compile and download objects" dialog box for all components. The use of this 
function depends on the plant status.  
- or compiling and downloading individual components in step SM 4a+4b. 

SIMATIC Manager 

SM4a Transfer the diagnostics blocks to the AS by executing "Compile and download 
objects":  
- Execution of the "Compile and download objects" function for each AS with 
changed configuration. 

SIMATIC Manager 

SM4b Functions to execute for the compilation and transfer of diagnostics screens for the 
Maintenance Station "OS":  
• "Compile OS". 
• If you do not run Maintenance Station diagnostics on the S7 Engineering 

Station:  
"Download to PLC" function. 

SIMATIC Manager 

SM5 Compile and download additional WinCC stations which access a modified AS. SIMATIC Manager 
SM6 If the Maintenance Station "OS" operated as multiuser system is capable of 

accessing different WinCC servers:  
• Compile and download all WinCC servers which are accessed by the 

Maintenance Station "OS". 

SIMATIC Manager 

   
W2 Basic settings in the WinCC Project:  

• Check the settings of computer and project properties. 
WinCC Explorer 

W3 User administration in the WinCC project: 
• Check of the user configuration and of user rights. 

WinCC Explorer / 
WinCC User Admin 

   
BS0 Optional if the "Loop-in-HW-Config" function is used for diagnostics:  

• If the S7 ES does not handle Maintenance Station diagnostics, copy the 
S7 project to the PC which runs diagnostics and the "Loop-in-HW-
Config" function.  

Operating system / 
Windows 
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5.3 Providing the component data for diagnostics 

5.3.1 Overview of the supply of component data for diagnostics 

Overview  
Components supported for diagnostics: 
● The properties of SIMATIC components are determined by the hardware configuration 

data of the S7 project. The module catalog of the S7 project provides most of the 
SIMATIC component data in five regional languages. These data are automatically 
included when you insert a component into the plant configuration. Additional data are 
defined during configuration. 

● Siemens drives and non-SIMATIC components can be integrated in the diagnostics 
system as so-called standard slaves, for example DP slaves. The component properties 
of standard slaves are defined by a GSD file.  
– Device data are integrated by importing the corresponding GSD file. The GSD file 

must be available in the regional languages required. 
– PROFINET components can also be integrated using a GSD file. The GSD file may be 

multilingual to support different languages. 
● An Asset Proxy is used to integrate the interfaces of logical devices or components which 

do not represent standard slaves. The user configures the component data, the interface 
for the diagnostics status, including the diagnostics messages, at the asset proxy. 
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5.3.2 Editing the component data of SIMATIC products 

Introduction 
The component data are output to the Maintenance Station user interface. Any available 
online data are also output to this interface. The program visualizes the offline data if 
otherwise.  
The sources of these offline data are available for all SIMATIC components in the hardware 
configuration of the S7 project. This chapter shows how to edit these data.  
For additional information, please refer to "Source and visualization of component data 
(Page 90)".  

Procedure 
1. Select the component whose data you want to edit from the navigation window of 

SIMATIC Manager, for example, an AS. To change the data in the sublevel hierarchy of a 
component such as a DP slave, you also need to select the corresponding higher-level 
unit.  

2. Select "Open Object" from the shortcut menu. The "HW Config" editor opens the 
hardware configuration of this component. The view includes sublevel components such 
as DP slaves. 

3. Open the "Properties" dialog box by double-clicking the component required. 
4. Edit the required parameter, for example, the entry in the "name" input box of the 

"General" tab. This value is output in the "Device type" field of the "Ident" view in the 
diagnostics faceplate of the component. 

5. Close the properties dialog box by clicking "OK". 
6. Select "Station > Save and compile" in the "HW Config" editor.  

You can also use this command to undo compilation in order to edit further configuration 
data. 

7. Close the "HW Config" editor. 

Result 
The change of the diagnostics data of a SIMATIC component is completed.  

 

 Note 
In order to be able to visualize these data on the user interface of Maintenance Station, 
compile the changed hardware configuration data and and then download these to the 
corresponding component, for example, to an AS. Also update your existing diagnostics 
screens and download these to the Maintenance Station.  
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5.3.3 Creating a separate PC station for SIMATIC Maintenance in the S7 project 

Introduction 
You expand the plant configuration with a PC for Maintenance Station diagnostics by 
integrating this PC as "SIMATIC PC station" in the S7 project.  
This procedure applies to various scenarios: 
● You add a PC for diagnostics with a Maintenance Station Stand-alone. 
● You add one or several PCs as Maintenance Station Server / Client. 

Procedure 
1. Select the project folder from the navigation window in SIMATIC Manager. Select 

"Insert new object > SIMATIC PC Station" from the shortcut menu. A new "SIMATIC PC 
Station" object is inserted and remains selected in the navigation window. 

2. Select "Open Object" from the shortcut menu. The Editor "HW Config" opens the view of 
the new PC station as empty rack. 

3. Select "WinCC Application" from the "SIMATIC PC Station > HMI" module catalog if you 
are going to implement the PC as Maintenance Station Server or use it to visualize 
diagnostics data in a stand-alone configuration.  
When using the PC as Maintenance Station Client, select the "WinCC Application Client" 
entry from the module catalog.  
Drag-and-drop the selected module to a free slot of the rack. 

4. Insert a communication module either for PROFIBUS or for Industrial Ethernet or MPI, 
depending on the network used. Select a module from the module catalog. When using 
Industrial Ethernet, for example, select "SW V6.2 SP1…" from the "SIMATIC PC Station 
> CP-Industrial Ethernet > IE General" folder. Drag-and-drop the selected module to a 
free slot of the rack. The properties dialog box of the communication module opens 
automatically. 

5. Select one of the subnets shown and check all other settings on this dialog box. Close 
the properties dialog box by clicking "OK". 

6. To change the default name of the PC station, select the "PC" rack, and then select 
"Object properties" from the shortcut menu. The "Properties – SIMATIC PC station" dialog 
box opens. Rename the PC and check all other settings. Close the dialog box by clicking 
"OK". 

7. Select the "Station > Save and compile" command. Close the HW Config editor by 
selecting "Station > Close". 

8. Select to the "OS" symbol in the folder of the new PC station in the navigation window. 
Select "Object properties" from the shortcut menu. The "Properties - OS:" dialog box 
opens. Change to the "Target OS and standby OS" or to the "Target OS" when using 
Maintenance Station Client. Enter the path in the "Path to Target OS Computer" input 
box. You can also open a selection dialog by clicking the "..." button and select the target 
OS path. Close the dialog box by clicking "OK". 

9. The "OS" symbol remains selected in the navigation window.  
Select "Assign to OS Server" from the shortcut menu when the PC station is integrated as 
Maintenance Station Client and configured as "WinCC Application Client" in step 3. The 
"Assign OPC Server" dialog box opens. Select Maintenance Station Server as server. 
Click "OK" to confirm your entry. Close the dialog box by clicking "OK".  
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You have successfully completed the configuration of PC station as Maintenance Station 
Client. 

10. Select "Compile" from the shortcut menu when the PC station is integrated as 
Maintenance Station Server or Maintenance Station Stand-alone and if it was configured 
as "WinCC Application Client" in step 3. The "Compile OS" wizard is started. 

11. Assign the S7 programs as required in the wizard. Check all other settings and close the 
wizard by clicking "Compile". Close the dialog box by clicking "OK". 

Result 
You expanded the HW configuration of the S7 project with a PC for Maintenance Station 
diagnostics.  

 

 Note 
SIMATIC NET SNMP OPC Server is deployed as an optional feature for network component 
diagnostics using the Maintenance Station. When integrating a new PC to visualize the 
diagnostics data returned by SNMP-compatible network components or industrial PCs, you 
also need to integrate SNMP OPC Server on this new PC. For additional information, please 
refer to "Integrating SIMATIC NET SNMP OPC Server into the project (Page 71)".  
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5.3.4 Creating and managing diagnostics blocks using the "Report system errors (RSE)" 
function 

Introduction 
The integrated "Report system errors" function of STEP 7 can be used to manage 
diagnostics data returned by the plant components and to output these to the message and 
status displays of SIMATIC Maintenance Station.  

Creating and managing diagnostics blocks using the "Report system errors" function  
STEP 7 automatically generates the necessary diagnostics blocks and message texts 
required for diagnostics data management. The diagnostics blocks are generated 
automatically when you create and update diagnostics screens.  
Download these blocks to the AS, and transfer the message texts to all WinCC stations 
connected or to other HMI devices as well.  

Default diagnostics settings  
After installation of the maintenance software, the "Report system errors" function on the 
Maintenance Station is assigned diverse global settings. This saves you from having to 
configure the functions separately at each AS.  
You can disable these defaults at specific automation systems. Open the corresponding 
automation system in the "HW Config" editor. In the next step, configure the RSE function for 
this AS in the "Report system errors" dialog box. Example: definition of diagnostics blocks 
and call of the functions in organization blocks ("OBs").  
You can also reactivate the defaults. Select the project overview in the S7 project and open 
the "Generate diagnostics screen settings" dialog box using the shortcut menu. Click 
"RSE settings" to open the dialog box of the same name, and then set the "Apply RSE 
settings to all AS" option on the "Diagnostics support" tab.  
The up-to-date status of the AS diagnostics blocks is visualized in the status bar of the RSE 
settings dialog box. For additional information, please refer to "Verifying the update status of 
diagnostics screens and data (Page 127)".  

 

 Note 
The "Report system errors" always transfers messages in the context of the Maintenance 
Station with compulsory acknowledgment.  

 
For further information on the "Report system errors" function, refer to the "Configuring 
messages > Configuring the reporting of system errors" section in the SIMATIC STEP 7 
documentation. 
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5.3.5 Transferring diagnostics blocks to the automation systems 

Introduction 
The creation or update the diagnostics screens always includes the generation or the update 
and compilation of the diagnostics blocks. On completion of these operations, the blocks 
must be transferred to the corresponding automation systems.  
The transfer scope is determined by the object selected from the navigation window of 
SIMATIC Managers: 
● You can select compilation and download of one or several components by executing the 

"PLC > Compile and download objects…" command after having selected the project 
folder. 

● You can select the "Compile and download objects…" or "Download" functions if you 
selected a single AS. 

This download operation for a single AS is described in this chapter is recommended if the 
following conditions apply: 
● A download to all AS while the plant is in operation is ruled out for reasons of safety. 
● A download to all AS is ruled out for reasons of time shortage. 

Requirements 
The diagnostics screens were generated at least once or were updated in the course of 
configuration changes.  

Procedure 
1. Select the AS folder which contains the diagnostics blocks you changed from the 

navigation window in SIMATIC Manager. 
2. Select the "PLC > Download" command from the shortcut menu. 
3. The program outputs a message reporting the deletion of system files on the automation 

system. Once you have checked this message, you can cancel the procedure by clicking 
"Cancel". Click "Yes" or "No" to decide whether to start or cancel the operation and 
whether to overwrite the AS system files. 

4. The program outputs a selection dialog if the automation system contains several CPUs. 
Select the CPU required to start the download. 

5. The download progress is indicated on the screen. 
6. You can view and check the log file when the operation is completed. Finally, close the 

message window. 
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Result 
The diagnostics blocks were transferred to the AS.  

 

 Note 
Restart the CPU of the AS having received the diagnostics blocks order to initialize the RSE 
blocks.  
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5.4 Visualization of diagnostics data 

5.4.1 Introduction Visualization of diagnostics data 

Overview of the visualization of diagnostics data  
This section describes the visualization of diagnostics data of SIMATIC Maintenance Station.  
● Overview screens:  

The Maintenance Station overview screen and the overviews of the PC stations, network 
components and AS objects provide a quick overview of the diagnostics states.  

● Hierarchy of the diagnostics screens: 
The diagnostics screens are generated in the course of configuration and assigned a 
hierarchy level.  

● Representation of the diagnostics status in status word MaintenanceState "MST": 
This status word is used to manage the diagnostics and maintenance states of a 
component.  

● Visualization of components: 
The diagnostics status is visualized by HMI elements such as the faceplates, group 
displays, status bars of the individual component. 

● Creation and management of diagnostics screens:  
The user creates new diagnostics screens and assigns the corresponding hierarchy for 
the S7 project in the course of configuration or when changes of the plant structure 
require their update. 
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5.4.2 Source and visualization of component data 

Source and visualization of maintenance data  
The component data are output to the Maintenance Station user interface. The data are 
stored in various sources:  
● The sources of these data are available for all SIMATIC components in the hardware 

configuration of the S7 project. The module catalog of the "HW Config" editor returns 
most of the SIMATIC component data in five regional languages for integration in the 
configuration data. Additional data are defined during configuration.  

● The data of other components such as standard slaves an non-SIMATIC components are 
derived from a GSD file supplied by the manufacturer and cannot be edited. Components 
with properties defined by GSD file are considered standard slaves. 

● Online component data are received from the actual device and cannot be edited. Online 
data can be identified on the screen based on the indication of the time of their most 
recent update. 

● The data source depends on the type of any asset proxy used.  

Data in the "Ident" view of the diagnostics faceplate 

 
 

The "- - -" characters in a field indicate that the data cannot be read or that these are not 
defined. A blank field is output if no content is available.  
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Applicable to the "Source" column if not defined otherwise in the table field: Any online data 
returned by the device take priority in this field. The field outputs data from the S7 project of 
from a GSD file if online data are not available.  

 
Date  Notation in the 

faceplate 
Source Editable 

"TAG" field Name / designation a) S7 project 
b) at Switches the IP address  

No 

"Description" field  Description Online data / S7 project / GSD file No 
"Message" field Message Online data / S7 project / GSD file No 
"Device type" field Device type HW Config > Properties dialog box 

of the component > General tab > 
"Description" field  

Yes  

"Manufacturer" field Manufacturer Online data / S7 project / GSD file No  
"Order number" field Order number  Online data / GSD file /  

S7 project: HW Config > Properties 
dialog box of the component > 
General tab > "Order no." / 
Firmware field  

No  

"Serial number" field  Serial number Only online data from the device No 
"Installation date" field Installation date  HW Config > Properties dialog box 

of the component > Identification 
tab > "Installation data" field  

Yes 

"HW version" field HW version  Online data / S7 project / GSD file No 
"SW version" field Software version / 

Firmware version  
Online data / GSD file /  
S7 project: HW Config > Properties 
dialog box of the component > 
General tab > "Order no." / 
Firmware field 

No 

"Comment" field 
Note: 
The "Comment" field text 
is also output to the title 
bar of the faceplate.  

Comment HW Config > Properties dialog box 
of the component > General tab > 
"Comment" field 

Yes 
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Component data of asset proxies in diagnostics screens  
Visualization of the asset proxy component data on the diagnostics screen depends on the 
proxy type. The diagram below shows an example of the output of an asset proxy of the 
"Extended" type to the diagnostics screen.  

 
The table shows the component data archive.  

 
Date  Source Editable 
Name on the icon of an asset 
proxy of the "Standard" type 

SIMATIC Manager > Properties dialog box of the data 
block > "General - part 1" tab > "Symbolic name" field  

Yes 

Name on the icon of an asset 
proxy of the "Extended" type 

HW Config > Properties dialog box of the component 
> "General" tab > "Description" field  

Yes 
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5.4.3 Hierarchy of the diagnostics screens 

5.4.3.1 Introduction: Hierarchy of the diagnostics screens 

Hierarchy of the diagnostics screens  
All maintenance and service data of components registered in the S7 project are visualized 
on the overview and diagnostics screens of the Maintenance Station.  
These overview and diagnostics screens are generated automatically for the Maintenance 
Station and assigned to a hierarchy according to the structure of the S7 project and of the 
hardware configuration. If no sublevel components such as DP slaves of an AS are 
registered in the project, the program does not generate a hierarchy with sublevel 
diagnostics screens for this AS.  

 
Level 1  
(root level) 

Overview screen of the Maintenance Station 

Level 2 Overview  
PC stations 

Overview of network 
components 

Overview of AS objects 

Level 3  -   -  AS (stand-alone) 
Level 4  -   -  Central racks and 

expansions 
DP slaves 

Level (n)  -   -   • ET200M 
• ET200S /iS 
• additional DP 

slaves 
• PROFINET IO 

The most complex hierarchy which contains the most levels is derived from the plant 
structure in the area of AS objects.  
The hierarchy created for the areas of PC stations and network components extends only to 
the overviews at level 2.  
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5.4.3.2 Overview screen of the maintenance station 

Overview screen of the Maintenance Station 
The overview screen of the maintenance station represent the root screen of the diagnostics 
screens hierarchy. The screen is output when you select the "Diagnostics" system area from 
the overview area of the user interface.  
All other diagnostics screens are allocated to the nested hierarchy of the overview screen. 
Picture Tree Navigator illustrates the hierarchic structure of the diagnostics screens and 
facilitates navigation in the hierarchy. 
The following plant areas are visualized on a colored background in the overview screen. 
1. The "PC stations" area in "light-yellow" color. 
2. The "Network components" area in "light-green" color. 
3. The "AS objects" area in "light-blue" color. 
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Each area comprises a corresponding group status display "MaintenanceGroupDisplay". 
The MaintenanceGroupDisplay returns different symbols which indicate the status of 
components of the sublevel hierarchy.  

In the screen shown above, these are  and . You can navigate to a nested 
diagnostics screen using the MaintenanceGroupDisplay.  
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5.4.3.3 The PC Stations, network components and AS objects overviews 

The PC Stations, network components and AS objects overviews 
The overviews form the next level below the Maintenance Station overview screen within the 
hierarchy of diagnostics screens.  
● Overview PC stations 
● Overview of network components 
● Overview of AS objects 
The overviews return the status of all components within their group and sublevel hierarchy 
and provide a quick overview and directed access to areas and components which require 
precise diagnostics.  

 
 

The three overviews are generated in the S7 project based on component configuration 
data. 
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Viewing the overviews  
The user has several options of calling an overview.  
● By navigation using the Picture Tree Navigator 
● By navigation using the icons of the toolbar sets. 
● An overview is also output to the screen if several messages are active in different 

diagnostics screens of the sublevel hierarchy. The overview accumulates all messages 
and represents the next higher level.  
In this case, a jump to the sublevel overview is initiated by, for example, the group display 
in the overview area or the MaintenanceGroupDisplay status display in the overview 
screen. 

Navigating to sublevel diagnostics screens and to further views  
The overview outputs a symbol with status display for each component and sublevel 
hierarchy of an area. These status displays can be used to navigate to sublevel diagnostics 
screens or to call functions.  
An AS is represented in the "AS objects overview", for example, by the symbol shown below.  

 
● A status display for the actual component is returned by the MaintenanceStateDisplay 

"MSD", which shows the status on the screen. 

. This status display can be used to open the diagnostics faceplate of the 
component. 

● The status display MaintenanceGroupDisplay "MGD", shown with the status on the 
screen, allows a jump to corresponding component or sublevel hierarchy. 

 

  Note 
The hierarchy created for the areas of PC stations and network components extends only 
to the overviews at level 2. Navigation on sublevels is usually only supported in the area 
of AS objects and depends on the plant configuration.  

Abbreviation: MSD 
MSD = MaintenanceStateDisplay. Status bar for the output of the maintenance status of the 
stand-alone component. 

Abbreviation: MGD 
MGD = MaintenanceGroupDisplay. Status display for the output of the maintenance status of 
sublevel components.  
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5.4.3.4 Level of unit components and their sublevel hierarchy 

Introduction 
The diagnostics screens and the sublevel hierarchy of unit components are assigned to the 
next level below the overview screen and the AS objects, network components and 
PC stations overviews.  

 

 Note 
The most complex hierarchy which contains the most levels is derived from the plant 
structure in the area of AS objects.  
The hierarchy created for the areas of PC stations and network components extends only to 
the overviews at level 2.  
A description of the hierarchy is only possible for this reason in the area of AS objects.  
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Visualization of unit components and sublevel components 
The diagnostics screen of a stand-alone AS visualizes the various components by means of 
symbols. 
● The CPU of the AS in the central rack. 
● Existing expansion racks 
● Sublevel components such as PROFIBUS DP systems and their connected slaves.  
The diagram below shows an example of the diagnostics screen of a stand-alone AS.  

 
Components shown on this screen: 
1. An AS 400 with corresponding universal rack "UR1 1" 
2. An "ER1-417-4 1" expansion rack 
3. Two sublevel PROFIBUS DP systems "DP master system x". 
The corresponding status displays are integrated in the symbolic view of components.  
● The status of an actual component is returned in the MaintenanceStateDisplay "MSD". 

The CPU view in this screen outputs the CPU status  = "maintenance request".  

The expansion rack has the status  = "Good". 
This status display can be used to open the diagnostics faceplate of the component. 
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● The "EventState" status display is attached to the bottom right of the 
MaintenanceStateDisplay. This function only returns the status of diagnostics messages 
of the actual component. The small red square indicates an active CPU message. There 
are no active messages for the other component. 

● For all components, the MaintenanceGroupDisplay "MGD" returns the status 

 = "Good".  
The MaintenanceGroupDisplay can be used to jump to the diagnostics screen of the 
corresponding component or sublevel hierarchy. This screen shows an example of slaves 
connected to the PROFIBUS DP subsystems. 

Term: Event State 
Status display for diagnostics messages of the component.  



 Configuration for SIMATIC Maintenance Station 
 5.4 Visualization of diagnostics data 

SIMATIC Maintenance Station 2007 
Operating Manual, 04/2008, A5E00901992-03 101 

5.4.4 Representation of the diagnostics status in MaintenanceState "MST" 

5.4.4.1 Introduction 

Overview 
The diagnostics status of a component is saved to a variable "MS" of the type "DWORD" and 
managed on the SIMATIC Maintenance Station. The Maintenance Station Server updates 
this variable.  
● The status is visualized on different displays. 

– The MaintenanceGroupDisplay "MGD" (for example, ) outputs the status to 
higher-level diagnostics screens. 

– The MaintenanceStateDisplay "MSD" (for example, ) outputs the status to the 
diagnostics screens and faceplates. 

● The status of component maintenance request is also managed in the variable. 
The MaintenanceStateDisplay "MSD" and symbols in the diagnostics faceplate visualize 

maintenance requests, for example,  and the maintenance status, for example, 
. 

● The status bits are used to indicate the master ID in the diagnostics faceplate for 
redundant components. 

The main elements of this variable are component status bytes 1 and 2, the "OS operation" 
bits, various status bits and the reserved bits.  
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5.4.4.2 Syntax of the diagnostics status word MaintenanceState "MST" 

Syntax of the diagnostics status word MaintenanceState "MST" 
The diagnostics status word is a "DWORD" variable with a main elements structure outlined 
below.  
● Component status byte 1  

The component diagnostics status is managed in component status byte 1, bits 0 to 7. 
Bits 0 to 3 are relevant in the dword. Bits 4 to 7 are reserved. 

● Component status byte 2  
The diagnostics status of the redundant component is managed in component status 
byte 2, bits 8 to 15. Bits 8 to 11 are relevant in the dword. Bits 12 to 15 are reserved. 

● "OS operation" bits  
Bits 24 to 27 represent the "OS operation" status for managing maintenance measures 
and the activity status. 

● Status bits  
The status bits 16 to 18, 22 and 23 return different states such as the existence of a 
redundant component, or the master identifier for redundancy.  

● Reserved bits 

Status word structure 

 
 

For additional information on possible states, as well as on the display of icons in the 
diagnostic screens, please refer to the section titled "Set of symbols for the visualization of 
the MaintenanceState "MST" (Page 103)".  
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5.4.4.3 Set of symbols for the visualization of the MaintenanceState "MST" 

Symbol set of the diagnostics status word MaintenanceState "MST" 
The diagnostics status word MaintenanceState "MST" is used to manage the component 
status.  
Elements of the status word. 

 
 

● Component status bytes 1 and 2 
● "OS operation" bits 24 to 27 
● Status bits 16 to 18, 22 and 23 
● Reserved bits 19 to 21 and 28 to 31 
This section describes the possible states and their assignment to corresponding symbols.  

Component status bytes 1 and 2 
The table below shows the image of the component status in MaintenanceStateDisplay 
"MSD". The "Symbol in MGD" column returns the corresponding image in the 
MaintenanceGroupDisplay "MGD" which maps the status to higher levels of the diagnostics 
screens.  
The states of redundant components are summarized in a group. The diagnostics faceplate 
of the component returns the status of each redundant component. For further information, 
refer to the section "Working with SIMATIC Maintenance Station > Diagnostics status of 
redundant components". 
Remarks: 
● Component status byte 2 identifies a redundant component 
● Bits 0 to 3 and 8 to 11 are relevant in the component status byte Bits 4 to 7 and 12 to 15 

are reserved 
● The status "x" is irrelevant 
● Lowest priority is "xxxx0000", highest priority is "xxxx1000". Exception: priority "2" of 

"Configuration changed" which lies between "OK" and "Device disabled". 
● "Unknown / higher-priority error" means that actual valid status information is not 

available, for example, due to a communication error at a higher level. 
 

Status  
Bits "7 to 0" 
or "15 to 8" 

Meaning Symbol in 
"MSD" 

Priority Symbol in 
"MGD" 

xxxx0000 Good 

 
1 
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Status  
Bits "7 to 0" 
or "15 to 8" 

Meaning Symbol in 
"MSD" 

Priority Symbol in 
"MGD" 

xxxx0001 Device disabled 

 
3 

 

xxxx0010 Shut down 

 

4 
 

xxxx0011 At least one process value is simulated. 

 

5 
 

xxxx0100 Local operation 

 

6 
 

xxxx0101 Maintenance required 

 

7 
 

xxxx0110 Maintenance demanded 

 

8 
 

xxxx0111 Maintenance alarm 

 

9 
 

xxxx1000 Unknown / higher-priority error  

 

10 
 

xxxx1001 Configuration changed 

 

2 
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The "OS operation" bits 
Bits 24 to 27 represent the "OS operation" status for managing maintenance measures and 
the activity status.  
The status of bits is visualized by the MaintenanceStateDisplay "MSD" and by the symbols in 
the diagnostics faceplates.  

 
Status 
Bits  
"27…24" 

Meaning Working on the OS Activity status 

0000 Done -  
0001 Maintenance measure requested for 

"Maintenance required"  
  

0010 Maintenance measure requested for 
"Maintenance demanded"  

  

0011 Maintenance measure requested for 
"Maintenance alarm"  

  

x100 Not allowed    
0101 Maintenance measure requested for 

"Maintenance required" in progress 
  

0110 Maintenance measure requested for 
"Maintenance demanded" in progress 

  

0111 Maintenance measure requested for 
"Maintenance alarm" in progress 

  

1000 Canceled   
1001 
1010 
1011 
1100 
1101 
1110 
1111 

Not allowed   
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Status bits 16 to 18, 22 and 23  
These bits are used for management and are not assigned to any symbols.  
Bits 16 = "R" and 17 = "M" are used to indicate the master ID in the diagnostics faceplate for 
redundant components.  

 
Bit Characters Meaning / function 
16 R Redundant component 

0 = none  
1= exists 

17 M Masters 
R = 1 and M = 0 = component 1 is master, and component 2 is "Stand-by" or 
"Fault"  
R = 1 and M = 1 = component 2 is master, and component 1 is "Stand-by" or 
"Fault"  

18 O Overwritten 
1 = component status overwritten  

22 S Status change  
1 = status was changed again  

23 U Cyclic update 
1 = the component is updated cyclically 

The reserved bits 19 to 21 and 28 to 31 
These bits have an internal function with read only attribute.  
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5.4.5 Components for the visualization of diagnostics data 

5.4.5.1 Symbols in the block symbols file 

Overview 
The section below shows which diagnostics-compatible components of the S7 project are 
visualized in the diagnostics screens: 
● PC stations such as industrial PCs 
● Automation systems such as an AS300 
● I/O modules 
● Network, Fast Ethernet OSM and ESM, Ethernet OLM and ELM 
● PROFIBUS components such as modular and compact field devices 
● PROFINET components 
● Asset proxies 
● Redundancy components 
These components are visualized on the process and diagnostics screens by different block 
symbols. These symbols are stored in the "@@MaintenanceTypicals.pdl" file. This file name 
may not be changed.  
Symbol changes are saved to a separate file named "@MaintenanceTypicalsXXX.pdl". The 
"XXX" string represent a placeholder: In the course of the creation or update of diagnostics 
screens in the S7 project, the program always starts searching for symbols in the most 
recently modified file and continues the search in ascending alphabetical order. 
"@@MaintenanceTypicals.pdl" is the last file scanned within this search for symbols.  
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The file is available in the "<installation drive> \ Programs \ SIEMENS \ WINCC \ options \ 
pdl \ faceplatedesigner_v6" folder. When you create an S7 project or open a session in the 
OS project editor, the file is copied from the installation folder to the project folder at 
"<project directory> \ wincproj \ <os-name> \ GraCS".  
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5.4.5.2 The MaintenanceStateDisplay "MSD" status display 

Overview 
The MaintenanceStateDisplay "MSD" status display is used to visualize the component 
status on the diagnostics screens of the Maintenance Station. Instead of returning the status 
of a sublevel hierarchy, the MSD only returns the status of its own component.  
This status display can be used to open the diagnostics faceplate of the component for 
detailed diagnostics.  
The MaintenanceState "MST" component status is saved to the component tag "MS" for 
management.  

Symbolism 
The program outputs different symbols based on the component status in MaintenanceState 
"MST". Examples: 

 
An AS is represented in the "AS objects overview", for example, by the symbol shown below.  

 

The MaintenanceStateDisplay returns the AS status in this example using the symbol  
= "Maintenance alarm". 
For further information on possible states and symbols used, refer to the chapter 
"Representation of the diagnostics state in MaintenanceState "MST" > Structure of the 
diagnostics status word MaintenanceState "MST"".  
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5.4.5.3 The "EventState" status display 

Overview 
Instead of returning the status of a sublevel hierarchy, the "EventState" status display returns 
the status of its own component.  
The status display of a component symbol is attached to the bottom right of the 
MaintenanceStateDisplay "MSD".  
The diagram below shows an example of a PROFIBUS DP subnet on the AS diagnostics 
screen.  

 
● The "EventState" status display for this component appears as a small red square at the 

bottom right of the MaintenanceStateDisplay. 

 
EventState returns the following status:  
A diagnostics message was received or cleared and is not yet acknowledged. The 
message may be already cleared. Messages continue flashing until these are 
acknowledged. If the message persists after acknowledgment, the flashing symbol 
changes to non-flashing state. The symbol disappears when the message is cleared. 

● The MaintenanceStateDisplay on the screen returns the  = "OK" status. 

Symbolism 
 

Symbol Meaning 

 
Maintenance alarm  

 
Maintenance demanded 

 
Maintenance required 

 
Good 

 
Not applicable 
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5.4.5.4 The MaintenanceGroupDisplay "MGD" status display 

Overview  
The MaintenanceGroupDisplay "MGD" returns the actual status of the component in a 
sublevel hierarchy on the overview and diagnostics screens.  
The MaintenanceGroupDisplay "MGD" shows different status symbols, depending on the 
component status in the sublevel hierarchy.  
The status display can be used to open the diagnostics screen which contains the sublevel 
components for detailed diagnostics. An active diagnostics message in the sublevel 
hierarchy is shown on the corresponding diagnostics screen. If no active messages are 
found, the program opens the diagnostics screen of the next lower level of the hierarchy. 
An AS is represented in the "AS objects overview", for example, by the symbol shown below.  

 

The MaintenanceGroupDisplay returns the  = "Maintenance alarm" on the screen.  

Symbolism 
The symbolism of the MaintenanceGroupDisplay differs in terms of visualization on the 
diagnostics screen and in the component faceplate.  

 
Symbol in the 
diagnostics screens 

Symbol in the 
faceplate 

Meaning 

  
Maintenance alarm  

  
Maintenance demanded 

  
Maintenance required 

  
Good 

For additional information on possible states and icons, please refer to the section titled 
"Representation of the diagnostics status in MaintenanceState "MST" > Structure of the 
diagnostics status word MaintenanceState "MST"".  
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5.4.5.5 Diagnostics faceplates 

Overview 
A diagnostics faceplate returns various information concerning the diagnostics-compatible 
component.  
● Status displays and control elements  

These reside permanently on the upper area of the faceplate. 
● Views of a diagnostics faceplate  

Users can select a faceplate view which contains the required information. 
The views return different types of information. 
– Configuration and component data 
– Diagnostics messages of the component 
– Maintenance status management 

The diagnostics faceplate of a component is opened using the component symbol in the 
MaintenanceStateDisplay.  
The diagram below shows an AS symbol on a diagnostics screen.  

 
Open the corresponding diagnostics faceplate by clicking the "MaintenanceStateDisplay" 

(e.g. ).  
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Views of a diagnostics faceplate 
In addition to the status view, the faceplate provides various views for the output of 
component-specific information. There are three default views:  
● Identification 

 
 

In the "Ident" view all the available information and the maintenance status are displayed 
for the component. The visualized data represent either offline HW configuration data or, 
if available, the online component data plus the date of the most recent update. The view 
also visualizes the status of redundant components and the corresponding master ID. 
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● Messages: 

 
 

In the "Messages" view messages for diagnostics, operator actions and maintenance 
requests are output. The messages can be acknowledged and managed in this view. 

● Maintenance 

 
 

The "Maintenance" view allows the user to react to maintenance requests for the 
respective component and to initiate and manage the corresponding maintenance task. 
The maintenance task requested is shown on the MaintenanceStateDisplay of the 
component in the diagnostics screens. The status displays of the faceplate return the 
progress of maintenance requested. 
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Status displays and control elements of the faceplate 
The top edge of the faceplate contains several control elements and displays showing the 
status of the components and of maintenance in progress. The control elements are shown 
on the screen independent of the view selected.  

 
 
 
① 

 

Status display for the stand-alone component. The display outputs the status of each 
redundant component separately.  
As a result of a maintenance request, this display outputs the message, for example, 
"Maintenance alarm" instead of the status returned in the overall status display in "④".  
Status visualized: "Maintenance alarm"  

② 
 

Status display for diagnostics messages.  
Status visualized: Active diagnostics message of the component. 

③ 
 

Button: 
Fixes the faceplate to the foreground, regardless of any change of screens in the 
background. 

④ 

 

Status display for the stand-alone component. This display returns the overall status of 
redundant components.  
As a result of a maintenance request this display no longer returns the same status as 
display "①".  
Status visualized: Maintenance requested for "Maintenance alarm".  

⑤ 
 

Display of the status of maintenance requests. This status display is hidden if no 
maintenance requests are active.  
Status visualized:  
Maintenance requested but not yet started.  

⑥ 
 

Button: 
Acknowledges the messages relating to this component. The "Messages" view does not 
have to contain the faceplate.  
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⑦ 
 

Button: 
Starts the online view of the hardware configuration "HW Config". This button is only shown 
if this faceplate component represents an element of the hardware project, for example, an 
AS.  

⑧ 
 

Selection box: 
Selects the current view of the faceplate.  

The views of the diagnostics faceplate contain additional control elements and status 
displays. For detailed information, refer to the chapter "Working with SIMATIC Maintenance 
Station".  
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5.4.5.6 Group displays for diagnostics 

Overview 
The group displays are output to the overview and diagnostics screens in the so-called 
overview area and are also shown in Picture Tree Navigator.  
The group displays show a summary of the states of all components in the nested 
hierarchies.  
When an active diagnostics message is indicated on the message bar of the overview area, 
you can jump to the diagnostics screen which contains the corresponding component by 
clicking the group display button. The program opens the diagnostics screen of the next 
higher hierarchy level if several messages are active.  

Symbolism 
The scope of the group display depends on the Maintenance Station configuration.  
The group display returns more complex status displays if you also integrated process 
screens of a WinCC project on the Maintenance Station. Status which may be displayed in 
this case:  

 
The middle one of five buttons is relevant to Maintenance Station diagnostics. This button is 
used to visualize diagnostics data on a Maintenance Station which does not feature any 
integrated process screens of a processing plant. Status which may be returned by a group 
display:  

 
Meaning of the symbols:  

 
Priority Description Symbol Color Acknowledgment 
1 Maintenance alarm  S Yellow on black Flashing = active,  

Permanent = 
acknowledged 

2 Maintenance required F Yellow on black Flashing = active,  
Permanent = 
acknowledged 

3 Maintenance demanded M or MR  Yellow on black Flashing = active,  
Permanent = 
acknowledged 

4 Good   -  Gray  -  
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5.4.6 Creating and managing diagnostics screens 

5.4.6.1 Introduction: Creating and managing diagnostics screens 

Overview of the creation and management diagnostics screens 
The diagnostics screens and maintenance station functionality require specific default 
settings to be made, in particular in the course of initial creation.  
The diagnostics screens and their hierarchy are generated in the course of project 
engineering.  
All screens and data required are generated when you create a new maintenance station. 
You can update the diagnostics screens after having changed the plant structure. In order to 
avoid any time-consuming generation of data, you can start by checking the update status of 
the diagnostics screens. Run the update only if necessary.  
You can remove specific plant areas or automation systems from the diagnostics system. 
This would include their removal from the configured screens and from configuration data.  
On completion of their creation or update, transfer the diagnostics screens and their 
hierarchy to the maintenance station and download the diagnostics blocks to the automation 
systems.  

5.4.6.2 Starting WinCC OS project editor 

Introduction 
You need to run an initial session of WinCC OS project editor in order to configure 
Maintenance Station diagnostics within the WinCC project. You define specific diagnostics 
settings on the PC in the course of this session.  
The editor session is required for the WinCC projects shown below.  
● For the Maintenance Station "OS", independent of "combined" or "stand-alone" mode of 

operation. 
● For each WinCC server which provides packages containing the diagnostics variables 

and messages. 
 

NOTICE  
 

Check the settings on the "Basic data" tab when using "WinCC OS Project Editor" in 
current WinCC projects to change basic screens, local actions of the computer and 
faceplates.  
 
If you do not check the settings on this "Basic data" tab the program restores the default 
and overwrites changes made to these objects. 
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Requirements 
● Message classes 4, 5, 6 and 10 required for diagnostics messages of the Maintenance 

Station are generated in the "WinCC OS Project Editor" session. The messages classes 
may not be in use by a user-specific application in an existing WinCC project for this 
reason. Such a scenario could in particular develop if "WinCC OS Project Editor" was 
never started in this WinCC project. If these classes are already being used you need to 
assign other, free message classes to the user-specific application before you run 
"WinCC OS Project Editor". 

● The Maintenance Station "OS" was compiled at least once using the "Compile OS" 
function. Execute the function in step "H3" as described in "Overview of Maintenance 
Station engineering" to implement a new PC. 

Procedure 
1. Open the current WinCC project in SIMATIC Manager. In the navigation window of 

SIMATIC Manager, select the PC station of the Maintenance Station, and then select the 
corresponding "OS" symbol. Select "Open Object" from the shortcut menu. The WinCC 
project opens. 

2. Start the OS project editor by double-clicking the corresponding symbol on the navigation 
window of WinCC Explorers. 

3. Change to the "General" tab. Activate the "Complete configuration (loss of support for 
online DeltaLoading)" check box on the "Activities when processed by project editor" 
area. 

4. Change to the "Message configuration" tab. Click "…" on the "Message classes/types" 
area to open a selection dialog box. Select the file "MessageMaintenanceStation.cfg" 
from "WinCC > Options > SSM" in the WinCC installation folder. Close the dialog box by 
clicking "Open". This configuration file only uses the message classes 4, 5, 6 and 10 as 
required for diagnostics. 

5. Change to the "Layout" tab. Check the settings of the "Available layouts" window and of 
the "Monitor configuration" area. Select the settings as required. 

6. Check the settings on the "Basic data" tab. This tab shows all changes made to objects of 
the basic screens, actions and faceplates within the WinCC project. To accept these 
changes, deactivate the check box at the corresponding object.  
Note the information in the preface! 

7. Check the settings of the other tabs and edit these as required. 
8. Click "OK" to run the configuration process. 
9. Close the WinCC project by selecting "File > Close". 

Result 
"WinCC OS Project Editor" has configured various diagnostics settings in the WinCC project.  

 

NOTICE  
On completion of the "WinCC OS Project Editor" session, check the start screen 
configuration for your current WinCC projects in the "Computer properties" dialog box. The 
OS Project Editor sets the Maintenance Station user interface as start screen.  
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5.4.6.3 Defaults for the creation of diagnostics screens 

Defaults for the creation of diagnostics data and screens  
The creation of diagnostics screens and Maintenance Station functionality is based on 
various settings. These settings are defined in the "Settings for Generating Diagnostics 
Screens" and "Report system errors" dialog boxes.  
The dialog box can be opened as shown below. Select the overall project from the 
navigation window.  
● By selecting "Options > Diagnostics screens > Settings…" in SIMATIC Manager. 
● By selecting "Diagnostics screens > Settings…" from the shortcut menu 

Defaults in the "Settings for Generating Diagnostics Screens" dialog box.  
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The dialog box contains the elements and setup options shown below.  
 

Element Meaning  
Check box  
"Derive diagnostics screens" 

Activates the generation of diagnostics screens and data. When 
the check box is deactivated, the program no longer generates 
any diagnostics screens and the entire Maintenance Station 
functionality is disabled.  

Check box  
"Diagnostics only for AS objects" 

Activates the generation of diagnostics screens only for AS 
objects. The program no longer generates diagnostics screens 
for PC stations and network components or the Maintenance 
Station overview screen.  

Input box  
"Name of the diagnostic area" 

Defines the name of the diagnostics area.  
This name is set on the area selection button in the overview 
area and in the messages of the "Area" message block.  

List  
"Please select the maintenance 
OS from the list"  

Select the PC station used as Maintenance Station. You can 
only select PC stations.  

Button  
"SFM Settings..."  

Opens the SFM Settings dialog box.  
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Default settings for the "Report system errors" function 
 

 Note 
The "SFM Settings…" dialog is not required when defaults are set for the creation / update of 
diagnostics screens. The system automatically includes certain defaults during initial 
generation of the data. You only configure the settings in this dialog box if you want to set 
other defaults.  

 
You open the "Configuration of Maintenance Station diagnostics ..." dialog box by clicking 
the "SFM Settings..." button in the "Settings for Generating Diagnostics Screens".  
The "Diagnostics support" tab of this dialog box is used to define additional settings for the 
Maintenance Station function.  

 

 Note 
This documentation does not cover any options of this dialog which are irrelevant to the 
Maintenance Station function. For further information on these options, refer to the 
SIMATIC STEP 7 documentation. 

 
 

 
Element Meaning 
"Apply SFM settings to all AS 
stations" check box  

Activates the SFM settings at all AS of this S7 project.  
The check box is set by default when you update or initially 
create diagnostics screens.  
The default setting no longer applies to all AS if this check box is 
deactivated.  
 
The program automatically deactivates the check box when you 
open the "HW Config" editor after having selected an AS for 
editing the settings. This action may involve the assignment of a 
different FB number.  
 
To reactivate this function open this dialog in the "Settings for 
Generating Diagnostic Screens" dialog box and then set the 
check box.  
 
This check box is not shown in the dialog box opened in the 
"HW Config" editor after you selected an AS.  
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5.4.6.4 Creating defaults for initial generation of the diagnostics screens 

Introduction 
Define or verify the settings outlined in the next section if you have not yet generated any 
diagnostics screens and data for the Maintenance Station.  

Requirements 
● The Maintenance Station "OS" was compiled at least once using the "Compile OS" 

function. 
● Run "WinCC OS Project Editor" in the WinCC project before you continue.  

Procedure 
1. Select the project folder in the navigation window of the SIMATIC Manager. Select 

"Diagnostics screens > Settings..." from the shortcut menu. The "Settings for Generating 
Diagnostic Screens" dialog box opens. 

 
2. Activate the "Derive diagnostic screens" check box. Activate the "Diagnostics only for AS 

objects" check box to run Maintenance Station diagnostics only for AS objects and their 
sublevel components. 

3. Define the name of the area selection button in the overview area in the "Name of the 
diagnostic area:" input box. The name is also entered as text in the "Area" message 
block. 
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4. Select the Maintenance Station PC from the "Please select the maintenance OS from the 
list" selection box. You can only select PC stations. 

5. You can ignore the "SFM Settings…" dialog when you set the defaults. The system 
automatically includes certain defaults during initial generation of the data. You only 
configure the settings in this dialog box if you want to set other defaults. 

6. Close the "Settings for Generating Diagnostic Screens" dialog box by clicking "OK". 

Result 
The defaults for initial generation of the diagnostics screens and data are set.  
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5.4.6.5 Creating new diagnostics screens 

Introduction 
Take the steps described in the next section if you have not yet generated any diagnostics 
screens and data for the Maintenance Station in the S7 project. The instructions apply to a 
Maintenance Station which is, for example, to be created on a new PC or integrated into an 
existing WinCC station.  

Requirements 
● The new Maintenance Station PC must be registered in the S7 project. 
● Run "WinCC OS Project Editor" in the WinCC project before you continue. On systems 

which contain several WinCC servers, you also need to run the "OS Project Editor" on 
each WinCC server that provides packages with diagnostics variables and messages. 

● You have set the defaults in the "Settings for Generating Diagnostics Screens" dialog 
box. 

● Install and configure SNMP OPC Server if you want to run diagnostics of SNMP 
components. The SNMP components must be assigned to the SNMP OPC Server.  
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Procedure 
1. Select the project folder in the navigation window of the SIMATIC Manager. 
2. Select "Diagnostics screens > Create diagnostics screens..." from the shortcut menu. The 

"Create Diagnostics Screens" dialog box opens. 

 
3. Select the automation systems for which you are going to generate diagnostics screens 

and blocks. 
4. Confirm the selection by clicking "OK. The program now starts generation and outputs a 

progress bar. 
5. Acknowledge the message informing you that generation has successfully completed. 

Result 
You have successfully created the new diagnostics screens and blocks. 

 

 Note 
Finally, compile the diagnostics screens and blocks and download these to the 
corresponding AS, or download the diagnostics screens to the Maintenance Station.  
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5.4.6.6 Verifying the update status of diagnostics screens and data 

Introduction 
The diagnostics screens and data may no longer be up-to-date when you generate the 
diagnostics screens and then modify configuration data. This is relevant in particular when 
you change the hardware configuration or edit the default settings, for example, in the 
"General" tab of the "Report system errors" dialog box. 
This section describes how to check the update status of the configuration of diagnostics 
screens and data.  

Requirements 
The diagnostics screens were generated at least once before.  

Procedure 
1. Select the AS whose update status you want to verify from the navigation window of 

SIMATIC Manager. Double-click the "Hardware" symbol on the right pane. The 
"HW Config" dialog box opens.  

2. Select the CPU of the AS from the list on the station window. 
3. Select "Options" > "Report system errors...". The "Report system errors" dialog box 

opens. 
4. Change to the "Diagnostics support" tab. 
5. Verify that the status bar of the dialog returns the message "Diagnostics blocks are 

updated". 
6. An update is not necessary if you see this text. Close "HW Config" by selecting "Station > 

Close". 
7. Update the diagnostics screens and data if this text is not output. Continue at the 

"Updating diagnostics screens" section. 

Result 
You verified the update status of the diagnostics screens and data.  
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5.4.6.7 Updating diagnostics screens 

Introduction 
The diagnostics screens must be updated after their initial creation if changes were made to 
the S7 project which have an impact on the diagnostics screens: for example, if new 
components were added.  
For further information on the verification of the update status, refer to the "Verifying the 
update status of diagnostics screens and data" section.  

Requirements 
The diagnostics screens were created previously.  

Procedure 
1. Select the project folder in the navigation window of the SIMATIC Manager. 
2. Select "Diagnostics screens > Create diagnostics screens..." from the shortcut menu. The 

"Create Diagnostics Screens" dialog box opens. 
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3. The list highlights the automation systems for which you generated diagnostics screens 
and data in the previous update session. Check the list and modify the settings if 
necessary. 

4. Confirm the selection by clicking "OK. The program now runs the update and outputs a 
progress bar. 

5. Acknowledge the message informing you that generation has successfully completed. 

Result 
You have successfully updated the diagnostics screens and blocks. 

 

 Note 
Finally, compile the diagnostics screens and blocks and download these to the 
corresponding AS, or download the diagnostics screens to the Maintenance Station.  
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5.4.6.8 Deleting CPU or AS data from diagnostics data 

Introduction 
You may need to delete one or more AS, along with their sublevel components, from 
diagnostics data once changes have been made to configuration data or the plant 
configuration. 

Procedure 
1. Select the project folder in the navigation window of the SIMATIC Manager. 
2. Select "Diagnostics screens > Create diagnostics screens..." from the shortcut menu. The 

"Create Diagnostics Screens" dialog box opens. 

 
3. The list highlights the CPUs of the automation systems for which you generated 

diagnostics screens and data in the previous update session. Deactivate the check box 
next to the CPU entry of the automation system you want to delete from diagnostics data. 
You can edit this setting for several CPUs. 

4. Click "Apply" to save the current setting. 
5. Click "Cancel" to close the dialog box and to discard the update of diagnostics screens 

and data for the time being. 
6. Verify and edit the list as required, and then click "OK" to immediately update the 

diagnostics screens and blocks. The program now runs the update and outputs a 
progress bar. Acknowledge the message informing you that generation has successfully 
completed. 
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Result 
The diagnostics data of one or several AS and of the sublevel components are deleted from 
diagnostics.  

 

 Note 
Finally, compile the updated diagnostics screens and blocks and download these to the 
corresponding AS, or download the diagnostics screens to the Maintenance Station.  
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5.4.6.9 Compiling diagnostics screens and downloading these to the maintenance station 

Introduction 
The diagnostics screens you generated or updated must be compiled and downloaded to the 
Maintenance Station.  
You can run the "Compile" and "Download" functions in a single operation using the 
"Compile and download OS" command. This section describes this procedure.  
You can also select the "OS" from the navigation window and then execute both functions 
separately using the "Compile" and "PLC > Download" commands. This procedure is 
recommended in various scenarios: 
● A download in run is ruled out for reasons of safety. 
● If the download is to be initiated later for time reasons. 
● If the quality of configuration data is to be checked based on the compiler log. 

Requirements 
The diagnostics screens were generated at least once or were updated in the course of 
configuration changes.  

Procedure 
1. Select the Maintenance Station PC from the Navigator of SIMATIC Manager. 
2. Select the "PLC > Compile and download objects" command from the shortcut menu. 
3. The "Compile and download objects" dialog box opens and shows the selected 

components on the "Selection table" area. Expand the folder structure in the "Objects" 
column until all objects are displayed. 

4. Check the "Compile" and "Download" columns. The check boxes must be activated in 
both columns in order to execute both functions in a single step.  
You can also decide only to run the compilation and discard the download for the time 
being if you are short on time or for reasons of safety. 

5. Click "Start". A message is output to indicate program changes in run. After having 
checked the message, you can cancel the operation and return to the dialog, for 
example, in order to execute only the "Compile" function. Acknowledge the message and 
start the operation by clicking "OK". 

6. Progress of the compile and download operation is indicated on the screen. 
7. The program outputs the log to the screen on completion of the operation. Check the log 

and then close this view. 
8. Close the "Compile and download objects" dialog box by clicking "Close". 

Result 
The diagnostics screens are compiled and downloaded to the Maintenance Station.  
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5.5 Integrating SIMATIC Maintenance Station into an existing WinCC 
project 

5.5.1 Introduction 

Configuration with integration into a WinCC project 
● You need to set up diverse computer and project properties for integration. 
● User rights are verified and adapted to maintenance station diagnostics. 
● Configure the logical links between the WinCC project and the diagnostics screens. 

5.5.2 Settings in the WinCC project 

Requirements 
The diagnostics screens were generated at least once or were updated and downloaded to 
the Maintenance Station.  

Overview of settings in the WinCC project 
In order to integrate the maintenance station in a current WinCC project, you need to check 
diverse settings in this project after having created the diagnostics screens.  

Project properties 
Check the project properties and in particular the project type definition the settings in the 
"Hotkeys" and "Options" tabs.  
For additional information, please refer to "Setting up the WinCC project (Page 142)".  
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Computer properties 
Check the computer properties and in particular the correpsonding parameters set in the 
"Graphics Runtime" tab. Check the screen name setting in the "Start screen" field. This 
name determines the start screen of the WinCC user interface:  
● If the input box contains the name of the start screen of the process screens, the program 

opens the user interface with the previously used process screens. 
● If the input box shows the name "@screen.pdl", the program initially opens the 

diagnostics screens. 
You can program corresponding links to allow you to change between the user interface of 
the process screens and diagnostic screens. These links are described in the sections 
below.  
Check the settings in the "Window attributes" and "Shutdown" areas.  
For additional information, please refer to "Defining computer properties of the WinCC 
project (Page 143)".  

User rights and authorizations 
Open WinCC User Administrator to check existing users and their authorizations.  
On the Maintenance Station, WinCC OS Project Editor adds the "Diagnostics" column to the 
user rights table. User rights granted in the "Enabled" column are automatically assgined in 
the "Diagnostics" column. However, if the authorization is disabled in the "Enabled" column 
you can only assign it for diagnostics.  
Create new users and user groups as required and assign permissions which cover, for 
example, only diagnostics or the default permissions defined in the "Enabled" column.  
For additional information, please refer to "Checking and creating users and user rights 
(Page 147)".  



 Configuration for SIMATIC Maintenance Station 
 5.5 Integrating SIMATIC Maintenance Station into an existing WinCC project 

SIMATIC Maintenance Station 2007 
Operating Manual, 04/2008, A5E00901992-03 135 

5.5.3 Linking process screens of the current WinCC project with the diagnostics screens 

Introduction 
The diagnostics screens of the Maintenance Station can be integrated in the WinCC project 
of a WinCC station previously used as process control station.  
This integration requires the creation of logical links to interconnect the user interfaces in the 
process and diagnostics screens. 
This section shows how to logically link a process screen with the diagnostics screens.  

Requirements 
The diagnostics screens were generated or updated in the S7 project.  

Procedure 
1. Open the "Graphics Designer" editor in the WinCC project. Select "File > Open". The file 

selection dialog opens.  
2. Select the process screen on which you want to set the logical link to the diagnostics 

screens. Confirm the selection with "OK". 
3. In the Object Palette, click the "Button" object on the "Windows objects" area. 
4. Position the mouse pointer on an area of the open process screen and keep the mouse 

button pressed to draw the size of the "Button" object. 
5. The "Button Configuration" dialog opens. Type the text you want to assign to the button 

into the "Text" input box. 
6. If the function requires access protection, open a corresponding selection dialog box by 

clicking "Authorization…" and then assign the permission as required. 
7. Enter the name "@screen.pdl" in the input box on the "Change Picture on Mouse Click" 

area. This object represents the start screen of the Maintenance Station user interface. 
You can also click the corresponding button to open a selection dialog in which you can 
assign the "@screen.pdl" screen. 

8. Click "OK" to close the dialog box and save the process screen. 

Result 
You have successfully configured a button function on a process screen for changing to the 
overview of diagnostics screens of the Maintenance Station.  
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5.5.4 Configuring the logical link of diagnostics screens with the process screens of a 
current WinCC project 

Introduction 
The diagnostics screens of the Maintenance Station can be integrated in the WinCC project 
of a WinCC station previously used as process control station.  
This integration requires the creation of logical links in the process and diagnostics screens 
which interconnect the user interfaces.  
This section describes the procedure of creating a logical link in the diagnostics screens to 
the process screens.  
The user interface of the diagnostics screens contains static and dynamic screen elements. 
The logical link should preferably be created for this reason in static screen elements such 
as the overview area or in the toolbar sets.  
Toolbar set 2 is used in this example, as this set provides the most space reserves. The 
overview are is not suited quite as well, as this area is always overwritten with area selection 
buttons and group displays and does not provide any larger free spaces in the remaining 
sections.  

 

 Note 
Check the settings on the "Basic data" tab when you run "WinCC OS Project Editor" after 
having integrated the button in the overview area or the button sets of the user interface. If 
you do not check these settings, the program restores default settings and overwrites the 
changes made to these objects!  

 
You could also integrate the object in the Maintenance Station overview screen, as this 
screen is not overwritten when you generate the diagnostics screen and when running the 
"WinCC OS Project Editor".  

Requirements 
● The diagnostics screens were generated or updated in the S7 project. 
● The WinCC project was opened in SIMATIC Manager. 
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Procedure 
1. Open the "Graphics Designer" editor in the WinCC project. Select "File > Open". The file 

selection dialog opens. 
2. Select the "@Buttons12.pdl" screen of toolbar set 2 in which you are going to set the 

logical link to the process screens. Confirm the selection with "OK". 
3. In the Object Palette, click the "Button" object on the "Windows objects" area. Position the 

mouse pointer on an area of the open screen and keep the mouse button pressed to 
draw the size of the "Button" object. 

4. The "Button Configuration" dialog opens. Type the text you want to assign to the button 
into the "Text" input box. 

5. If the function requires access protection, open a corresponding selection dialog box by 
clicking "Authorization…" and then assign the permission as required. 

6. Close the dialog box by clicking "OK". Adjust the size and position of the button you 
inserted to suit requirements. 

7. Double-click the button. The "Object properties" dialog box opens. 
8. On the "Event" tab, select the "Mouse" entry from the "Button" folder. 
9. Select the "Mouse click" event from the table. Position the mouse pointer onto the 

lightning bitmap in the same row of the "Action" column. Select "C-Action" from the 
shortcut menu. The "Edit actions" dialog box opens. 

10. You have several options of configuring the change from the diagnostics user interface to 
the process screens. Select the "OpenHomePicture" function from the "Internal functions 
> graphics" folder to configure a jump from the process screens to the start screen of the 
WinCC project. The start screen of the user interface of the process screens is entered as 
start screen. Select the "OpenPicture" function from the "Default functions > graphics" 
folder to configure a function for changing between process screens. Enter the screen 
name as parameter. Double-click the function to enter it in the input box. Close the dialog 
box by clicking "OK". 

 

  Note 
When using the "OpenPicture" function or the "Button" object with "Change Picture on 
Mouse Click" function in a specific configuration to change to the process screens, the 
screen called may be output to the working area of the diagnostics user interface.  

11. Confirm the warning of pending compilation by clicking "Yes". 
12. Close the "Object properties" dialog box. Save the "@Buttons12.pdl" screen. 
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Result 
The change to the start screen of the process screens is configured in toolbar set 2 of the 
diagnostics screens.  

 

 Note 
This new configuration has changed the basic data of the WinCC project. Check the settings 
of the "Basic data" tab in "WinCC OS Project Editor". 
Any changes made to objects such as basic screens, local computer actions and faceplates 
are indicated on this tab. You restore factory defaults and overwrite your changes if you 
activate the check box at a modified object!  
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5.6 Configurations in the WinCC project 

5.6.1 Basic settings in the WinCC Project 

Introduction 
In a WinCC project special properties for the project and thus for the operation of the 
Maintenance Station are configured.  
● Project settings 
● Computer properties 
These properties are to be configured and tested for the following WinCC projects.  
● The WinCC project of the Maintenance Station, particularly when creating a new 

Maintenance Station. 
● The WinCC project of every WinCC Server that makes data available for the Maintenance 

Station.  
For additional information on this topic, please refer to "Specifying the computer 
properties of a WinCC server (Page 145)". 

 

  Note 
Always use SIMATIC Manager to create and modify the plant structure and the hierarchy 
of diagnostics screens. The "Compile OS" function is otherwise going to overwrite or fail 
to update data of the WinCC project you edited in SIMATIC Manager. 
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Basic settings in the WinCC Project on the Maintenance Station 

Project settings 
Configure the internal project settings. 
● Project type 

The Maintenance Station project may be a "multiuser" or "single-user" type. The project 
type is selected depending of the system type of the overall system. 

 

  Note 
If the project type is changed after the diagnostics screens have been created for the first 
time, please note the information in "Changing the project type in WinCC  (Page 149)". 

● Update cycles 
Determines the rate at which the dynamic display, for example, of a tag value or status, is 
updated in the active process. The dialog box outputs a list of all available default update 
cycles. You can define additional user-specific update cycles on this dialog box to suit 
specific requirements of your project. 

● Hotkeys 
You can define "Logon", "Logoff" and "Hardcopy" hotkey functions. The plant operator 
can use these hotkeys within the active process. 

● Runtime options  
These options are used to specify the properties with regard to the activation and the 
characteristics in Runtime, for example whether activation of the Maintenance Station on 
the Engineering Station is permissible. 

Computer properties 
The computer properties define Maintenance Station characteristics such as the Runtime 
language, time zone, window attributes and cursor control in the active process. 
The computer properties are grouped in different tabs:  
● "General" tab  

No settings are required in this tab. The compute name and type are set automatically. 
The entry in the "Computer name" field represents the name of the computer currently 
running the WinCC project. It also represents the network name of the station. This name 
is automatically replaced with the name of the target computer to which you download the 
project. 

● "Startup" tab  
In this tab you specify in the so-called startup list which applications are required in 
process operation and are started automatically when the WinCC projects of the 
Maintenance Station is started. Usually, you do not have to modify any settings on this 
tab, as these values are set automatically.  

 

  Note 
If the S7 project of the Maintenance Station contains a WinCC Server that provides data 
for the Maintenance Station, the startup list has to contain certain applications. For 
additional information on this topic, please refer to the section titled "Specifying the 
computer properties of a WinCC Server". 
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In order to minimize the load on the computer, you should only activate those applications 
that are also required for process operation. By contrast to the Maintenance Station 
Client which requires activation of the "Graphics Runtime" application, this application can 
be deactivated on a Maintenance Station Server without operating and monitoring 
functions. 

● "Parameters" tab 
On this tab you can set properties such as the process runtime language or the time 
zone. It also allows you to disable Windows hotkeys. Such settings prevent the startup of 
additional applications which may have a negative impact on Maintenance Station 
performance in the active process. 

 

  Note 
The Windows hotkeys usually do not have to be disabled in the engineering phase. You 
disable all Windows hotkeys the plant operator may not use after you configured the 
system and released the active process. 

● "Graphics-Runtime" tab 
In this tab you specify all the settings that apply for displaying in process operation. 
Usually, you do not have to edit these tab settings. Additional visualization settings can 
be made in OS Project Editor. 

 

  Note 
When operating the plant in test mode, you can activate the "maximize" and "minimize" 
window attributes, for example. This allows you to quickly change from the runtime view 
to other applications when running the system in test mode. However, you should disable 
these settings when you release the plant to the active process. 

● "Runtime" tab 
This tab is used to define settings for the active process. 
When using VB scripting, you can set up a VBS debugger at the "VBS Debug Options" 
areas. On this tab you can also define a process screen cache and the appearance of the 
mouse pointer for the indication of specific control options to the plant operator. 

For more detailed information, please refer to the documentation for SIMATIC WinCC. 
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5.6.2 Setting up the WinCC project 

Introduction 
The internal properties are defined in the project properties dialogs. 

Requirements 
● The configuration of the hardware in the S7 project is up-to-date. 
● The diagnostics screens were created or updated, and compiled with "Compile OS". 
● The WinCC project of the maintenance station is opened in SIMATIC Manager. 
● "WinCC OS Project Editor" must have been started before you initially generated the 

diagnostics screens. 

Procedure 
1. Select the project folder from the navigation window of the WinCC Explorer. The folder is 

assigned the name of the PC station in SIMATIC Manager. Select the menu command 
"Edit > Properties". The "Project properties" dialog box opens with the "General" tab. 

2. Check the settings on the "General" tab. You can define "multiuser" or "single-user" 
project type for the maintenance station, depending on the overall system configuration. 
The "multiuser project" type is assigned accordingly to the maintenance station if your 
system configuration contains any other WinCC station with multiuser project. 

3. Change to the "Update cycles" tab. You can define user-specific update cycles on this 
dialog box to suit specific requirements of your project. 

4. Change to the "Hotkeys" tab. The "Actions" list returns various actions which you can 
assign a hotkey function. Continue at step 6 if you do not want to define any 
assignments. 

5. Click in the field below the "Assign" button if you want to assign a hotkey. Press the key 
combination you want to assign on the keyboard. The key combination is displayed in the 
box. Accept this hotkey by clicking "Assign". 

6. Change to the "options" tab to check its settings. Check in particular the "Allow activation 
on the ES" option. Set this option to enable activation of the maintenance station on the 
ES of the S7 project. 

7. Click "OK". This accepts all entries made and closes this dialog box. 

Result 
You defined various hotkeys and user-specific cycles for maintenance station runtime. 
For more detailed information on these dialog boxes, please refer to the SIMATIC WinCC 
documentation. 
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5.6.3 Defining computer properties of the WinCC project 

Introduction 
The computer properties determine the runtime properties of the maintenance station.  
The following description applies for the WinCC project of the Maintenance Station.  

Requirements 
● The configuration of the hardware in the S7 project is up-to-date. 
● You created or updated the diagnostics screens and executed the "Compile and 

download OS" function to download these to the WinCC project of the maintenance 
station. 

● The WinCC project of the maintenance station is opened in SIMATIC Manager. 

Procedure 
1. Select the "Computer" object in the navigation window of WinCC Explorer. Select the 

menu command "Edit > Properties". The "Computer list properties" dialog box opens. In 
the S7 environment, the "Computer list" returns exactly the computer that you have 
selected in the SIMATIC Manager and have opened in the WinCC project. 

2. Select the computer and click the "Properties" button. The "Computer properties" dialog 
box opens, and the "General" tab is displayed. 

3. Usually, you do not have to make any settings on the "General" and "Startup" tabs. 
Change to the "Parameters" tab. 

4. Set the languages as required at the "Runtime language" and "Default runtime language" 
selection boxes. Check the time zone settings at the "Runtime timebase" selection box. 

5. Disable specific Windows hotkeys on the "Disable hotkeys" area. Activate the 
corresponding check box. 

 

  Note 
The Windows hotkeys are usually not disabled in the engineering phase. You disable all 
Windows hotkeys the plant operator may not use after you configured released the 
system for the active process. 

6. Change to the "Graphics Runtime" tab. Define all visualization setting for runtime, for 
example, window attributes, deactivation of functions, hotkeys and cursor control. 
Additional visualization settings can be made in OS Project Editor. 

 

  Note 
When operating the plant in test mode, you can, for example, activate the "maximize" and 
"minimize" window attributes. This allows you to quickly change from the runtime view to 
other applications when running the system in test mode. However, you should disable 
these settings when you release the plant to the active process. 
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7. Change to the "Runtime" tab. Define the users-specific settings for maintenance station 
runtime.  
When using VB scripting, you can set up a VBS debugger at the "VBS Debug Options" 
areas.  
Define a process screen cache on the "Screen cache" area. 
The "Mouse pointer" area offers additional cursor images you can set for runtime control 
options. Open the selection dialog by clicking "...", and then select the cursor. The 
currently configured cursor representations are shown on the right side of the "..." 
buttons.  

8. Click "OK". This confirms your entries and closes this dialog box. 
9. Click "OK" to close the "Computer list properties" dialog box. 

Result 
The Maintenance Station properties in runtime are configured. 
For more detailed information, please refer to the documentation for SIMATIC WinCC. 
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5.6.4 Specifying the computer properties of a WinCC server 

Introduction 
Properties of the WinCC project in Runtime are specified in the computer properties. 
The following description applies for a WinCC Server that makes data available for the 
Maintenance Station and is integrated in the S7 project of the Maintenance Station.  
Certain applications have to be contained in the startup list of this WinCC Server.  

Requirements 
● The configuration of the hardware in the S7 project is up-to-date. 
● The WinCC Server that makes data available for the Maintenance Station is integrated in 

the S7 project of the Maintenance Station. 
● The WinCC project of the WinCC servers is opens by means of the SIMATIC Manager. 

Procedure 
1. Select the "Computer" object in the navigation window of WinCC Explorer. Select the 

menu command "Edit > Properties". The "Computer list properties" dialog box opens. 
2. In the S7 environment, the "Computer list" returns exactly the computer that you have 

selected in the SIMATIC Manager and have opened in the WinCC project. 
3. Select the computer and click the "Properties" button. The "Computer properties" dialog 

box opens, and the "General" tab is displayed. 
4. You do not have to carry out any settings in the "General" tab. Change to the "Startup" 

tab. 
5. Check whether the following applications are activated in the startup list in the "Sequence 

when starting WinCC" list box and activate the missing application, if necessary. 
– Text Library Runtime 
– Alarm Logging Runtime 
– Tag Logging Runtime 

6. Check whether the following applications are contained in the startup list in the 
"Additional tasks/applications" list box and add the missing application, if necessary. 
– CCPerfmon.exe 
– CCCSigRTServer.exe 
– CCTTRTServer.exe 
– OSLTMHandlerX.exe 
– IMServerX.exe 

7. Click "OK". The "Computer properties" dialog box closes. 
8. Click "OK" to close the "Computer list properties" dialog box. 
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Result 
The properties of the WinCC server supplying the data are checked.  
For more detailed information, please refer to the documentation for SIMATIC WinCC. 
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5.6.5 Checking and creating users and user rights 

Introduction 
The setup of your Maintenance Station in the WinCC project includes the configuration of 
users and user rights, namely of so-called authorizations.  
These users and user rights must be configured to enable user login to the Maintenance 
Station and operation of the elements of the user interface.  
On a new Maintenance Station the program automatically creates the group of 
"Administrators" and the "Administrator" and assigns these members default privileges. 
However, Maintenance Station operation requires at least one more user with defined user 
rights.  
On the Maintenance Station, WinCC OS Project Editor adds the "Diagnostics" column to the 
user rights table.  
For additional information on the authorizations required, please refer to "Control elements of 
the toolbar sets and of the message system (Page 196)".  
Additional information regarding the user administration can be found in the WinCC 
documentation at "Working with WinCC" and "Configuration of the User Administration".  

Requirements 
● The diagnostics screens were generated at least once or were updated and downloaded 

to the Maintenance Station. 
● Run "WinCC OS Project Editor" in the WinCC project before you continue. 

Procedure 
1. Select the "User Administrator" editor from the navigation window of WinCC Explorer. 

Open it by double-clicking the symbol.  
2. The navigation window shows the existing users and user groups. Continue at step 4 if 

you created a new WinCC project for the Maintenance Station. 
3. Check the authorization of all users and user groups configured in a current project. 

Assign corresponding user rights to an existing user or user group in the "Diagnostics" 
column if you do not specifically want to set up a new user for handling diagnostics 
functions. Select the relevant user(s) from the navigation window. The table output on the 
right pane shows currently assigned authorizations. Check authorizations set in the 
"Diagnostics" column and assign these to the user as required. You should also check 
the "Administrator" privileges concerning access to diagnostics functions. Continue at 
step 6. 

4. Check the Administrator" privileges after having created the new WinCC project. Select 
the "Administrator" from the navigation window. The table output on the right pane shows 
the currently assigned authorizations. Assign all authorizations required, for example, with 
attributes up to "999", by double-clicking the "Enable" column. 
User rights assigned in the "Enable" column are automatically inherited at the 
"Diagnostics" column. However, if the user right is disabled in the "Enabled" column you 
can only assign it for diagnostics. 
Repeat this step for the "Administrators" group. 
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5. Select the "Administrator" from the navigation window. Select "User > Change password". 
The password input box opens. You do not have to enter an "Administrator" password in 
the "Old password" input box when configuring a new project. Type the new password 
into the "New password" input box and then confirm this entry in the "Repeat" input box. 
Close the dialog box by clicking "OK". 

6. Create a new user group for diagnostics as required. Select "User > Create group". Type 
in the name of the new group, for example, "Diagnostics maintenance", on the navigation 
window. Assign corresponding authorization attributes, for example, from "2" to "999" by 
double-clicking in the "Enable" column of the table. The setting in the "Enable" column is 
automatically applied to the "Diagnostics" column.  
You can also choose to assign this user group only access rights for diagnostics 
functions. Activate the authorizations at the "Diagnostics" column but do activate these in 
the "Enable" column. 

7. Create a new user for diagnostics as required. Select the new group you created from the 
navigation window and then select "User > Create user…".  
 Enter the new user name in the "Login" input box of this dialog. Type the new password 
into the "Password" input box and then confirm this entry in the "Repeat" input box. 
Activate the "Also copy group settings" check box. Close the dialog box by clicking "OK". 
The new user is created and group authorizations are applied. 

8. Close the "User Administrator" by selecting "File > Close". 

Result 
Existing user rights were checked in an existing WinCC project.  
The "Administrator" privileges for the new Maintenance Station were checked. A user was 
created as required for Maintenance Station diagnostics and assigned corresponding user 
rights.  
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5.6.6 Changing the project type in WinCC 

Introduction 
When the Maintenance Station is in use, it may be advisable to change the project type of a 
WinCC project; for example, from a single-user project to a multiuser project.  
● Determining the plant type results in a configuration that cannot be determined.  

For additional information on this topic, please refer to "Principle of determining the plant 
types (Page 26)". 

● A more beneficial method of communication for the Maintenance Station Server would be 
to use either a direct process connection or server packages.  
For additional information on this topic, please refer to "Information on client-server 
architectures (Page 39)". 

Procedure 
1. Select the project folder in the navigation window of the SIMATIC Manager. Select 

"Diagnostics screens > Settings..." from the shortcut menu. The "Settings for Generating 
Diagnostic Screens" dialog box opens. 
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2. Deactivate the "Derive diagnostic screens" check box. Click "OK" to confirm the message 
that follows and close the dialog box. 

3. A "Report system errors" message will then appear for each configured AS. Select the 
"No" option for all messages so that the diagnostics blocks are not deleted. 

4. In the SIMATIC Manager navigation window, highlight the PC station whose WinCC 
project type you wish to change. Navigate to the corresponding "OS" icon via this PC 
station. Select "Open Object" from the shortcut menu.  
The WinCC Explorer opens. 

5. Select the project folder from the navigation window of the WinCC Explorer. The folder is 
assigned the name of the PC station in SIMATIC Manager. Select "Edit > Properties". 
The "Project properties" dialog box will open. 

6. On the "General" tab, change the project type setting to the one you require. Close the 
dialog box by clicking "OK". 

7. Click "Yes" to confirm the message that follows ("Change project type") and close the 
WinCC Explorer by selecting "File > Exit". 

8. Select the project folder in the navigation window of the SIMATIC Manager. Select 
"Diagnostics screens > Settings..." from the shortcut menu. The "Settings for Generating 
Diagnostic Screens" dialog box opens. 

9. Activate the "Derive diagnostic screens" check box. Close the dialog box by clicking "OK". 
Click "OK" to confirm the message that follows. 

10. Select the project folder in the navigation window of the SIMATIC Manager. Select 
"Diagnostics screens > Create diagnostics screens..." from the shortcut menu. The 
"Create Diagnostics Screens" dialog box opens. 

11. The list highlights the automation systems for which you generated diagnostics screens in 
the previous update session. Change the settings if necessary. 

12. Confirm the selection by clicking "OK". The update procedure starts. Acknowledge the 
message informing you that generation has successfully completed. 

Result 
The WinCC project type has been changed.  
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5.6.7 Configuring the default server for client control messages 

Introduction 
In the project for the Maintenance Station Server client, what is known as a default server 
must be defined so that control messages can be triggered and displayed via a Maintenance 
Station/WinCC Client (for example, if a maintenance task has been initiated in the 
maintenance view).  

Procedure 
1. In the navigation window of the SIMATIC Manager, select the PC station of the 

Maintenance Station Client or WinCC Client, and then select the corresponding "OS" 
icon. Select "Open Object" from the shortcut menu. The WinCC Explorer opens. 

2. Select the "Server data" icon in WinCC Explorer. 
3. Select "Default server..." in the shortcut menu. The "Configure default server" dialog box 

opens. 
4. In the "Symb. computer name" field, select the name of the Maintenance Station Server 

for the "Alarms" component. 
5. In the "Symb. computer name" field, select the name of the Maintenance Station Server 

for the "Archive" component. 
6. Close the dialog box by clicking "OK". 
7. Close the WinCC Explorer by selecting "File > Exit". 

Result 
Control messages for operations on the Maintenance Station/WinCC Client are triggered and 
can also be displayed.  

 

 Note 
You still need to download the changes to the client.  
Please note that these changes will only take effect once WinCC Runtime has been 
restarted on the client. 
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5.7 Diagnostics on Maintenance Station Server 

Running maintenance station diagnostics on a Maintenance Station Server 
A PC previously operated as Maintenance Station Server can also be used to run 
maintenance station diagnostics.  
Maintenance station functionality requires that the "Graphics Runtime" application is active in 
the WinCC project of the Maintenance Station Server.  
To activate this application, select the "Startup" tab from the "Computer properties" dialog 
box, and then set the "Graphics Runtime" check box at the "Startup sequence of WinCC 
Runtime" list.  
The Maintenance Station user interface opens on the Maintenance Station Server when you 
restart the WinCC project. You login to the station by entering one of the configured user 
names. 
License agreements apply same as to any Maintenance Station Client.  

5.8 Complete export of component data 

Overview 
What is known as a complete export can be used to export all the SIMATIC Maintenance 
Station components with diagnostics capability for further processing in other applications.  

The complete export is started via the  button in the overview screen of the 
Maintenance Station. 
The data from all the components with diagnostics functionality are exported to the 
"@XML_Export.sml" file. 

Storage of the export file 
The storage path for the export file is specified by using the WinCC tag "@ExportPath".  
This is an internal tag of the data type "Text tag 16-bit character set". The path for the 
storage of the export file is configured as the start value for the tag, for example to external 
drives as "\\<pc_name>\<released_directory>\<directory>" or to local drives as 
"<drive_name>\<directory>".  

See also 
Overview of control elements in the diagnostics screens (Page 190) 
Starting the complete export of the component data (Page 229) 



 Configuration for SIMATIC Maintenance Station 
 5.9 Exporting the data of an individual component 

SIMATIC Maintenance Station 2007 
Operating Manual, 04/2008, A5E00901992-03 153 

5.9 Exporting the data of an individual component 

5.9.1 Introduction to exporting the data of an individual component 

Overview 
During diagnostics with the SIMATIC Maintenance Station the data of an individual 
component is displayed in the various views in the diagnostics faceplate of this component. 
● I&M data (online /offline) 
● Messages 
● Status of a maintenance job. 
The so-called individual export can be used to export the data of an individual component in 
XML format for further processing in other applications.  
● CMMS applications or applications of the ERP level. 
● WinCC add-on "Alarm Control Center ACC":  

The Alarm Control Center sends WinCC messages fully automatically to a variety of 
possible receivers such as text messages to mobile phones, pagers, e-mail. 

● WinCC add-on "PM-MAINT": 
PM-MAINT is a branch- and technology-neutral maintenance planning tool for 
preventative maintenance. 

This section describes examples for the individual export for the WinCC add-ons "Alarm 
Control Center ACC" and "PM-MAINT". 

Identifying components with the Asset ID 
The asset ID is used to identify the components and must be unique across the entire 
project. The asset ID is a character string of 32 characters that is transferred to the export 
file when an individual export is carried out.  
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Configuring the asset ID 
● When creating new S7 projects with STEP 7 V5.4 SP3 or higher, the asset ID is 

generated automatically for all components configured in the "HW Config" editor.  
● When migrating S7 projects that were created before STEP 7 V5.4 SP3, the asset ID for 

all configured components must be created manually on a one-off basis. The "Allocate 
asset ID..." function in the "HW Config" editor is used for this purpose.  
In "HW Config", each configured AS station is opened once and the "Allocate asset ID..." 
function in the "Edit" menu started. The function creates unique asset IDs for the AS and 
its corresponding subcomponents, and also indicates in a dialog box where these can be 
edited (if necessary). Once the dialog box has been confirmed, the AS station still needs 
to be saved, compiled and downloaded.  
This is particularly necessary if the asset ID will continue to be used, e.g. by PM-MAINT.  

● For each asset proxy, the asset ID must be allocated manually by means of configuration 
in the corresponding instance blocks.  
For additional information on this topic, please refer to "Configuring an asset ID for 
individual export with a standard asset proxy (Page 66)". 

Principle for configuration and data export  

Configuration 
Every application for which the data of the SIMATIC Maintenance Station are to be exported 
is a so-called export target. In order to manage the export process, various internal tags with 
the prefix "@ASSET_EXPORT" are created in SIMATIC WinCC for each export target. The 
tag name contains a numerical placeholder for assigning the tags to an export target. Each 
number stands for an export target.  
For additional information on the tags used, please refer to "Creating tags for exporting the 
maintenance data (Page 160)".  
Global scripts are used for the data export for PM-MAINT and Alarm Control Center. When 
exported to PM-MAINT the data are converted by the script into the format required for 
PM-MAINT.  
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Exporting the data 
The procedure for exporting the data is started by the user in the diagnostics faceplate of a 
component; for example, after the maintenance status has changed or a maintenance 
measure has been introduced. 
In the diagnostics faceplate of the component, the required export target is selected in the 
"Request via" field of the "Maintenance" view. The export is started by using the "Execute" 
button.  

 
 

The data is exported in an export file in XML format. The corresponding tags in WinCC for 
managing the process are used.  

Name of export file 
The name of the export file has the following format: "<Tagname>.<Asset ID>_JJJJ-MM-
TT_HH_MM_SS.XML".  
The elements have the following meaning: 
● "<Tag_name>" = Configured component designation. 
● "<Asset ID>" = ID number of the component. 
● "YYYY-MM-DD_HH_MM_SS" = Date and time when the component data was exported. 
● "xml" = File type 
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Storage of the export files 
The export file is stored in the default path "<WinCC_project_directory> / AssetExport".  
A subdirectory for this default path can optionally be defined by using the tag 
"@ASSET_EXPORT_<n>_DIR".  
Directory structure when the example scripts are used 
● If the example script for PM-MAINT is used, the data are converted into the format 

required for PM-MAINT during exporting. The converted data are stored in the 
subdirectory "OUT2". 

● If the example script for Alarm Control Center is used, the data are stored in the 
subdirectory "OUT" during exporting. 

 

  Note 
The export file is not deleted by the Maintenance Station. If required, this step must be 
carried out by either the user or the application that receives the data. 

Status changes at the maintenance station 
When the status changes - for example, after the maintenance job has been terminated - 
exporting has to be restarted by the user to transfer the status to the application (such as the 
Alarm Control Center) for further processing. 

See also 
Exporting the data of a single component  (Page 230) 
Overview of the data export for PM-MAINT (Page 164) 
Overview of the data export for the Alarm Control Center (Page 174) 
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5.9.2 Data in the export file 

Overview of the data  
When the component data of the Maintenance Station are exported to an application for 
further processing, such as PM-MAINT, the data from the diagnostics faceplate is stored in 
XML format.  
For information about storing the export file please refer to the chapter "Exporting component 
data for other applications".  

 
 

In the XML file the data are structured into the following sections: 
● "DocumentInfo" 

Contains general data, for example creation date, user name, PC name. 
● "Maintenance Information" 

Contains the data of the "Maintenance" view of the diagnostics faceplate, for example 
maintenance status, number of the maintenance job. 

● "Alarms" 
Shows the pending maintenance messages of this component from the "Maintenance" 
view of the diagnostics faceplate. 

● Equipment Information 
Contains the component data from the "Ident" view of the diagnostics faceplate. 
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Data of the "Maintenance Information" section 
The following table shows the meaning of the data in the export file in the XML tag 
"<b2mml:MaintenanceInformation>".  
The information described in the table in the "XML tag" column is available in XML format in 
the XML tag, for example "<b2mml:Problem>". 

 
XML-Tag 
< b2mml:...> 

Display in the faceplate Meaning  

Problem "Note" field Information or note  
Requestor No display User who is currently logged in  
Status "Request operator" 

status display 
Status display  

SubmissionDate No display Date 
MaintenanceWorkOrderID Maintenance work 

order no.  
Number  

EquipmentID No display Installation date / 
HW Config 
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Data of the "Equipment Information" section 
The following table shows the meaning of the data in the export file in the XML tag 
"<b2mml:EquipmentInformation>".  
The information described in the table in the "XML tag" column is available in XML format in 
the XML tag, for example "<b2mml:ValueString>".  
<b2mml:EquipmentProperty> 
    <b2mml:ID>MANUFACTURER_NAME <ID> 
        <b2mml:Value> 
        <b2mml:ValueString>SIEMENS AG<ValueString> 
        ...... 
        <b2mml:Value> 
<b2mml:EquipmentProperty> 

 
XML tag 
< b2mml:ID>  

Field display in the 
faceplate 

Meaning / source  

NAME  Name or designation in 
the title of the faceplate 

Name or designation in the title of the faceplate 
a) Standard: Name of the S7 project and component name  
b) At switches: IP address 

DEVICE_TYPE "Device type" Device type /  
HW Config 

MANUFACTURER_NAME "Manufacturer" Manufacturer /  
Online data 

ORDER_ID "Order number" Order number /  
Online data 

SERIAL_NUMBER "Serial number"  Serial number / 
Online data from the device 

INSTALLATION_DATE "Installation date" Installation date / 
HW Config 

HARDWARE_REVISION "HW revision" Hardware revision /  
Online data 

SOFTWARE_REVISION "SW revision" Software revision or firmware revision /  
Online data 

TAG_FUNCTION "Tag" Name or designation  
a) Standard: Component name (without name of the 
S7 project)  
b) At switches: IP address 

TAG_LOCATION "Description" Description or location / 
Online data from the device 

DESCRIPTOR "Notification" Notification /  
Online data 

COMMENT "Comment" 
 

Comment / 
HW Config 
 
Note: The text in the "Comment" field is also displayed in the 
title bar of the faceplate. 

 
For additional information on the source of the data, please refer to "Source and visualization 
of component data (Page 90)".  
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5.9.3 Creating tags for exporting the maintenance data 

Introduction 
In order to export data of an individual component, various internal tags are created in 
SIMATIC WinCC in order to manage the export process for each export target.  
The following table shows the possible tags: Not all the tags are required, depending on the 
export target.  

 
Name Function  Type 
@ASSET_EXPORT_<n>_NAME Name of the export target.  

This name is displayed in the diagnostics 
faceplate of the component as an export 
option.  
The name is defined as the start value of 
the tag.  

Text 16-bit 
character set 

@ASSET_EXPORT_<n>_USERDATA Optional tag. 
This information is included in the export 
and can serve to differentiate several 
export targets, for example as a group for 
Alarm Control Center.  
The information is defined as the start 
value of the tag. 

Text 16-bit 
character set 

@ASSET_EXPORT_<n>_DIR Optional tag. 
The export file is stored in the default path 
"<WinCC_project_directory> / 
ASSETEXPORT".  
The tag can be used to define a 
subdirectory for this default path in which 
the export file is stored.  
If the tag for an export target does not 
exist, the export file is stored in the default 
path "<WinCC_project_directory> / 
AssetExport".  
The directory name is defined as the start 
value of the tag. 

Text 16-bit 
character set 

@ASSET_EXPORT_<n>_FLAGS Optional tag. 
The tag is not used at present. If the tag 
does not exist, the value "0" is used.  

Integer 
unsigned 32 Bit 



 Configuration for SIMATIC Maintenance Station 
 5.9 Exporting the data of an individual component 

SIMATIC Maintenance Station 2007 
Operating Manual, 04/2008, A5E00901992-03 161 

Name Function  Type 
@ASSET_EXPORT_FINISHED Optional tag. 

A script can be used for the export 
function. During the export this tag is used 
as the trigger for this script.  
The tag is only required once in the 
project, even if several export targets are 
defined. The tag therefore does not 
contain a numerical placeholder "<n>".  

Integer 
unsigned 32 Bit 

Assignment of the tags to the export target 
The numerical placeholder "<n>" in the tag name is used to assign the individual tags to an 
export target. Each number stands for an export target. The tag 
"@ASSET_EXPORT_FINISHED" does not contain any numerical placeholder since it is not 
assigned to an export target.  

 

 Note 
The export targets must be numbered consecutively. 
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Procedure 
1. Open the WinCC project of the Maintenance Station. 
2. In the directory window select the "Tag Management> Internal Tags" directory and open 

the shortcut menu. 
3. Select the menu command "New Tag....". The "Properties Tag" dialog box opens. 
4. Enter the name of the export tag in the "Name" field, for example 

"@ASSET_EXPORT_1_NAME". In the process, enter the number of the export target 
instead of the numerical placeholder in the name. 

5. In the "Data type" field select the corresponding type in accordance with the table above, 
for example "Text tag 16-bit character set". 
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6. If text tags do not apply here, continue with step 7.  
In the case of a "Text" type tag, the start value still needs to be configured.  
Change to the "Limits/Logging" tab. Select the check box for the "Start value" field and 
enter the desired value or text. The use of the text depends on the tags and is listed in 
the table above. 

7. Close the dialog box by clicking "OK". 
8. Repeat steps 2 to 7 in order to create all the required tags for this export target. 
9. Close the WinCC project. 

Result 
The tags for the data export to an export target have been created.  
If necessary, repeat these steps to create the tags of additional export targets. 

See also 
Configuring the data export for PM-MAINT  (Page 166) 
Configuring the data export for Alarm Control Center (Page 176) 
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5.9.4 Overview of the data export for PM-MAINT 

Introduction 
The SIMATIC WinCC add-on "PM-MAINT" is a branch- and technology-neutral maintenance 
planning tool for preventative maintenance. PM-MAINT offers extensive possibilities for 
connecting to automation systems of different manufacturers and in addition to a purely 
calendar-controlled maintenance also a real performance- and/or event-controlled 
maintenance.  

Overview 
The messages of the SIMATIC Maintenance Station for diagnostics, operator actions and 
maintenance demands of an individual component can be passed on by means of the 
individual export at PM-MAINT. These data can then be processed further in PM-MAINT and 
are used for event-controlled maintenance planning.  
Before using the individual export, the plant hierarchy of the components used must be 
integrated according to PM-MAINT, via what is known as the CAx data.  

Configuration 
● The following tags are created for the "PM MAINT" export target in WinCC: 

– "@ASSET_EXPORT_<n>_NAME".  
The name of the export target is specified as the start value of the tag, for example 
"PM_MAINT_Export". 

– "@ASSET_EXPORT_FINISHED" 
The tag serves as the trigger for executing a global script. 

● The export file is stored in the default path "<WinCC_project_directory> / AssetExport". A 
subdirectory for this default path can optionally be defined by using the tag 
"@ASSET_EXPORT_<n>_DIR", for example "PM_MAINT_Export_DIR". 

● A global script is defined by the user for transferring the data to PM-MAINT.  
An example script is supplied on the DVD of the Maintenance Station and is described in 
the topic "Example script for the export to PM-MAINT".  
The global script is inserted under VBS Editor in the WinCC editor "Global Script". 

● The tag "@ASSET_EXPORT_FINISHED" is configured as a trigger for the global script. 
● For the data format in the export file stylesheets are furthermore required in order to 

convert the data into a format that can be processed by PM-MAINT.  
The files "PM_MAINT_cax.xsl" and "PM_MAINT_workflow.xsl" are supplied as examples 
of stylesheets on the DVD of the SIMATIC Maintenance Station in the directory 
"Additional_Products/PM-MAINT_Integration" . 
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Exporting the data 
Exporting of the data to PM-MAINT is carried out by the user in the diagnostics faceplate in 
the "Maintenance" view. The export is not carried out automatically.  
The export target is selected in the "Request via" field and the export started by using the 
"Execute" button.  
During exporting the data are converted into the format required for PM-MAINT. Stylesheets 
are used to this purpose. If the example script is used, these stylesheets are contained in the 
"Stylesheets" subdirectory.  
After conversion the export file is stored by the example script in the subdirectory "OUT2" 
under the export directory for PM-MAINT.  

Integrating data in PM-MAINT 
In PM-MAINT the subdirectory "OUT2" is configured as the import directory.  
To transfer the plant hierarchy of the components being used to PM-MAINT, the CAx data 
need to be exported in the SIMATIC Manager and imported into PM-MAINT.  
For more detailed information on this topic, please refer to "Importing the plant hierarchy into 
PM-MAINT (Page 169)".  
For more detailed information about the integration of data in PM-MAINT, please refer to the 
PM-MAINT documentation.  

See also 
Introduction to exporting the data of an individual component (Page 153) 
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5.9.5 Configuring the data export for PM-MAINT 

Introduction 
The following section describes the configurations for exporting data of an individual 
component for PM-MAINT:  
● Creation of the export directory and the subdirectory for the stylesheets. 
● Integration of the example script in WinCC. 
● Configuration of the trigger for the example script. 
● Use of supplied stylesheets for the conversion of the data into the format required for PM-

MAINT. 
The example script from the topic "Example script for the data export to PM-MAINT" is used 
to this purpose. The example script is also supplied on the DVD of the SIMATIC 
Maintenance Station in the directory "Additional_Products/PM-MAINT_integration/Scripts".  

 

 Note 
Before using the example script check the file names and path specifications configured in it 
against the real directory structure of the PC that is used and adapt them if necessary. 

 

Requirements 
The following tags are used for the "PM MAINT" export target and have to be created in 
WinCC: 
● "@ASSET_EXPORT_<n>_NAME".  

The name of the export target is defined as the start value of the tag. The example script 
uses "PM_MAINT_Export". 

● "@ASSET_EXPORT_FINISHED" 
The tag serves as the trigger for executing a global script. 

● "@ASSET_EXPORT_<n>_DIR"  
The tag can be used optionally and specifies the subdirectory of the default path 
"<WinCC_project_directory> / AssetExport" in which the export file is to be stored. The 
directory name is specified as the start value. The example script uses 
"PM_MAINT_Export_DIR". 

For additional information about creating the tags please refer to the topic "Creating tags for 
exporting the maintenance data".  
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Procedure 
1. In the Windows Explorer navigate in the navigation window to the directory of the WinCC 

project of the Maintenance Station. By default the WinCC project lies in the directory of 
the corresponding S7 project in the subdirectory "wincproj / <wincc_project_name>". 

2. Create a new subdirectory called "AssetExport". Create a subdirectory called "Stylesheet" 
under the directory "AssetExport". 

3. Change to the subdirectory "wincproj / <wincc_project_name>" and open the WinCC 
project of the Maintenance Station by double-clicking the file 
"<wincc_project_name>.mcp". The WinCC Explorer opens. 

4. Select the entry "Global Script" in the navigation window. Open the shortcut menu and 
select the "Open VBS Editor" command. 

5. In the navigation window of the VBS Editor select the "Actions" tab. Click in the tab and 
select the menu command "New > Action" in the shortcut menu. 

6. Copy the code of the example script from the topic "Example script for the data export to 
PM-MAINT" and insert it into the new action between the code lines "Function action" and 
"End Function". Check that these code lines do not exist double after being inserted. 

7. Save the action by using the menu command "File > Save". Since this is a new action, 
the "Save As" dialog box opens. Enter the name of the action, for example 
"PM_MAINT_Transform". 

8. The tag "@ASSET_EXPORT_FINISHED" is configured as a trigger for the script. To do 
so, select the menu command "Options > Info / Trigger". The "Properties" dialog box is 
opened. Change to the "Trigger" tab. Select the "Tag" entry in the navigation window and 
click "Add". The "Add trigger" dialog box opens. Enter the name 
"@ASSET_EXPORT_FINISHED" in the "Tag name" field. Click "Add" in order to add the 
tag to the "trigger name" table. You can alternatively use the "..." button to open a 
selection dialog and select the tag from it.  
Close the dialog box by clicking "OK". 

9. Close the "Properties" dialog box by clicking "OK". Save the action by using the menu 
command "File > Save". 

10. Close the VBS Editor by using the menu command "File > Exit". 
11. Stylesheets are furthermore required for the format of the data in the export file.  

The files "PM_MAINT_cax.xsl" and "PM_MAINT_workflow.xsl" are supplied as examples 
of stylesheets on the DVD of the SIMATIC Maintenance Station in the directory 
"Additional_Products/PM-MAINT_Integration/Stylesheets" . In the Windows Explorer copy 
these files into the directory "<wincc_project_name> / AssetExport / Stylesheets" that you 
created in step 2. 
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Result 
The required configurations specified in the introduction for the data export to PM-MAINT 
have been implemented.  

 

 Note 
If you use the example script, no additional directories have to be created manually. The 
subdirectories configured in the example script and in the optional tag 
"@ASSET_EXPORT_<n>_DIR" are created automatically when the script is started for the 
first time. 

 

See also 
Creating tags for exporting the maintenance data (Page 160) 
Example script for the data export to PM-MAINT  (Page 170) 
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5.9.6 Importing the plant hierarchy into PM-MAINT 

Introduction 
To transfer the plant hierarchy of the components being used to PM-MAINT, the CAx data 
need to be exported in the SIMATIC Manager and imported into PM-MAINT. 

Procedure 
1. Export the CAx data from the SIMATIC Manager. To do this, select the project folder from 

the SIMATIC Manager, followed by "Options >CAx data > Export...". The "Export CAx 
data" dialog box opens. 

2. Select the target folder in the field of the same name. 
3. The table displays the stations whose data can be exported. Check the selection. 
4. Start the export process by clicking the "Export" button. In the target folder, an XML file is 

created for each station selected. Once the process is complete, the table will display the 
status for each station exported. 

5. Close the dialog box by clicking "Close". 
6. In Windows Explorer, copy the "CAX2PM-Maint.vbs" script from the 

"Additional_Products\PM-MAINT_integration\Scripts\" folder on the Maintenance Station 
product DVD to your local hard drive. 

7. Adapt the paths in the local copy of the "CAX2PM-Maint.vbs" script. 
8. Execute the script to convert the CAx data into PM-MAINT format and import them into 

PM-MAINT. 

Result 
The plant hierarchy of the components being used is imported into PM-MAINT.  
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5.9.7 Example script for the data export to PM-MAINT 

Overview 
The following global script can be used to export data of an individual component for PM-
MAINT:  

 

 Note 
Before using the example script, check the file names and path specifications configured in it 
against the real directory structure of the PC that is used and adapt them if necessary. 

 
The following files and directories are used in this script: 
● The directory "<WinCC_project_directory> / AssetExport / PM_MAINT_Export_DIR / 

OUT".  
The directory is created automatically when the script is started for the first time. 

● The stylesheets "PM_MAINT_cax.xsl" and "PM_MAINT_workflow.xsl" in the directory 
"<WinCC_project_directory> / AssetExport / Stylesheet".  
The stylesheets are also supplied on the DVD of the SIMATIC Maintenance Station in the 
directory "Additional_Products/PM-MAINT_integration/Stylesheets". 

 
For additional information about using the example script please refer to the topic 
"Configuring the data export for PM-MAINT".  
The example script is supplied on the DVD of the SIMATIC Maintenance Station in the 
directory "Additional_Products/PM-MAINT_integration/Scripts". 
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Example 
Option Explicit 
Function action 
 
' FilesystemObject doc: http://msdn2.microsoft.com/en-
us/library/hww8txat.aspx 
' Files Object doc: http://msdn2.microsoft.com/en-
us/library/18b41306.aspx 
' Folder Object doc: http://msdn2.microsoft.com/en-
us/library/1c87day3.aspx 
 
Dim ExportTarget 
 
 
Dim fso 
Dim folder 
Dim fc 
Dim f1 
 
Dim a 
'a = 1 / 0 
 
 
' Load XSL Stylesheet 
Dim xsl  
Set xsl = CreateObject("MSXML2.DOMDocument.3.0") 
xsl.async = false 
xsl.load(HMIRuntime.ActiveProject.Path & 
"\AssetExport\Stylesheet\PM_MAINT_workflow.xsl") 
 
 
Set fso = CreateObject("scripting.filesystemobject") 
Set folder = fso.GetFolder(HMIRuntime.ActiveProject.Path & 
"\AssetExport\PM_MAINT_Export_DIR\Out\") 
Set fc = folder.Files 
 
'On Error Resume Next 
 
For Each f1 In fc 
    If Right(f1.name, 4) = ".xml" Then 
 
        'debug script for Interlink.dll 
        Dim il 
        Dim job 
        Dim xmlfile 
        Dim MessageText 
 
        xmlfile = f1.Path 'the chosen XML file 
 

http://msdn2.microsoft.com/en-us/library/hww8txat.aspx
http://msdn2.microsoft.com/en-us/library/18b41306.aspx
http://msdn2.microsoft.com/en-us/library/1c87day3.aspx
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'''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''' 
        Dim objXML 
        'Set objXML = CreateObject("MSXML2.DOMDocument.6.0") 
        Set objXML = CreateObject("MSXML2.DOMDocument.3.0") ' 
delivered with IE 6.0SP1, see http://support.microsoft.com/kb/269238 
 
        '  check Document structure on load 
        objXML.validateOnParse = True 
 
        ' load Document 
        Dim xml 
        Set xml = CreateObject("MSXML2.DOMDocument.3.0") 
        xml.async = False 
        xml.load(xmlfile) 'Load XML file 
 
        Dim destName 
        Dim destFile 
        Dim pos 
        pos = InStrRev(xmlfile, "\", -1, vbTextCompare) 
        If pos > 0 Then 
            pos = InStrRev(xmlfile, "\", pos - 1, vbTextCompare) 
            If pos > 0 Then 
                'Destination Directory for PM Maint Import Path  
                destName = 
"\\<Destination_PC>\<PM_MAINT_ImportPath>\" & f1.name 
 
        '        destName = Left(xmlfile, pos) & "out2\" & f1.name 
 
                ' Transform 
                Set destFile = fso.CreateTextFile(destName, True, 
False) 
                destFile.Write(xml.transformNode(xsl)) 
                Set destFile = Nothing  
 
                ' save to new file 
 
            End if 
        End if 
 
 
 
 

http://support.microsoft.com/kb/269238
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'''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''' 
 
        ' rename file to prohibit processing the same file again 
        fso.MoveFile f1.Path, f1.Path & ".bak" 
    End if 
Next 
 
 
End Function 

 

See also 
Configuring the data export for PM-MAINT  (Page 166) 
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5.9.8 Overview of the data export for the Alarm Control Center 

Introduction 
The SIMATIC WinCC add-on "Alarm Control Center (ACC)" sends WinCC messages fully 
automatically to a variety of possible receivers such as text messages to mobile phones, 
pagers, language output to phone, e-mail, LAN message to PC, PDA or Webpad (MOBIC).  
The modular Alarm Control Center and the available options allow individual adaptation to 
the requirements - from a stand-alone solution to company-wide communication solutions. 
Additional functions are:  
● Integrated shift and person management for time-dependent delivery of messages to 

different persons. 
● Extensive escalation system for reliable delivery of messages even when individual 

receivers cannot be reached. 
● Network-wide operation and configuration through Web capability. 

Overview 
The messages of the SIMATIC Maintenance Station for diagnostics, operator actions and 
maintenance demands of an individual component can be passed on to the Alarm Control 
Center. The Alarm Control Center then sends these messages fully automatically to various 
receivers such as the maintenance personnel.  

Configuration 
● The following tags are created for the "Alarm Control Center" export target in WinCC: 

– "@ASSET_EXPORT_<n>_NAME".  
The name of the export target is specified as the start value of the tag, for example, 
"ACC_Export". 

– "@ASSET_EXPORT_FINISHED" 
The tag serves as the trigger for executing a global script. 

● The export file is stored in the default path "<WinCC_project_directory> / AssetExport". A 
subdirectory for this default path can optionally be defined by using the tag 
"@ASSET_EXPORT_<n>_DIR", for example, "ACC_Export". 

● A global script is defined by the user for transferring the data to Alarm Control Center. An 
example script is supplied on the DVD of the Maintenance Station and is described in the 
topic "Example script for the export to Alarm Control Center".  
The global script is inserted under VBS Editor in the WinCC editor "Global Script".  
The tag "@ASSET_EXPORT_FINISHED" is configured as a trigger for the global script. 

● Similarly, the license number of the Alarm Control Center is configured in an XML file in 
the Maintenance Station for data transmission. 
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Exporting the data 
Exporting of the data to Alarm Control Center is carried out by the user in the diagnostics 
faceplate in the "Maintenance" view. The export is not carried out automatically.  
The export target is selected in the "Request via" field and the export started by using the 
"Execute" button.  
The export file is stored by the example script in the subdirectory "OUT" under the 
configured export directory. 

Integration of the data in the Alarm Control Center 
For more detailed information about integrating data in Alarm Control Center, please refer to 
the Alarm Control Center documentation.  
Configuration in the Alarm Control Center  
The following points have to be observed at the configuration in the Alarm Control Center:  
● The coupling agent "OpenInterface" with "ACC Open Interface Runtime license (CAL)" is 

required. 
● The send channel "ACC LAN Message" is preferred. The router must have been set up. 
● The "Administrator" user must be set up for the channel "ACC LAN Message". Set 

"localhost" as the phone number. 

Use in case of distributed systems 
If the SIMATIC Maintenance Station is used as a distributed system, the ACC agent must be 
installed on the Maintenance Station Server.  
The Alarm Control Center server can be installed on a different PC.  

See also 
Introduction to exporting the data of an individual component (Page 153) 
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5.9.9 Configuring the data export for Alarm Control Center 

Introduction 
The following section describes the configurations for the data export to the Alarm Control 
Center "ACC":  
● Creating the export directory. 
● Integration of the example script in WinCC. 
● Configuration of the trigger for the example script. 
The example script from the topic "Example script for the data export to Alarm Control 
Center" is used to this purpose. The example script is also supplied on the DVD of the 
SIMATIC Maintenance Station in the directory "Additional_Products / ACC_integration / 
Scripts".  

 

 Note 
Before using the example script check the file names and path specifications configured in it 
against the real directory structure of the PC that is used and adapt them if necessary. 

 

Requirements 
The following tags are used for the "Alarm Control Center" export target and have to be 
created in WinCC: 
● "@ASSET_EXPORT_<n>_NAME".  

The name of the export target is defined as the start value of the tag. The example script 
uses "ACC_Export". 

● "@ASSET_EXPORT_FINISHED" 
The tag serves as the trigger for executing a global script. 

● "@ASSET_EXPORT_<n>_DIR"  
The tag can be used optionally and specifies the subdirectory of the default path 
"<WinCC_project_directory> / AssetExport" in which the export file is to be stored. The 
directory name is specified as the start value. The example script uses "ACC_Export". 

For additional information on creating tags, please refer to "Creating tags for exporting the 
maintenance data (Page 160)".  
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Procedure 
1. In the Windows Explorer navigate in the navigation window to the directory of the WinCC 

project of the Maintenance Station. By default the WinCC project lies in the directory of 
the corresponding S7 project in the subdirectory "wincproj / <wincc_project_name>". 

2. Create a new subdirectory called "AssetExport". 
3. Change to the subdirectory "wincproj / <wincc_project_name>" and open the WinCC 

project of the Maintenance Station by double-clicking the file 
"<wincc_project_name>.mcp". The WinCC Explorer opens. 

4. Select the entry "Global Script" in the navigation window. Open the shortcut menu and 
select the "Open VBS Editor" command. 

5. In the navigation window of the VBS Editor select the "Actions" tab. Click in the tab and 
select the menu command "New > Action" in the shortcut menu. 

6. Copy the code of the example script from the topic "Example script for the data export to 
Alarm Control Center" and insert it into the new action between the code lines "Function 
action" and "End Function". Check that these code lines do not exist double after being 
inserted. 

7. Save the action by using the menu command "File > Save". Since this is a new action, 
the "Save As" dialog box opens. Enter the name of the action, for example 
"ACC_Send_Messages". 

8. The tag "@ASSET_EXPORT_FINISHED" is configured as a trigger for the script. To do 
so, select the menu command "Options > Info / Trigger". The "Properties" dialog box is 
opened. Change to the "Trigger" tab. Select the "Tag" entry in the navigation window and 
click "Add". The "Add trigger" dialog box opens. Enter the name 
"@ASSET_EXPORT_FINISHED" in the "Tag name" field. Click "Add" in order to add the 
tag to the "trigger name" table. You can alternatively use the "..." button to open a 
selection dialog and select the tag from it.  
Close the dialog box by clicking "OK". 

9. Close the "Properties" dialog box by clicking "OK". Save the action by using the menu 
command "File > Save". 

10. Close the VBS Editor by using the menu command "File > Exit". 

Result 
The required configurations specified in the introduction for the data export to Alarm Control 
Center have been implemented.  

 

 Note 
If you use the example script, no additional directories have to be created manually. The 
subdirectories configured in the example script and in the optional tag 
"@ASSET_EXPORT_<n>_DIR" are created automatically when the script is started for the 
first time. 
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5.9.10 Configuring the license number of the Alarm Control Center for the export function 

Introduction 
The license number of the Alarm Control Center "ACC" is required as a parameter in the 
export file when exporting individual items. As a result, the license number must be called in 
the "ACC", and configured in the "logininfo.xml" file in the Maintenance Station.  
By way of example, the "logininfo.xml" file is also supplied on the DVD of the SIMATIC 
Maintenance Station in the directory "Additional_Products / ACC_integration / LoginInfo".  

Requirements 
● The license number of the Alarm Control Center is known.  

You can find the license number in the "System overview" of the Alarm Control Center in 
the "OpenInterface" entry under "Coupling agents". 

Procedure 
1. In Windows Explorer, navigate to the DVD of the SIMATIC Maintenance Station where 

you will find the directory "Additional_Products / ACC_integration / LoginInfo". 
2. Copy the subdirectory "ACC" from the DVD, as a subdirectory, to the local WinCC project 

directory of the Maintenance Station under "<wincc_project_name>".  
By default the WinCC project lies in the directory of the corresponding S7 project in the 
subdirectory "wincproj / <wincc_project_name>".  
This "<wincc_project_name> / ACC" path for the XML file is used in the example script. 

3. Open the "logininfo.xml" file using an XML editor such as Windows Notepad. 
4. Enter the license number of the Alarm Control Center under the "<License>" parameter. 

The format in the example file has been preselected. 
5. Save the file and exit the editor. 

Result 
The license number of the Alarm Control Center is configured for exporting individual items.  
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5.9.11 Example script for exporting data to the Alarm Control Center 

Overview 
The following global script can be used to export data of an individual component for the 
Alarm Control Center.  

 

 Note 
Before using the example script, check the file names and path specifications configured in it 
against the real directory structure of the PC that is used and adapt them if necessary. 

 
The following files and directories are used in this script: 
● The directory "<WinCC_project_directory> / AssetExport / ACC_Export".  

The directory is created automatically when the script is started for the first time.  
The "OUT" subdirectory is also created at this point. 
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For additional information about using the example script, please refer to the topic 
"Configuring the data export for Alarm Control Center".  
The example script is supplied on the DVD of the SIMATIC Maintenance Station in the 
directory "Additional_Products / ACC_integration / Scripts". 
 
Example 
Option Explicit 
Function action 
 
' FilesystemObject doc: http://msdn2.microsoft.com/en-
us/library/hww8txat.aspx 
' Files Object doc: http://msdn2.microsoft.com/en-
us/library/18b41306.aspx 
' Folder Object doc: http://msdn2.microsoft.com/en-
us/library/1c87day3.aspx 
 
Dim ExportTarget 
Dim ServiceUnit 
Dim loginInfoPath 
ServiceUnit = "9999" 
ExportTarget = "ACC_Export" 
LoginInfoPath = HMIRuntime.ActiveProject.Path & "\ACC\logininfo.xml" 
 
Dim fso 
Dim folder 
Dim fc 
Dim f1 
 
' activate debugger 
Dim a 
'a = 1 / 0 
 
 
Set fso = CreateObject("scripting.filesystemobject") 
Set folder = fso.GetFolder(HMIRuntime.ActiveProject.Path & 
"\AssetExport\" & ExportTarget & "\Out\") 
Set fc = folder.Files 
 
On Error Resume Next 
 
For Each f1 In fc 
    If Right(f1.name, 4) = ".xml" Then 
 
        'debug script for Interlink.dll 
        Dim il 
        Dim job 
        Dim xmlfile 
        Dim MessageText 
 
        xmlfile = f1.Path 
 
 
        If Len(ServiceUnit) <= 0 Then ServiceUnit = "9999" 
 

http://msdn2.microsoft.com/en-us
http://msdn2.microsoft.com/en-us
http://msdn2.microsoft.com/en-us/Dim
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'''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''' 
        Dim objXML 
        'Set objXML = CreateObject("MSXML2.DOMDocument.6.0") 
        Set objXML = CreateObject("MSXML2.DOMDocument.3.0") ' 
delivered with IE 6.0SP1, see http://support.microsoft.com/kb/269238 
 
        ' check structure of document while loading 
        objXML.validateOnParse = True 
 
        ' load document 
        If Not objXML.Load(xmlfile) Then 
            ' Error while loading 
            HMIRuntime.Trace "Error while loading document." & 
vbCrLf & vbCrLf _ 
            & "Reason: " & objXML.parseError.reason & vbCrLf _ 
            & "Line: " & objXML.parseError.Line 
            Exit Function 
        Else 
            Dim child 
 
            MessageText = "Maintenance Request: " 
 
            Set child = 
objXml.documentElement.selectSingleNode("/Document/b2mml:EquipmentIn
formation/b2mml:Equipment/b2mml:EquipmentProperty/b2mml:Value/b2mml:
ValueString[../b2mml:Key='Name']") 
            MessageText = MessageText & " Tag=" & child.text 
            'HMIRuntime.Trace child.NodeName & " = " & child.text & 
vbNewLine 
 
            Set child = 
objXml.documentElement.selectSingleNode("/Document/b2mml:Maintenance
Information/b2mml:MaintenanceRequest/b2mml:Problem") 
            MessageText = MessageText & " / Problem=" & child.text 
 
            Set child = 
objXml.documentElement.selectSingleNode("/Document/b2mml:Maintenance
Information/b2mml:MaintenanceRequest/b2mml:Requestor") 
            MessageText = MessageText & " / Requestor=" & child.text 
 
            Set child = 
objXml.documentElement.selectSingleNode("/Document/b2mml:Maintenance
Information/b2mml:MaintenanceRequest/b2mml:Status") 
            MessageText = MessageText & " / Status=" & child.text 
            HMIRuntime.Trace "MessageText = " & MessageText & 
vbNewLine 
        End If 
 

http://support.microsoft.com/kb/269238
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'''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''' 
 
        'Create and initialize Interlink and Job helper objects 
        Set il = HMIRuntime.DataSet("il").Value 
        'Set job = HMIRuntime.DataSet("job").Value ' always create a 
new job object 
 
        If IsEmpty(il) Then 
            Set il = CreateObject("FSP3Interlink.Interlink") 
 
            'Load login info from File 
            Dim file 
            Dim logininfo 
            Set file = fso.OpenTextFile(LoginInfoPath) 
            loginInfo = file.ReadAll() 
 
            'chose connection method (default is dcom) 
            Dim ComputerName 
            Set ComputerName = HMIRuntime.Tags("@LocalMachineName") 
            'Set ComputerName = HMIRuntime.Tags("@ServerName") 
            ComputerName.Read 
            'il.AddGateway "tcp://localhost", 5, loginInfo, nothing, 
false 
            'il.AddGateway "soap://FSP3SERVER/fsp3", 5, loginInfo, 
nothing, false 
            'il.AddGateway "dcom://" & ComputerName.Value, 5, 
loginInfo, Nothing, False 
            il.AddGateway "dcom://localhost", 5, loginInfo, Nothing, 
False 
 
            HMIRuntime.DataSet.Add "il", il 
        End If 
 
        If IsEmpty(job) Then 
            Set job = CreateObject("FSP3Interlink.Job") 
            HMIRuntime.DataSet.Add "job", job 
        End If 
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        'Prepare Job object 
        job.MsgText = MessageText 
        job.AddAlarmGroupToCall(ServiceUnit) 
 
        'Submit Job 
        Dim sHost 
        Dim sJobID 
        sHost = "" 
        sJobID = il.SubmitJob("", "", job, sHost) 
 
        HMIRuntime.DataSet.Add "host", sHost 
        HMIRuntime.DataSet.Add "jobid", sJobID 
 
        ' rename file to prohibit processing the same file again 
        fso.MoveFile f1.Path, f1.Path & ".bak" 
    End If 
Next 
 
 
End Function 

 

See also 
Configuring the data export for Alarm Control Center (Page 176) 
Configuring the license number of the Alarm Control Center for the export function 
(Page 178) 
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Working with SIMATIC Maintenance Station 6
6.1 Overview of diagnostics and maintenance using the maintenance 

station 

Overview of diagnostics and maintenance  
This chapter describes diagnostics and maintenance functionality of 
SIMATIC Maintenance Station. 

Starting the Maintenance Station 
Activate WinCC on the PC used to run the Maintenance Station diagnostics functions. The 
user must log in to access the diagnostics functions.  

Layout of the diagnostics screens 
The diagnostics screens are output with a user interface which is split into three areas. The 
user interface features static and dynamic control elements and displays.  

Control elements for diagnostics 
The user interface of the Maintenance Station provides various control elements and 
displays. These are used to navigate in the hierarchy of diagnostics screens and to execute 
specific functions in the overview area and in the toolbar.  

General diagnostics 
This chapter describes the basic diagnostics procedures and options.  

Diagnostics of AS, PC stations and network components  
The next three chapters, i.e. the "AS objects", "PC stations" and "Network components" 
sections, are focused on the description of directed component diagnostics.  
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Maintenance requests and status management 
In Maintenance Station diagnostics, the maintenance requests for components concerned 
are displayed with different priorities. The user can check the maintenance request and 
initiate an appropriate maintenance task. The status of the maintenance task is managed on 
the diagnostics faceplate.  

Additional topics in this chapter  
● Exporting component data 
● Diagnostics status of redundant components 
● Changeover between SIMATIC Maintenance Station and PCS 7 Maintenance Station. 
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6.2 Starting the maintenance station 

Introduction 
The Maintenance Station is ready for operation upon conclusion of engineering.  

Requirements 
● Hardware configuration data in the S7 project are up-to-date, compiled and downloaded 

to the AS. In order to visualize diagnostics data of the Maintenance Station on a PC and 
use the "Loop-in-HW-Config" function, the S7 project must be copied from the S7 ES to 
this PC.  

● You created or updated the diagnostics screens and downloaded these to the WinCC 
project of the Maintenance Station. 

● Configure the interconnections between the process screens and the Maintenance 
Station user interface when the Maintenance Station is integrated in an existing WinCC 
project. The user rights of previously configured users must be adapted to enable user 
access to diagnostics functions. 

Procedure 
1. Open the WinCC project on the Maintenance Station or, in distributed systems, on the 

Maintenance Station Client.  
Open the WinCC project in which you have integrated the Maintenance Station. 

2. Click the "Activate" toolbar button to activate the WinCC project. 
3. The login dialog opens after startup of the WinCC project. Log on using one of the 

configured user names.  
The previous user accounts remain valid when the Maintenance Station is integrated in 
an existing WinCC project. 

4. The Maintenance Station user interface opens and is ready for diagnostics after the user 
is logged in.  
The Maintenance Station in the existing WinCC project initially starts with the current user 
interface and the process screens. You can use the configured links to change to the 
Maintenance Station user interface and to return to the process screens when diagnostics 
is completed. 

Result 
The Maintenance Station is active.  
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6.3 Structure of the diagnostics screens 

Introduction 
Diagnostics data are visualized on the overview and diagnostics screens of SIMATIC 
Maintenance Station. The diagnostics screens are automatically generated and allocated to 
the hierarchy in the course of engineering.  

Layout of the diagnostics screens 
The overview and diagnostics screens have a uniform layout and are divided into different 
areas: 
● Overview area 
● Working area 
● Toolbar 
The areas are determined by the configuration.  

�

�

� 
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① Overview area 
② Working area 
③ Toolbar 

Overview area (1) 
The overview area is displayed permanently. Its group displays for the various plant units 
and the message bar provide an overview of the entire system. The operator can refer to the 
group displays, the area selection buttons and to various toolbar buttons to react to the 
displayed status.  
Each plant area is represented by an area selection button and a group display. The area 
selection button is used to jump directly to the diagnostics screen at root level of the screen 
hierarchy of this plant area. When an active message is indicated, the operator can use the 
group display to change directly to the diagnostics screen which shows the originating 
message.  
Picture Tree Navigator is an additional tool for navigation in the screen hierarchy. 

Working area (2)  
The working area is used to visualize the overview and diagnostics screens of individual 
components for diagnostics. It can also be used to visualize process screens of a WinCC 
project which is integrated in the Maintenance Station and used for operating and 
monitoring. The process screens must also be managed in WinCC Picture Tree Manager. 
The working area also outputs the faceplates, control windows, message lists or dialog 
boxes called by the operator. 

Toolbar (3) 
The permanently shown toolbar consists of two button sets which can be toggled by the 
user. These toolbar sets contain various functions which can be used, for example, for 
navigation in the screen hierarchy, or to call process screens and dialogs.  

 

 Note 
The content of the button sets depends on the configuration of the Maintenance Station. 
Certain buttons mentioned in this documentation may be deactivated or may not be available 
in the actual diagnostics screens of the Maintenance Station.  
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6.4 Control elements for diagnostics 

6.4.1 Overview of control elements in the diagnostics screens 

Introduction 
This chapter provides an overview of various control options such as navigation which are 
available in the diagnostics screens of the Maintenance Station.  

 

 Note 
Component diagnostics and the management of maintenance tasks are described in 
separate chapters.  

 

Overview of control elements in the diagnostics screens 
The control elements are allocated to the various areas of the user interface.  

Overview area 
The overview area returns a compact view of the plant status and provides various control 
elements and functions: 
● The "Loop-in-Alarm" function: Jump to the diagnostics screen which outputs the cause of 

the message.  
● User navigation in the screen hierarchy using Picture Tree Navigator. 
● Operating the group displays. 
● Control elements of the overview area which can be used, for example, to acknowledge 

active messages or to start Picture Tree Navigator. 
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Working area 
The working area is used to visualize process and diagnostics screens and to perform 
component diagnostics.  
● Navigation 
Users can navigate in the hierarchy levels using either Picture Tree Navigator, or the toolbar 
icons. The diagnostics screens of the working area allow easy navigation.  
The diagnostics status displays can be used, for example, to change from higher-level 
screens such as overview screens to screens of the sublevel hierarchy. You navigate to 
higher levels in the hierarchy using the toolbar buttons, the Picture Tree Navigator or the 
control elements of the overview area.  
● Action 
An action is enabled when the mouse pointer is transformed into a lightning bitmap after 
having been positioned on the symbol of the component. A diagnostics faceplate can be 
opened, for example, using the MaintenanceStateDisplay "MSD". The 
MaintenanceGroupDisplay "MGD" can be used to change directly from a sublevel 
diagnostics screen to a corresponding diagnostics screen when a diagnostics message is 
active. If several messages are active in different screens, the program jumps to the next 
higher level.  
● Additional functions 

The functions outlined below are integrated in the overview screen. 

– The "Export" function : 
This function, the so-called complete export, is used to export all the component data. 
These may be offline configuration data of an S7 project or, if available, online data.  
For additional information on the complete export function, please refer to the sections 
"Complete export of component data  (Page 152)" and "Starting the complete export 
of the component data (Page 229)". 
The "Enable for area" authorization for the diagnostics area is required in WinCC for 
executing the function.  
The so-called individual export is furthermore available for exporting the data of an 
individual component. For additional information, please refer to "Introduction to 
exporting the data of an individual component (Page 153)".  

– "Message correction" :  
This function checks for inconsistency between active messages and the current plant 
configuration.  
You may not be able to acknowledge messages which remain active when you 
replace defective components. This scenario may develop when the component name 
has changed, for example, the computer name in Windows. 
The "Message correction" checks for this inconsistency and automatically corrects it.  
Activation of a button triggers a control message.  
The "Enable for area" and "Advanced process operations" authorizations for the 
diagnostics area are required in WinCC for the execution of the function. 

Toolbar 
The toolbar sets contain various control functions, for example, for navigating in the screen 
hierarchy or for selecting screens or dialogs. System functions such as language changes 
are also integrated.  
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6.4.2 Control elements of the overview area 

Control elements of the overview area 
The overview area returns a constant overview of the plant status. The various control 
elements allow the operator to react to changes indicated.  
The message bar outputs the active message, however, without offering any control 
elements.  

 
Symbol / element Functionality 

 
Extended message line 

Opens the extended message bar. All incoming messages are output 
in list format to the message window of the working area.  

 
"Loop-in-alarm" function 

This function triggers a change to the diagnostics screen showing the 
cause of an active message.  

 
Message acknowledgment 
button 

Acknowledges the message shown in the message bar of the 
overview screen. 

 
Area selection button 

Outputs the root process screen or diagnostics screen of this plant 
area to the working area.  
The range selection button is active if shown with black letters on a 
gray background.  
The cyan background color indicates that a process or diagnostics 
screen of the corresponding plant area is already shown on the 
working area.  

 
Group display 

Shows the plant status of the corresponding area in compact format. 
Any button of the group display indicating an active message can be 
used to change pictures. This element is used to view the process or 
diagnostics screen which indicates the cause of the message.  

 
Picture Tree Navigator 

Opens the Picture Tree Navigator for navigation in the hierarchy of 
process and diagnostics screens.  

 
Screen dump 

Outputs the active screen content to the default printer of the 
computer. 

 
Logged on user 

Displays the name of the logged on user. The login dialog for 
changing the user is opened by clicking in this field.  
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6.4.3 Operating the group displays 

Introduction 
A group display outputs a summary of the status of diagnostics messages.  
● The overview area is used to output a group display for the "Diagnostics" plant area and 

for the entire sublevel hierarchy. 
● Picture Tree Navigator always returns the status of a group display for a specific area or 

for the diagnostics screen. The status of the sublevel hierarchy is always integrated in 
this case. 

The group display allows the change to the diagnostics screen which indicates the message 
event. If several messages are active the function always outputs the diagnostics screen 
which contains all events.  
The jump function is available for all messages signaled, i.e. for new messages, and for 
acknowledged messages which have not been cleared yet.  

Requirements 
The group display signals an active diagnostics message by highlighting a button. 

Procedure 
1. On the overview area, click the middle one of the five buttons of the group display of the 

"Diagnostics" area. 

 

Result 
The diagnostics screen which contains the message event is output to the working area.  
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6.4.4 Triggering the "Loop-in-Alarm" function 

Introduction 
The "Loop-in-Alarm" function can be used to trigger a change to the diagnostics screen 
which contains the message event.  

The "Loop-in-Alarm"  icon is available at the following locations:  
● On the left of the message bar of the overview area. 
● On the message list toolbar. 
This function always relates to the message which is indicated or which is selected from the 
message list. The component faceplate is opened on the working area if it is not possible to 
assign this message a specific diagnostics screen. 
The assignment of components to the diagnostics screen is configured in the block list editor 
of WinCC. Assignments are not possible within the active process. 

Requirements 
● A message is output to the message bar of the overview area or to the message list.  

This function is not supported for system messages. 
● The message is configured for the function. The "Loop-in-Alarm" column must be set in 

the message in WinCC Alarm Logging. The component must be assigned a start screen 
in the WinCC block list Editor. 

Procedure 

1. Click  on the overview area to the left of the message bar. The program changes the 
screen. 

Result 
The diagnostics screen which indicates the message event is output to the working area. 
The component for which the message is output to the message bar is highlighted in cyan 
color. 

The "previous screen"  icon of toolbar set 1 is used to return to the previously selected 
diagnostics screen.  
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6.4.5 Navigating with Picture Tree Navigator 

Introduction 
Picture Tree Navigator is used to navigate in the hierarchy of process and diagnostics 
screens. The navigator returns a clear graphical view of the hierarchy.  
Picture Tree Navigator lets you select and visualize specific screens.  
Picture Tree Navigator can be moved or remain open permanently on the working area.  

 
 

Requirements 
● The diagnostics screens return the actual status of the configuration. 
● "WinCC OS Project Editor" was executed in the WinCC project. 

Procedure 
1. In the overview area, click the  icon next to the required plant area. Picture Tree 

Navigator opens on the working area. 
2. Expand or reduce the directory structure by clicking the "+" or "-" character to the left of 

the area or screen name. The group displays to the right of the area and screen names 
return the current state and indicate messages which are active in the diagnostics 
screens or in their sublevel hierarchy. Right-click the group display in Picture Tree 
Navigator to view the name of the screen from which the message originates. Left-click 
the group display button to view the screen showing the message event. 

3. Navigate to the required area or screen name in the tree structure and then click it. The 
corresponding process or diagnostics screen is output. 

4. You can view further screens when diagnostics of the current process / diagnostics 
screen is completed. Click the corresponding name or group display in Picture Tree 
Navigator. 

Result 
The required process or diagnostics screen is output to the working area by navigating in the 
tree structure or using an element of the group display.  
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6.4.6 Control elements of the toolbar sets and of the message system 

Control elements of the toolbar sets 1 and 2  
The "Symbol" column contains the symbol with the short info as shown in both toolbar sets.  
The user rights required to execute this function are defined in the "Authorization required" 
column. User rights are managed and assigned in the WinCC "User Administrator".  

 
Symbol Function Authorization 

required  
Toolbar set 1 

 

Change to toolbar set 2 

Shows button set 2 on the toolbar. 
Toolbar set 1 is displayed by default.  

None 

 

Password 

Opens the default "System Login" dialog box on the working area for user 
login or change.  
The "SIMATIC Logon Service" dialog is output if SIMATIC Logon is 
deployed in the process control system.  

System change 

 

Message system 

Opens the message system and outputs the new messages list to the 
working area. The new events list shows messages that were not 
acknowledged yet. A special toolbar set is displayed when the message 
system is open. The function is described below. 

Enable for area 

 

Log files 

Opens the "Log files" dialog box with an overview of all log files.  
The dialog box is output to the foreground of the working area and overlays 
the process and diagnostics screens shown. The size and position can be 
modified.  

Enable for area 

 

Call /  
merge trend groups 

Opens the "Call / merge trend groups" system dialog for the visualization of 
the trends of selected process values.  
This function is not supported in SIMATIC Maintenance Station and the 
button is not shown for this reason.  
This function is supported when you integrate the diagnostics functions for 
PCS 7 and S7 projects and run these functions on a PCS 7 Maintenance 
Station Client.  

Enable for area 

 

Screen selection by 
process tag 

Opens the "Screen selection by process tag" system dialog.  
This function is not supported in SIMATIC Maintenance Station and the 
button is not shown for this reason.  
This function is supported when you integrate the diagnostics functions for 
PCS 7 and S7 projects and run these functions on a PCS 7 Maintenance 
Station Client.  

Enable for area 

 

Screen selection by 
name 

Opens the "Select screen by name" system dialog.  
The dialog box is output to the foreground of the working area and overlays 
the process and diagnostics screens shown. The size and position can be 
modified. 

Enable for area 
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Symbol Function Authorization 
required  

 

Screen left 

Visualizes the process or diagnostics screens which is located on the same 
hierarchy level to the left of the currently output process or diagnostics 
screen.  
This function is used to navigate in the hierarchy and to view the process or 
diagnostics screens.  

None 

 
 
Screen up 

Visualizes the process or diagnostics screens which is located on the next 
higher hierarchy level to the currently output process or diagnostics screen. 
This function is used to navigate in the hierarchy and to view the process or 
diagnostics screens. 

None 

 

Detail screen 

Visualizes the process or diagnostics screens which is located on the next 
lower hierarchy level to the currently output process or diagnostics screen. 
This function is used to navigate in the hierarchy and to view the process or 
diagnostics screens. 

None 

 

 
Screen right 

Visualizes the process or diagnostics screens which is located on the same 
hierarchy level to the right of the currently output process or diagnostics 
screen.  
This function is used to navigate in the hierarchy and to view the process or 
diagnostics screens. 

None 

 

Previous screen 

Outputs the recently viewed process or diagnostics screen to the working 
area. 

None 

 

Save screen 

Saves the process or diagnostics screen which is currently active on the 
working area. 
The saved screen can be called again using the "Restore screen" function. 

None 

 

Restore screen 

Calls the process or diagnostics screen you previously saved using the 
"Save screen" function.  

None 

 

Restore composition 

Opens the "restore composition" system dialog on the working area. You 
can change the position but not the size of this dialog box. 
The dialog outputs a selection of the screen composition previously saved 
using the "Save composition" function. Screen compositions are assigned 
and only made available to the logged on user. 

Enable for area 

 

Save composition 

Opens the "Save composition" system dialog on the working area. You can 
change the position but not the size of this dialog box. 
This function is used to save the process or diagnostics screen currently 
output to the working area with a user-specific name.  

Enable for area 
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Symbol Function Authorization 
required  

 

Delete composition 

Opens the "Delete composition" system dialog on the working area. You 
can change the position but not the size of this dialog box. 
This function is used to delete the process or diagnostics screen the user 
saved with a specific file name. 

Enable for area 

 

System configuration 

Opens the plant configuration screen you configured in the S7 project on 
the PC station or in the WinCC project using the "Lifebeat Monitoring" 
editor. 
This function is used to monitor PC stations and automation systems (AS) 
which can be accessed via PC networks and industrial networks. The 
program displays the operating state of all monitored objects of the active 
process.  

Enable for area 

 

Screen information 

Opens a dialog box on the working area to output information about the 
currently visualized process or diagnostics screen.  
You can change the position but not the size of this dialog box on the 
working area. 

None 

 

 
Acknowledge horn 

Acknowledges the active signal of a signal generator such as a horn. This 
acknowledgment does not include the triggering message. 
This function is also available in toolbar set 2 and in the message system. 

None 

 

Acknowledge message 

Acknowledges all messages shown in the new events list which is output to 
the working area. This acknowledgment also includes the top priority 
message shown on the message bar of the overview area. 
This function is also available in toolbar set 2. 

None 

 
Toolbar set 2 

 

Change to toolbar set 1 

Toggles toolbar sets 1 and 2. None 

 

Language change 

Opens a dialog box in which you can select the dialog language. 
You can change the position but not the size of this dialog box.  

Monitoring 

 

BATCH Control Center 

Opens the SIMATIC BATCH Control Center application.  
You can only run this application if SIMATIC BATCH is installed and after 
having executed BATCH Start Coordinator. 
This function is irrelevant to SIMATIC Maintenance Station. The button is 
not activated for this reason. 

None 

 

SFC visualization 

Opens the "Open SFC" dialog box on the working area. The toolbar button 
and the help system are only available if the "SFC Visualization" software 
package is installed. 
This function is irrelevant to SIMATIC Maintenance Station. The button is 
not activated for this reason. 

Monitoring 
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Symbol Function Authorization 
required  

 

User authorization 

Opens the "User Administrator" editor.  
User rights are managed and assigned in the "User Administrator" editor. 
All changes to user rights are immediately applied to the process control 
system.  
You can change the size and position of this dialog box. 

User 
administration 

 

Exit runtime 

Opens the "Exit runtime" dialog box. This function closes Runtime on the 
Maintenance Station and of an integrated WinCC system. 

System change 

 

Toolbar control functions of the message system 
 
Symbol Function Authorization 

required 

 

Previous screen 

Exits the message system and returns you to the previously selected process 
screen on the working area.  

None 

 

New list 

Outputs the new events list to the working area. The new events list shows 
messages that were not acknowledged yet. 

Enable for area 

 

Old list 

Shows all acknowledged messages which have not yet been cleared. Enable for area 

 

Outgoing list 

Shows all cleared messages which have not yet been acknowledged. Enable for area 

 

Process control list 

Shows all process control messages of the AS, of field devices, of I/O devices 
and of PC stations.  

Enable for area 

 

Operator list 

Shows all control messages such as control actions in the faceplates. Enable for area 
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Symbol Function Authorization 
required 

 

Chronicle list 

Shows all process control events. Enable for area 

 

Print message 
tracking log 

Prints a chronological message tracking log to the printer. The log is output to 
page- or line-oriented printers. 

Enable for area 

 

Acknowledge horn 

Acknowledges the active signal of a signal generator such as a horn. 
Same function as in toolbar sets 1 and 2. 

None 

 

Acknowledge 
message 

Acknowledges all messages shown in the message list output to the working 
area.  

None 
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6.4.7 Overview of the message list functions 

Introduction 
The maintenance station features diverse toolbar functions for the visualization of entries in 
the message lists.  
Messages are visualized in different lists:  
● In the "Messages" view of the diagnostics faceplate. 
● In the message lists you open using using the toolbar buttons, for example, new events 

list, old events list. 
● Using the "Message system" button on the overview area. 

 

  Note 
The various message list do not always provide all of the functions described, 
for availability depends on user rights configured in the User Administrator. 

Overview of the message list functions 
 

Symbol Function 

 
View message list  

Shows the currently active messages.  

 
View long-term archive list 

Shows the messages saved to the long-term archive list.  

 
Set the selection 

Opens the "Define selection" dialog box. The selection criteria 
for visualization of messages in the message lists is defined in 
this dialog box. All messages which do not match the 
selection criteria are saved but not displayed. 

 
Acknowledging an alarm 

Acknowledges the selected message.  
The selection is indicated by means of a selection triangle.  

 
Acknowledge all visible messages 

Acknowledges all active visible messages in the message 
window that require acknowledgment, unless they require 
separate acknowledgment. 

 
Enable/disable auto-scrolling 

Enables or disables auto-scrolling 
The current message is output at the top edge of the window 
when the auto-scroll function is active. The old messages are 
shifted down in the list. This also represents the default setting 
in OS Project Editor. The message processing functions only 
apply to active messages.  
Manual scrolling using the "View previous message" button is 
disabled, for example.  
If auto-scrolling is disabled, you can select individual 
messages using the mouse. Subsequent message processing 
functions refer to this selected message.  

 
Print message log 

Outputs the message log to a connected printer. All messages 
in the message window are output to the printer. A selection 
dialog box is not displayed. 
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Symbol Function 

 
View first message 

Jumps to the first or oldest message in the message window. 
This function is only available if "Autoscroll" is disabled. 

 
View last message 

Jumps to the last or most recent message in the message 
window. This function is only available if "Autoscroll" is 
disabled. 

 
View next message 

Scrolls one message down in the message window.  
The function is only available if "Autoscroll" is disabled. 

 
View previous message 

Scrolls one message up in the message window.  
The function is only available if "Autoscroll" is disabled. 

 
Message info text 

Opens the "Message info text" dialog box. This dialog box 
returns an info text, provided it exists in the message 
configuration. The "X" entry in the "Info" message column 
indicates whether a message info text is configured. 

 
Message comment 

Opens the "Message comment" dialog box. You can type in a 
comment relating to the message in the "Comment" input box 
of the dialog box. This function is only available in the 
message lists of archived messages, for example, in the 
history list. 

 
Loop-in-Alarm 

This function triggers the change to the diagnostics screen 
showing the cause of an active message. 

 
Sorting 

Opens the "Sort" dialog box. You can set various sorting 
criteria for the output of messages in this dialog box, for 
example, by message blocks or by column headers.  
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6.5 General diagnostics 

6.5.1 Viewing maintenance messages 

Introduction 
The "Messages" view of the diagnostics faceplate returns messages relating to diagnostics, 
operator actions and maintenance requests for this component. The messages can be 
acknowledged and managed in this view.  

Procedure 
1. Select the "Diagnostics" area on the Maintenance Station. The overview screen opens.  

The screen displays the current status of the PC station, network components and AS 
objects areas by means of icons (for example, 

 or ). 
2. In the overview screen, click the MaintenanceGroupDisplay, e.g. 

. 

The display status  indicates an active diagnostics message. The program opens the 
diagnostics screen, which returns the cause of the message.  

When the display has the status , the overview of the AS objects is displayed.  
3. Click a component icon in the MaintenanceStateDisplay of the overview, e.g. 

. The diagnostics faceplate of this component opens. The "Ident" view is output by 
default.  

4. Select the "Messages" entry from the selection box. 
5. The "Messages" view returns the active messages relating to this component. The toolbar 

provides various functions such as message selection and print commands. 

Result 
The diagnostics faceplate outputs component-specific messages relating to diagnostics, 
control actions and maintenance requests. 
For additional information on this topic, please refer to "Overview of the message list 
functions  (Page 201)". 
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6.5.2 Viewing identification data of a component in offline mode 

Introduction 
All available information of the hardware configuration, namely the identification data, are 
visualized on the "Ident" view of the diagnostics faceplate. These data are considered offline 
data, as these do not originate from the actual component, but rather from the HW 
configuration.  

Requirements 
The component is registered in the hardware configuration data of the S7 project.  

Procedure 
1. Select the "Diagnostics" area on the Maintenance Station. The overview screen opens. 
2. Click the MaintenanceGroupDisplay status display in one of the three areas of the 

overview screen, e.g. 

. The corresponding overview, such as the "AS objects overview", opens. 
3. Click a component icon in the MaintenanceStateDisplay of the overview, e.g. 

. The diagnostics faceplate of this component opens.  
4. The "Ident" view is output by default. Select the "Ident" entry from the selection box if the 

view is not opened automatically. 
5. Configuration data are output to the right section of the "Ident" view. Data which are not 

configured do not appear in the corresponding fields. 

Result 
The "Ident" view returns all information of the hardware configuration and the maintenance 
status relevant to the component. The view also returns the status of redundant components 
and the master ID.  
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6.5.3 Viewing identification data of a component in online mode 

Introduction 
Online data originate directly from the component. By contrast to these data, the offline data 
originate from the hardware configuration in the S7 project.  
Both types of data can be visualized in the "Ident" view of a diagnostics faceplate. Online 
data can be identified based on the indication of the data and time of the most recent 
change.  
The corresponding component must support the visualization of online data. 

Requirements 
● The component is registered in the hardware configuration data of the S7 project. 
● The corresponding component must support the visualization of online data. 

Procedure 
1. Select the "Diagnostics" area on the Maintenance Station. The overview screen opens. 
2. Click the MaintenanceGroupDisplay status display in one of the three areas of the 

overview screen, e.g. 

. The corresponding overview, such as the "AS objects overview", opens. 
3. Click a component icon in the MaintenanceStateDisplay of the overview, e.g. 

. The diagnostics faceplate of this component opens.  
4. The "Ident" view is output by default. Select the "Ident" entry from the selection box if the 

view is not opened automatically. 
5. Data are output to the right section of the "Ident" view. Missing or non-configured data do 

not appear in the corresponding fields.  
The view also returns the date of the "Last change". This information is also an indicator 
for the visualization of online data. 

6. You can update the component data displayed by clicking "Update". 

Result 
The "Ident" view returns the online data of the component and the maintenance status. The 
view also returns the status of redundant components and the master ID. 
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6.6 Diagnostics of AS and of sublevel components 

6.6.1 Overview of the diagnostics status of all AS objects 

Introduction 
An overview of the diagnostics status of all AS objects can be obtained from the AS objects 
overview screen.  

Procedure 
1. Click the "Diagnostics" area selection button in the overview area. The Maintenance 

Station overview screen opens. 
2. In the overview area, click the  icon next to the "Diagnostics" area selection button. 

Picture Tree Navigator opens and expands the tree structure down to the overviews. 

 
3. Click "AS objects" in the folder structure of Picture Tree Navigator. The AS objects 

overview opens. 
4. Check the status displays in the component icons, e.g. 

.  
The MaintenanceStateDisplay returns the status of the actual component, e.g.  

.  
The EventState status display is attached to the bottom right of the 
MaintenanceStateDisplay and returns the status of the messages for this component. 
The small red square in our example indicates an active message.  

Result 
The diagnostics status of the AS objects is checked.  
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6.6.2 Diagnostics status of an AS 

Introduction 
You can check the diagnostics status of an AS by opening the AS objects overview on the 
overview screen, or view status details in the diagnostics faceplate.  

Procedure 
1. Click the "Diagnostics" area selection button in the overview area. The Maintenance 

Station overview screen opens. 
2. In the overview area, click the  icon next to the "Diagnostics" area selection button. 

Picture Tree Navigator opens and expands the tree structure down to the overviews. 

 
3. In order to check the overall status of a specific AS and of its sublevel hierarchy, click "AS 

objects" in the tree structure of Picture Tree Navigator. The AS objects overview opens. 
4. To check the diagnostics status of a stand-alone AS, select the AS objects overview, click 

the relevant AS icon (e.g. 

), and then click the MaintenanceStateDisplay in this icon, e.g. 
. 

5. The diagnostics faceplate opens with the "Ident" view. The "Component" area in the left-
hand area of this view displays the status of the actual component, as well as that of any 
existing redundant device. The component data are displayed in the right-hand area. 

6. Check the status views in the upper area of the faceplate. In addition to the component 
status, these views also display the status of requested and initiated maintenance tasks, 
e.g. 

. 
7. Change to the "Messages" view to check the active messages re this component. Use 

the toolbar functions to analyze the message history of this component. 
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8. Change to the "Maintenance" view to check the status. Respond to maintenance requests 
of the system by initiating a maintenance task in this view or by setting the request to 
"Cancel". You can change the request to "In progress" or "Completed" status if a 
maintenance task has already been initiated. 

9. You can open "HW Config" by clicking  in order to check the hardware data of the 
component. SIMATIC STEP 7 must be installed on the PC used to visualize the 
diagnostics data and the S7 project must be available on this PC. 

10. Close the diagnostics faceplate. 

Result 
The diagnostics status of the AS is checked.  
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6.6.3 Diagnostics status of central and expansion racks 

Introduction 
You check the diagnostics status of central and expansion racks on the diagnostics screen 
of the corresponding AS. Status details can be viewed on the diagnostics screens of the 
racks or on the diagnostics faceplates.  

Procedure 
1. Click the "Diagnostics" area selection button in the overview area. The Maintenance 

Station overview screen opens. 
2. In the overview area, click the  icon next to the "Diagnostics" area selection button. 

Picture Tree Navigator opens and expands the tree structure down to the overviews. 
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3. Expand the tree structure of Picture Tree Navigator to view the required AS entry by 
clicking the "+" icons, starting at the "AS objects" entry. Click the AS entry. The program 
displays the diagnostics screen of the AS and the sublevel hierarchy.  
The sample screenshot below shows the central rack, an expansion rack and two 
PROFIBUS DP subsystems. 

 
4. Continue at step 6 to run diagnostics of the actual central and expansion racks. 
5. You can also check the status of individual modules installed in the central and expansion 

racks. Click the MaintenanceGroupDisplay on the corresponding rack icon, e.g. 

. The diagnostics screen for a rack, along with the modules, is displayed.  
6. In the diagnostics screen, click the MaintenanceStateDisplay in the icon of the 

component or module required, e.g. 

. The diagnostics faceplate opens with the "Ident" view. The "Component" area in 
the left-hand area of this view displays the status of the actual component, as well as that 
of any existing redundant device. The component data are displayed in the right-hand 
area.  
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7. Check the status views in the upper area of the faceplate. In addition to the component 
status, these views also display the status of requested and initiated maintenance tasks, 
e.g. 

. 
8. Change to the "Messages" view to check the active messages re this component. Use 

the toolbar functions to analyze the message history of this component. 
9. Change to the "Maintenance" view to check the status. Respond to maintenance requests 

of the system by initiating a maintenance task in this view or by setting the request to 
"Cancel". You can change the request to "In progress" or "Completed" status if a 
maintenance task has already been initiated. 

10. You can open "HW Config" by clicking  in order to check the hardware data of the 
component. SIMATIC STEP 7 must be installed on the PC used to visualize the 
diagnostics data and the S7 project must be available on this PC. 

11. Close the diagnostics faceplate. 

Result 
The diagnostics status of the central or expansion rack is checked.  
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6.6.4 Diagnostics status of DP slaves, PROFINET IO networks and devices 

Introduction 
You check the diagnostics status of DP slaves / PROFINET components on the diagnostics 
screen of the corresponding AS. Status details can be viewed on the diagnostics screens of 
the AS or DP system or on the diagnostics faceplates.  

Procedure 
1. Click the "Diagnostics" area selection button in the overview area. The Maintenance 

Station overview screen opens. 
2. In the overview area, click the  icon next to the "Diagnostics" area selection button. 

Picture Tree Navigator opens and expands the tree structure down to the overviews. 
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3. Expand the tree structure of Picture Tree Navigator to view the required AS entry by 
clicking the "+" icon. Click the AS entry. The program displays the diagnostics screen of 
the AS and the sublevel hierarchy.  
The sample screenshot below shows the central rack, an expansion rack and two 
PROFIBUS DP subsystems. This screen also displays the PROFINET components of the 
AS. 

 
4. Continue at step 7 to run diagnostics of the actual DP master system. 
5. It is also possible to check the status of individual modules and DP slaves in one of the 

visualized DP subsystems. Click the MaintenanceGroupDisplay in the icon of the 
corresponding DP system, e.g. 

. The diagnostics screen of the DP system opens with a view of its interface modules.  

 
The DP system in this example contains an IM153 and an IM157 interface module. 
Continue at step 7 to run diagnostics of a module.  
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6. Click the MaintenanceGroupDisplay in the icon of the corresponding module to check the 
status of the submodules, e.g. 

. The diagnostics screen of the module opens. The example of the IM153 shows the 
power supply modules and I/O modules in the rack.  

7. In the diagnostics screen, click the MaintenanceStateDisplay in the icon of the 
component or module required, e.g. 

. The diagnostics faceplate opens with the "Ident" view. The "Component" area in 
the left-hand area of this view displays the status of the actual component, as well as that 
of any existing redundant device. The component data are displayed in the right-hand 
area.  

8. Check the status views in the upper area of the faceplate. In addition to the component 
status, these views also display the status of requested and initiated maintenance tasks, 
e.g. 

. 
9. Change to the "Messages" view to check the active messages re this component. Use 

the toolbar functions to analyze the message history of this component. 
10. Change to the "Maintenance" view to check the status. Respond to maintenance requests 

of the system by initiating a maintenance task in this view or by setting the request to 
"Cancel". You can change the request to "In progress" or "Completed" status if a 
maintenance task has already been initiated. 

11. You can open "HW Config" by clicking  in order to check the hardware data of the 
component. SIMATIC STEP 7 must be installed on the PC used to visualize the 
diagnostics data and the S7 project must be available on this PC. 

12. Close the diagnostics faceplate. 

Result 
You checked the diagnostics status of a DP slave, or of the corresponding DP system, or of 
a PROFINET component.  
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6.6.5 Diagnostics status of drives, sensors and other components 

Diagnostics status of drives, sensors and other components of the field bus systems  
The diagnostics functions for the components described below are implemented using an 
Asset Proxy, for example, of the "Extended" type.  
● Components which do not support standard diagnostics because these are not standard 

slaves, for example. 
● Components of "DRIVE ES". 
● Components not configured in the S7 project. 
The user configures the data of the diagnostics status interface and of diagnostics 
messages. It is not possible for this reason to specify basic factors which determine the 
output of diagnostics messages and states concerning such components.  
The description of the functions listed below are derived from the descriptions relating to 
general component diagnostics in the Maintenance Station. 
● Display of the component as icon in the diagnostics screens. 
● Automatic implementation of diagnostics messages and states in the hierarchy of status 

and group displays. 
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6.7 Diagnostics of PC stations 

6.7.1 Overview of the diagnostics status of the PC stations 

Introduction 
The diagnostics status of all PC stations can be obtained from the PC stations overview 
screen.  

Procedure 
1. Click the "Diagnostics" area selection button in the overview area. The Maintenance 

Station overview screen opens. 
2. In the overview area, click the  icon next to the "Diagnostics" area selection button. 

Picture Tree Navigator opens and expands the tree structure down to the overviews. 

 
3. Click "PC Stations" in the tree structure of Picture Tree Navigator. The PC stations 

overview screen opens. 
4. Check the status displays in the component icons, e.g. 

.  
The MaintenanceStateDisplay returns the status of the actual component, e.g. 

. 
The EventState status display is attached to the bottom right of the 
MaintenanceStateDisplay and returns the status of the messages for this component. 
The small red square in our example indicates an active message.  

Result 
You checked the diagnostics status of the PC stations.  
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6.7.2 Diagnostic status of a PC station 

Introduction 
You can check the diagnostics status of a PC station by opening the PC station overview on 
the overview screen. Status details are returned in the diagnostics faceplate.  

Procedure 
1. Click the "Diagnostics" area selection button in the overview area. The Maintenance 

Station overview screen opens. 
2. In the overview area, click the  icon next to the "Diagnostics" area selection button. 

Picture Tree Navigator opens and expands the tree structure down to the overviews. 

 
3. In order to check the status of a specific PC station, click "PC Stations" in the tree 

structure of Picture Tree Navigator. The PC stations overview opens and outputs the 
diagnostics status of all PC stations. 

4. To check the status of a specific PC station, click the icon for the required PC station, e.g. 

 followed by the MaintenanceStateDisplay in this icon, e.g. .  
The diagnostics faceplate opens with the "Ident" view. The "Component" area in the left-
hand area of this view displays the status of the actual component, as well as that of any 
existing redundant device. The component data are displayed in the right-hand area.  

5. Check the status views in the upper area of the faceplate. In addition to the component 
status, these views also display the status of requested and initiated maintenance tasks, 
e.g. 

. 
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6. Change to the "Messages" view to check the active messages re this component. Use 
the toolbar functions to analyze the message history of this component. 

7. Change to the "Maintenance" view to check the status. Respond to maintenance requests 
of the system by initiating a maintenance task in this view or by setting the request to 
"Cancel". You can change the request to "In progress" or "Completed" status if a 
maintenance task has already been initiated. 

8. Close the diagnostics faceplate. 

Result 
You checked the diagnostics status of the PC station.  



 Working with SIMATIC Maintenance Station 
 6.7 Diagnostics of PC stations 

SIMATIC Maintenance Station 2007 
Operating Manual, 04/2008, A5E00901992-03 219 

6.7.3 Checking the diagnostics status of an industrial PC 

Introduction 
You can check the diagnostics status of an industrial PC by opening the PC station overview 
on the overview screen. Status details are returned in the diagnostics faceplate.  
A SIMATIC Industrial PC is configured in the project as SNMP component, however, instead 
of visualizing the PC as network component in the diagnostics screens, the program displays 
it in the "PC stations" area.  

Procedure 
1. Click the "Diagnostics" area selection button in the overview area. The Maintenance 

Station overview screen opens. 
2. In the overview area, click the  icon next to the "Diagnostics" area selection button. 

Picture Tree Navigator opens and expands the tree structure down to the overviews. 
3. In order to check the status of a specific industrial PC, click "PC Stations" in the tree 

structure of Picture Tree Navigator. The PC stations overview opens and outputs the 
diagnostics status of all PC stations and of SIMATIC industrial PCs. 

4. To check the status of a specific industrial PC, click the icon for the required industrial 
PC, e.g. 

 followed by the MaintenanceStateDisplay in this icon, e.g. .  
The diagnostics faceplate opens with the "Ident" view. The "Component" area in the left-
hand area of this view displays the status of the actual component, as well as that of any 
existing redundant device. The component data are displayed in the right-hand area.  

5. Check the status views in the upper area of the faceplate. In addition to the component 
status, these views also display the status of requested and initiated maintenance tasks, 
e.g. 

. 
6. Change to the "Messages" view to check the active messages re this component. Use 

the toolbar functions to analyze the message history of this component. 
7. Change to the "Maintenance" view to check the status. Respond to maintenance requests 

of the system by initiating a maintenance task in this view or by setting the request to 
"Cancel". You can change the request to "In progress" or "Completed" status if a 
maintenance task has already been initiated. 

8. The "Monitoring 1" to "Monitoring 3" views are available for SIMATIC PC diagnostics.  
Change to the "Monitoring 1" view to check the displays. This view outputs the 
temperature displays for PC components such as the CPU or mainboard. 
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9. Change to the "Monitoring 2" view to check the displays. This view returns the rpm of the 
PC fan. 

10. Change to the "Monitoring 3" view to check the displays. This view returns data of the 
hard disk drives of the PC, for example, the type, the serial number, and the status. 

11. Close the diagnostics faceplate. 

Result 
You checked the diagnostics status of the SIMATIC Industrial PC.  
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6.8 Diagnostics of network components 

6.8.1 Overview of the diagnostics status of the network components 

Introduction 
You can view the diagnostics status of all network components on the network components 
overview.  

Procedure 
1. Click the "Diagnostics" area selection button in the overview area. The Maintenance 

Station overview screen opens. 
2. In the overview area, click the  icon next to the "Diagnostics" area selection button. 

Picture Tree Navigator opens and expands the tree structure down to the overviews. 

 
3. Click "Network objects" in the folder structure of Picture Tree Navigator. The network 

components overview opens. 
4. Check the status displays in the component icons, e.g. 

. 
The MaintenanceStateDisplay returns the status of the actual component, e.g.  

.  
The EventState status display is attached to the bottom right of the 
MaintenanceStateDisplay and returns the status of the messages for this component. 
The small red square in our example indicates an active message.  

Result 
You checked the diagnostics status of the network components.  
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6.8.2 Diagnostics status of a network component 

Introduction 
You can check the diagnostics status of a network component by opening the network 
components overview on the overview screen, or by viewing status details in the diagnostics 
faceplate.  

Procedure 
1. Click the "Diagnostics" area selection button on the overview area. The Maintenance 

Station overview screen opens. 
2. In the overview area, click the  icon next to the "Diagnostics" area selection button. 

Picture Tree Navigator opens and expands the tree structure down to the overviews. 

 
3. In order to check the status of a specific network components, click "Network objects" in 

the tree structure of Picture Tree Navigator. The network components overview opens. 
4. To check the diagnostics status of an individual network component, select the network 

components overview, click the icon for the component required (e.g. 

), and then click the MaintenanceStateDisplay in this icon, e.g. . 
5. The diagnostics faceplate opens with the "Ident" view. The "Component" area in the left-

hand area of this view displays the status of the actual component, as well as that of any 
existing redundant device. The component data are displayed in the right-hand area. 
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6. Check the status views in the upper area of the faceplate. In addition to the component 
status, these views also display the status of requested and initiated maintenance tasks, 
e.g. 

. 
7. Change to the "Messages" view to check the active messages relating to this component. 

Use the toolbar functions to analyze the message history of this component. 
8. Change to the "Maintenance" view to check the status. Respond to maintenance requests 

of the system by initiating a maintenance task in this view or by setting the request to 
"Cancel". You can change the request to "In progress" or "Completed" status if a 
maintenance task has already been initiated. 

9. Close the diagnostics faceplate. 

Result 
You checked the diagnostics status of the network component.  
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6.9 Maintenance management 

6.9.1 Maintenance states 

Introduction 
SIMATIC Maintenance Station supports users in terms of plant diagnostics, initiation of 
maintenance tasks and maintenance status management.  
The Maintenance Station returns diagnostics messages relating to components requiring 
maintenance to the plant operator. The operator can use this information to run directed 
diagnostics of this component and to initiate maintenance tasks as required.  

The status of maintenance tasks  
A maintenance task may assume different states on the Maintenance Station. The diagram 
below shows the possible status transitions.  
It also shows that the operator can cancel maintenance tasks in the various states. 
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Status transitions are set in the "Maintenance" view of the component's diagnostics 
faceplate. The section below shows the basic sequence of maintenance operations.  
● The operator can request maintenance while the system is in normal operating state or 

after having received a diagnostics message. The user sets the "Maintenance alarm", or 
the "Maintenance required", or the "maintenance demanded" priorities.  
The user can either maintain or change the priority defined in the diagnostics message 
when requesting maintenance.  
The faceplate returns the symbol of the maintenance task requested and the progress 
status after the user has defined priorities. 

 
Rating Name Message symbol Symbol for the requested 

maintenance task 
Low Maintenance required 

 
Medium Maintenance demanded 

 
High Maintenance alarm 

 

 
● The user sets the "In progress" status at the start of maintenance at the corresponding 

component. 
● The user sets the "Completed" maintenance status on completion of this task. The 

faceplate returns the actual status of the component in the status view. The progress 
symbol is cleared automatically. 

For details on the maintenance sequence, refer to the section "Sequence of maintenance 
tasks".  
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6.9.2 Sequence of a maintenance task 

Overview of the progress of a maintenance task 
This section provides and overview of the sequence of a maintenance task.  
The example describes the maintenance tasks initiated as a reaction to a maintenance 
alarm.  

Requesting a new maintenance task  
● Open the diagnostics faceplate of the component on the diagnostics screen by clicking 

the MaintenanceStateDisplay on the component symbol. Change to the "Maintenance" 
view. 
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● Select on the of options on the "Request Operator" area, i.e. "Alarm", "Request", 
"Demand" or Cancel". The "In progress" and "Completed" options are grayed out for new 
operations. You can enter a comment and a work instruction number in the next dialog 
box.  
You can accept the "maintenance requirement", or the "maintenance demand" or the 
"maintenance alarm" level proposed by the system in the "Component" area, or select a 
different phase, for example, by changing from the "maintenance demand" to the 
"maintenance requirement" status.  
The "Alarm" option is selected for this example; the screenshot below shows the 
corresponding dialog box. 

 
● You can type a comment into the "Comment" input box, for example, to describe the 

maintenance task.  
Enter the corresponding number in the "Work instruction number" input box. This number 
denotes a work package to be executed. The work instruction number is used as 
information for the transfer to EAM/CMMS systems and is entered in the protocol.  
The diagnostics faceplate returns the comment in the "Comment" field and the number 
you entered in the "Work instruction number" field.  
The program clears the "Work instruction number" and "Note" fields of the diagnostics 
faceplate when a maintenance task is completed or canceled. 

● You can output your settings to a specific target such as a printer by selecting it from the 
"Request via" drop-down menu.  
You can alternatively also select a so-called export target, in as far as it has been 
configured. This allows the data of the component to be exported for other applications 
for further processing such as the WinCC add-ons "PM-MAINT" or "Alarm Control 
Center". 

● The status bars on the top left of the faceplate change after you have set the priorities. 

 

The MaintenanceStateDisplay  returns the "Maintenance requested for maintenance 
alarm" status.  

The progress status displays the  icon. This icon corresponds to the status 
"Component maintenance requested, however, the task is not yet in progress, or has 
been completed or canceled". 
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Maintenance task in progress 
● You change the status of the currently requested maintenance operation at the start of 

maintenance activities. Activate the "In progress" option on the component faceplate. 
● Change to the status bars in the upper section of the faceplate. 

 
The MaintenanceStateDisplay shows:  

 = "Maintenance requested for maintenance alarm" 

 = "In progress". 

Maintenance task completed 
● Activate the "Completed" option on the component faceplate when all maintenance tasks 

for this components have been completed. 
● Change to the status bars in the upper section of the faceplate. The component status 

bar returns the actual status of the component. The progress status is cleared again. 
 

  Note 
Activate the "Completed" or "Canceled" option on the component faceplate to indicate 
completion or cancellation of a maintenance task. The progress symbol is cleared from 
the faceplate in both situations. 
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6.10 Exporting component data 

6.10.1 Starting the complete export of the component data 

Introduction 
The data of all the components with diagnostics capability are exported by means of the so-
called complete export. These may be offline configuration data of an S7 project or, if 
available, online data. 

Requirements 
● The "Enable for area" authorization for the diagnostics area is required in WinCC for the 

function. 

Procedure 
1. Change to the Maintenance Station overview screen. To do so, click the corresponding 

area selection button, for example, "Diagnostics" in the overview screen. 

2. Click . The complete export is started. 

Result 
The complete export is started and the data of the components are exported to the 
"@XML_Export.sml" file.  
 

See also 
Complete export of component data  (Page 152) 
Overview of control elements in the diagnostics screens (Page 190) 
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6.10.2 Exporting the data of a single component 

Introduction 
The "Maintenance" view in the diagnostics faceplate of a component lets the user react to 
maintenance requests by initiating and managing corresponding maintenance tasks.  
In this view the data of the individual component to be exported for other applications that 
process these data further such as the WinCC add-ons "PM-MAINT" or "Alarm Control 
Center".  

Requirements 
● Each application for which the data is to be exported is referred to as an export target. 

The corresponding variables have to be created in WinCC for every export target. 
● Depending on the respective export target, additional conditions have to be fulfilled, for 

example a global script has to be configured that also carries out conversion of the 
formats in order to export to PM-MAINT. 

Detailed information about the required configurations and the data export is available in the 
chapter "Exporting component data for other applications".  

 

 Note 
Please also observe the requirements that apply for importing the data into the applications 
for further processing: These are described in the relevant documentation. 
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Procedure 
1. Navigate in the diagnostics screens of the Maintenance Station to the desired component 

and open the diagnostics faceplate of this component. 
2. Select the "Maintenance" view. Check the status and the maintenance demand in the 

"Request operator" area and change the status if required. 

 
 

3. Select the name of the required export target, such as "PM_MAINT", from the "Request 
via" drop-down list box. 

4. Click "Execute". 

Result 
The data of the individual component are exported to an XML file. The export file is stored in 
the default path "<WinCC_project_directory> / AssetExport". If the variable 
"@ASSET_EXPORT_<n>_DIR" exists, the file is stored in the subdirectory that is specified 
in this variable. 

 

 Note 
Status changes at the maintenance station 
When the status changes - for example, after the maintenance job has been terminated - 
exporting has to be restarted by the user to transfer the status to the application (such as the 
Alarm Control Center) for further processing. 

 
For additional information, please refer to "Introduction to exporting the data of an individual 
component (Page 153)".  
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6.11 Diagnostics status of redundant components 

Introduction 
Redundant components are visualized on the diagnostics faceplate of each redundancy 
partner. The faceplate outputs a MaintenanceStateDisplay for each one of the redundant 
partners. The master is identified by a small orange square below the corresponding 
MaintenanceStateDisplay. 

 
 
 

Ⓐ MaintenanceStateDisplay of redundant component "A" 
Ⓑ MaintenanceStateDisplay of redundant component "B" 
① Master identifier 
② MaintenanceGroupDisplay  
③ MaintenanceStateDisplay for the overall status 

The screenshot shows the diagnostics status described below. 
Redundant component "A" shows the "Maintenance demanded" status. Redundant 
component "B" shows the "Good" status. The "maintenance demanded" self-diagnostics 
status is derived from the table below based on this information. The faceplate returns this 
status in MaintenanceStateDisplay "③". in addition, MaintenanceGroupDisplay "②" returns 
the maintenance demanded status "M".  
The status is also indicated by the component views below.  

●  In the MaintenanceStateDisplay of the component symbol on the diagnostics 
screen 

●  In the MaintenanceGroupDisplay in the higher-level hierarchy of the component's 
diagnostics screen 
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Diagnostics status of redundant components 
The "MaintenanceStateDisplay" for redundant components is composed of the redundancy 
partners A and B. The table below shows the impact of the diagnostics status of each 
redundancy partner on the status display of the faceplate. 

 
Redundant  
component A 

Redundant  
component B 

MaintenanceStateDisplay in the 
diagnostics faceplate 

Good Good 
 Good 

Unknown / not verified Good 
 Good 

Component disabled Good 
 Good 

Shut down Good 
 Maintenance requested 

At least one process value is simulated Good 
 Good 

Local operation Good 
 Good 

Maintenance required Good 
 Maintenance demanded 

Maintenance demanded Good 
 Maintenance requested 

Maintenance alarm Good 
 Maintenance requested 

Good Component disabled 
 Good 

Unknown / not verified Component disabled 
 Component disabled 

Component disabled Component disabled 
 Component disabled 

Shut down Component disabled 
 Shut down 

At least one process value is simulated Component disabled 
 At least one process value is 

simulated 
Local operation Component disabled 

 Local operation 
Maintenance required Component disabled 

 Maintenance demanded 
Maintenance demanded Component disabled 

 Maintenance requested 
Maintenance alarm Component disabled 

 Maintenance alarm 
Good Shut down 

 Maintenance requested 
Unknown / not verified Shut down 

 Shut down 
Component disabled Shut down 

 Shut down 
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Redundant  
component A 

Redundant  
component B 

MaintenanceStateDisplay in the 
diagnostics faceplate 

Shut down Shut down 
 Shut down 

At least one process value is simulated Shut down 
 At least one process value is 

simulated 
Local operation Shut down 

 Local operation 
Maintenance required Shut down 

 Maintenance demanded 
Maintenance demanded Shut down 

 Maintenance requested 
Maintenance alarm Shut down 

 Maintenance alarm 
Good At least one process value is simulated 

 Good 
Unknown / not verified At least one process value is simulated 

 At least one process value is 
simulated 

Component disabled At least one process value is simulated 
 At least one process value is 

simulated 
Shut down At least one process value is simulated 

 At least one process value is 
simulated 

At least one process value is simulated At least one process value is simulated 
 At least one process value is 

simulated 
Local operation At least one process value is simulated 

 Local operation 
Maintenance required At least one process value is simulated 

 Maintenance demanded 
Maintenance demanded At least one process value is simulated 

 Maintenance requested 
Maintenance alarm At least one process value is simulated 

 Maintenance alarm 
Good Local operation 

 Local operation 
Unknown / not verified Local operation 

 Local operation 
Component disabled Local operation 

 Local operation 
Shut down Local operation 

 Local operation 
At least one process value is simulated Local operation 

 Local operation 
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Redundant  
component A 

Redundant  
component B 

MaintenanceStateDisplay in the 
diagnostics faceplate 

Local operation Local operation 
 Local operation 

Maintenance required Local operation 
 Maintenance demanded 

Maintenance demanded Local operation 
 Maintenance requested 

Maintenance alarm Local operation 
 Maintenance alarm 

Good Maintenance required 
 Maintenance demanded 

Unknown / not verified Maintenance required 
 Maintenance demanded 

Component disabled Maintenance required 
 Maintenance demanded 

Shut down Maintenance required 
 Maintenance demanded 

At least one process value is simulated Maintenance required 
 Maintenance demanded 

Local operation Maintenance required 
 Maintenance demanded 

Maintenance required Maintenance required 
 Maintenance demanded 

Maintenance demanded Maintenance required 
 Maintenance requested 

Maintenance alarm Maintenance demanded 
 Maintenance alarm 

Good Maintenance requested 
 Maintenance requested 

Unknown / not verified Maintenance requested 
 Maintenance requested 

Component disabled Maintenance requested 
 Maintenance requested 

Shut down Maintenance requested 
 Maintenance requested 

At least one process value is simulated Maintenance requested 
 Maintenance requested 

Local operation Maintenance requested 
 Maintenance requested 

Maintenance demanded Maintenance requested 
 Maintenance requested 

Maintenance requested Maintenance requested 
 Maintenance requested 

Maintenance alarm Maintenance requested 
 Maintenance alarm 
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Redundant  
component A 

Redundant  
component B 

MaintenanceStateDisplay in the 
diagnostics faceplate 

Good Maintenance alarm 
 Maintenance requested 

Unknown / not verified Maintenance alarm 
 Maintenance alarm 

Component disabled Maintenance alarm 
 Maintenance alarm 

Shut down Maintenance alarm 
 Maintenance alarm 

At least one process value is simulated Maintenance alarm 
 Maintenance alarm 

Local operation Maintenance alarm 
 Maintenance alarm 

Maintenance demanded Maintenance alarm 
 Maintenance alarm 

Maintenance requested Maintenance alarm 
 Maintenance alarm 

Maintenance alarm Maintenance alarm 
 Maintenance alarm 

Good Unknown / not verified 
 Good 

Unknown / not verified Unknown / not verified 
 Unknown / not verified 

Component disabled Unknown / not verified 
 Component disabled 

Shut down Unknown / not verified 
 Shut down 

At least one process value is simulated Unknown / not verified 
 At least one process value is 

simulated 
Local operation Unknown / not verified 

 Local operation 
Maintenance demanded Unknown / not verified 

 Maintenance demanded 
Maintenance requested Unknown / not verified 

 Maintenance requested 
Maintenance alarm Unknown / not verified 

 Maintenance alarm 
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6.12 Changeover between SIMATIC Maintenance Station and 
PCS 7 Maintenance Station 

Changeover between SIMATIC Maintenance Station and PCS 7 Maintenance Station  
PCS 7 and S7 projects can be used in a production plant. However, both plant areas are 
separated up to server level, starting at the AS. Each area contains its own severs for plant 
operation and monitoring. Diagnostics data are also prepared and processed on separate 
Maintenance Station Servers in these plant areas.  
The two plant areas can share a single Maintenance Station for diagnostics. To this purpose 
a PCS 7 Maintenance Station Client is operated on a separate PC. The server packages 
outputs by the Maintenance Station Servers of both areas are imported to this PC.  
The diagnostics screens of the PCS 7 and S7 plant sections each have their own area on 
the Maintenance Station. The notation of both areas can be selected using the area 
selection buttons on the overview area.  
● In the PCS 7 project the name is defined in the plant view in the properties of the 

"Diagnostics" section in the "OS area identifier" field. 
● In the S7 project, the name is defined in the "Name of the diagnostics area" input box in 

the "Derive settings for diagnostics screens" dialog box. 
 

  Note 
The "Loop-in-HW Config" function is not possible on the Maintenance Station with PCS 7 
and S7 plant sections. 
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Glossary 

AS 
AS = Automation System 

Asset 
Assets are the various plant components. The term "plant assets" denotes components or 
devices of the plant / machinery which are serviced by maintenance personnel.  

Asset ID 
The asset ID is used to identify the components and must be unique across the entire 
project. The asset ID is a character string of 32 characters that is transferred to the export 
file when an individual export is carried out.  

Configuring the asset ID 
● When creating new S7 projects with STEP 7 V5.4 SP3 or higher, the asset ID is 

generated automatically for all components configured in the "HW Config" editor. 
● When migrating S7 projects that were created before STEP 7 V5.4 SP3, the asset ID for 

all configured components must be created manually on a one-off basis. The "Allocate 
asset ID..." function in the "HW Config" editor is used for this purpose.  
In "HW Config", each configured AS station is opened once and the "Allocate asset ID..." 
function in the "Edit" menu started. The function creates unique asset IDs for the AS and 
its corresponding subcomponents, and also indicates in a dialog box where these can be 
edited (if necessary). Once the dialog box has been confirmed, the AS station still needs 
to be saved, compiled and downloaded.  
This is particularly necessary if the asset ID will continue to be used, e.g. by PM-MAINT. 

● For each asset proxy, the asset ID must be allocated manually by means of configuration 
in the corresponding instance blocks.  
For additional information on this topic, please refer to "Configuring an asset ID for 
individual export with a standard asset proxy". 

Asset Management 
The term Asset Management generally encompasses activities and measures taken to 
maintain or increase the value of a plant. In addition to plant management, plant automation 
and their optimization, these measures include in particular the maintenance and increase of 
asset values.  
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Asset Proxy 
The Asset Proxy acts as component representative in the diagnostics system. It is 
implemented for components which are not standard slaves and do not belong to the 
SIMATIC family. The function blocks and instance DBs for the asset proxy are programmed 
in the user program of the AS. A defined interface is used to manage "MaintenanceState" 
diagnostics data and transfer messages. The "Extended" or "Standard" type is used, 
depending on the component.  

CMMS 
Computerized Maintenance Management System. CMMS is a computerized system which is 
used to plan, manage and analyze maintenance. This includes request management and 
execution, personnel planning and management, spare parts and materials.  

EAM 
Enterprise Asset Management System. EAM functionality is closely related to CMMS.  

ES 
ES = Engineering Station 

Event State 
Status display for diagnostics messages of the component.  

Maintenance Station Client 
A WinCC Client for the visualization of process and diagnostics screens with diagnostics 
control functionality. 

Maintenance Station Server 
A WinCC server which features enhanced diagnostics functionality. 

MaintenanceState 
Representation of the diagnostics status in MaintenanceState "MST" 
The diagnostics maintenance states of a component are managed in status word 
MaintenanceState "MST". 

MGD MaintenanceGroupDisplay 
MGD = MaintenanceGroupDisplay. Status display for the output of the maintenance status of 
sublevel components.  
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MSD MaintenanceStateDisplay 
MSD = MaintenanceStateDisplay. Status bar for the output of the maintenance status of the 
stand-alone component. 

OS 
OS = Operator Station 

Plant Asset Management 
Plant asset management denotes maintenance tasks which are suitable to preserve or add 
values. An important aspect in this context is an optimal cost ratio of value-adding 
maintenance and plant availability.  
In addition to the collection of data for the analysis of the plant's technical state, plant asset 
management also makes decisions concerning maintenance measures to be taken.  

Plant asset management system 
A plant asset management system is an IT system that provides the following functionality: 
● Collection of online information for the assessment of the plant and components state. 
● Support of decisions concerning maintenance measures to be taken. 
● Preparation and execution of maintenance measures. 
● Interface to other systems for asset management such as EAM/CMMS or business 

management. 

SIMATIC Maintenance Station Combined 
SIMATIC Maintenance Station Combined: The SIMATIC Maintenance Station is integrated 
into an existing WinCC station.  

SIMATIC Maintenance Station Stand-alone 
SIMATIC Maintenance Station Stand-alone: SIMATIC Maintenance Station is implemented 
on a new or separate PC which is dedicated to operation of the SIMATIC Maintenance 
Station.  

SNMP 
Simple Network Management Protocol. The protocol supports central management of 
multiple network components. 

WinCC client 
General term used of a PC which is used to visualize and operate the process screens or 
diagnostics screens. 
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WinCC multiuser project 
A WinCC multiuser project can generate its own packages and upload the packages from 
other WinCC multiuser projects. The packages can be uploaded from WinCC clients and 
WinCC multiuser projects. Communication with other WinCC multiuser stations is handled by 
server-server communication functions. The PC running the multiuser project features a 
process bus interface for communication with the corresponding automation systems. The 
multiuser project supports several WinCC clients. 

WinCC multiuser station 
WinCC station running a project of the type "WinCC multiuser project". 

WinCC Server 
A WinCC Server receives and processes the process data for operating and monitoring the 
system. The process data can be transferred via direct process connection or by other 
WinCC Servers. Operation and monitoring takes place on one or more WinCC clients.  
If several WinCC Servers are used, the data can be distributed across them. This means 
that, in a large system, different components can be processed on separate servers, for 
example. Systems that are distributed in this way offer the following advantages: 
● Good scalability 
● Separate system components 
● Greater availability as a result of good scalability and separate system components. 
● A WinCC Server can access several other WinCC Servers at the same time (server-

server communication). 
If configured as a SIMATIC Maintenance Station Server, a WinCC Server can also execute 
diagnostics and maintenance functions. 

WinCC single-user project 
WinCC single-user projects are interconnected directly with the corresponding automation 
systems. Generation of packages is not supported. Communication with other WinCC 
stations and server-server communication are ruled out for this reason. 

WinCC single-user station 
WinCC station running a project of the type "WinCC multiuser project". 
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Index 

@ 
@ASSET_EXPORT_xxx, 160 
@ExportPath, 152 

A 
ACC,  (Refer to Alarm Control Center) 
ActiveX controls, 43 
Alarm Control Center, 153, 174 

Data integration in ACC, 175 
License number for exporting individual items, 178 
Overview of the data export, 174 
Use in a distributed system, 175 

ALARM_D, 67 
ALARM_DQ, 67 
ALARM_S, 67 
ALARM_SQ, 67 
Asset, 7 
Asset ID, 153 

"Allocate asset ID..." function in HW Config, 154 
Projects from STEP 7 prior to V5.4 SP3, 154 
Projects from STEP 7 V5.4 SP3 and higher, 154 
Standard asset proxy, 66 

Asset Management 
Asset Management System, 8 
Definition, 8 
Introduction, 7 
Plant, 8, 9 

Asset proxy, 59, 60, 67 
Assigning diagnostics messages, 67 
Triggering diagnostics messages, 67 

Asset Proxy, 57, 59, 90 
Extended, 61, 215 
Standard, 63 

B 
Block symbols file, 107 

C 
CAS, 20 
CAx data 

Exporting, 169 
for PM-MAINT, 165 

Client/Server architecture, 39, 50 
CMMS, 8, 17 
Combined, 26 
Complete export, 152, 191 
Computer properties 

WinCC project of the Maintenance Station, 143 
WinCC Server supplying data, 145 

Computer properties WinCC project, 139 
Configuration 

Overview, 77 
Upon changes, 80 

Configuration changes, 80 
Control messages, 151, 203 

D 
Data export 

Assignment of the tags, 160 
Complete export, 191 
Contents of the XML File, 157 
Export target, 154 
for Alarm Control Center, 174, 176 
for PM-MAINT, 164, 166 
Global script for export to the ACC, 179 
Global script for linking PM-MAINT, 170 
Individual export, 153 
License number from the ACC, 178 
Script, 166, 176 
Trigger for script, 166, 176 

Data export for other applications, 153 
Default server, 151 
Demo mode, 47 
Diagnostic Status 

of drives, sensors, etc., 215 
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Diagnostics messages, 203 
Diagnostics screens 

Compiling, 132 
Creation / management, 118 
Hierarchy, 89 
Layout, 188 
Transfer, 132 
Updating, 128 
Updating required, 81 

Diagnostics status word 
Status bits, 103 
Symbol set, 103 
Syntax, 102 

DP slave, 55, 56 

E 
EAM, 8, 17 
ESM 

Electrical Switch Module, 71 
Event State, 110 
Export file, 155 

Internal/external drives, 152 
Name, 155 
Storage path, 152, 156 

Export target, 154 
Assignment of the tags, 160 

Exporting the data of an individual component, 153 

F 
Firewall 

Windows, 46 
Floating License, 47 

G 
Graphics Designer, 79, 135 
GSD, 56 
GSD file, 18, 55, 56, 82 

Language ID, 55 

H 
Hardware 

Requirements, 54, 77 
Hardware requirements, 45 
HMI, 86 
HW Config, 60, 71, 77, 86, 90, 127 

I 
Ident, 90 
Individual export, 153 

Alarm Control Center, 174 
PM-MAINT, 164 
Start, 230 

Industrial PC, 74 

L 
License 

Floating License, 47 
License key, 47 
License Manager, 47 
Number of licensed components, 48 
Regulations, 47 
Single license, 47 
SNMP OPC server, 50 

License agreement, 54 
License key, 71 

Data volume, 51 
Handling, 52 
Installation, 51 
SIMATIC Maintenance Station 2007 
Engineering, 31, 33 
SIMATIC Maintenance Station 2007 Runtime, 31, 
33 
Uninstalling, 52 

Limitations, 20 
Loop-in-Alarm, 12, 190, 194 
Loop-in-HW-Config, 24, 36, 41, 81, 187 

M 
Maintenance Station Client, 53 
Maintenance Station Engineering, 53 
Maintenance Station Server, 53 
Maintenance Station Stand-alone, 53 
MaintenanceGroupDisplay, 111 
MaintenanceState, 59, 89, 101 
Message correction, 191 
Migration of S7 projects, 80, 154 
Mixed system, 25, 34 
Multiuser system, 25, 32, 34 
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O 
OLE objects, 43 
OPC Server, 23, 41, 69, 71 
Operating systems 

Supported, 45 
OS Project Editor, 78, 123 
OSM 

Optical Switch Module, 71 
Overview 

AS objects, 89, 93, 96 
Network components, 89, 93, 96 
PC stations, 89, 93, 96 

Overview area, 192 
Overview screen, 89, 93, 94 

P 
Picture Tree Navigator, 117 
PM-MAINT, 153, 164 

CAx data, 165 
Importing CAx data, 169 
Overview of the data export, 164 

Process Server Extension, 32, 53 
Product DVD, 54 
PROFIBUS, 18, 60, 99 
PROFINET, 18, 55, 69 
Project settings WinCC, 139 
Project type 

Changing, 149 

R 
Readme file, 45 
Report system errors, 86 
Requirements, 45 

Hardware, 45 
Operating systems, 45 
Software, 46 
Windows XP SP2, 46 

Restraints, 77 
RSE block, 88 

S 
SFM Settings, 122 
SIMATIC 

Drives, 55 
NET, 29 
STEP 7, 36, 38, 41 
WinCC, 29, 38, 41 

SIMATIC Maintenance Station 
Benefits, 10 
Client/Server architecture, 23 
Combined, 23, 28, 35, 39 
Features, 9 
Functions, 10 
Installation, 53 
Stand-alone, 27, 37, 39 
Usage / applications, 11 

SIMATIC Manager, 77, 83 
SIMATIC NET, 69, 71 
SIMATIC PC station, 84 
SIMATIC STEP 7, 20 
Single license, 47 
Single-user system, 25, 30 
SNMP, 23, 41, 69 
SNMP component, 72, 74, 125 
SNMP OPC server 

Industrial PC, 70 
Licensing, 70 
Profile, 69 
Requirements, 70 
SNMP-compatible components, 69 

Software, 46 
Requirements, 54, 77 

Software requirements, 45 
Stand-alone, 26 
Standard slave, 55, 56 
Startup list, 140 

WinCC Server supplying data, 145 
Status bits, 102, 103 
Stylesheet, 166 

T 
Tag 

@ASSET_EXPORT_xxx, 160 
Trigger for script for data export, 166, 176 

U 
Upgrading the Maintenance Station, 53, 80 
User administrator, 147 
User rights in the WinCC project, 148 

V 
Variable 

@ExportPath, 152 
VB scripts, 144 
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W 
WinCC, 78 

Client control messages, 151 
WinCC / OS Project Editor, 118, 136 
WinCC add-on, 153 
WinCC multiuser station, 25 
WinCC project 

Existing, 133 
Settings, 133 
User Rights, 148 

WinCC single-user station, 25 
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